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1 ¢ Introduction

1.1 Introduction to lon Chromatography (IC)

The Dionex ICS-1000 Ion Chromatography System (ICS-1000) performs ion
analyses using suppressed or non-suppressed conductivity detection. An ion
chromatography system typically consists of a liquid eluent, a high-pressure
pump, a sample injector, a guard and separator column, a chemical suppressor, a
conductivity cell, and a data collection system.

Before running a sample, the ion chromatography system is calibrated using a
standard solution. By comparing the data obtained from a sample to that obtained
from the known standard, sample ions can be identified and quantitated. The data
collection system, typically a computer running chromatography software,
produces a chromatogram (a plot of the detector output vs. time). The
chromatography software converts each peak in the chromatogram to a sample
concentration and produces a printout of the results.

Doc. 031879-01 3/03 11
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A typical IC analysis consists of 6 stages (see Figure 1-1).

1. Eluent
Delivery

6. Data Analysis

Conductivit :
oncan Y |5. Detection

<
<

Separator
Column

Pump [':]

Injection
Valve /7”

Sample
2. Sample
Injection

Sample Loop

Figure 1-1. lon Analysis Process

1. Eluent Delivery

Eluent, a liquid that helps to separate the sample ions, carries the
sample through the ion chromatography system. The ICS-1000 is an
isocratic delivery system. This means that the eluent composition and
concentration remain constant throughout the run.

2. Sample Injection

The liquid sample is loaded into a sample loop either manually or
automatically (if an automated sampler is installed). When triggered,
the ICS-1000 injects the sample into the eluent stream.

The pump pushes the eluent and sample through the guard and
separator columns (chemically-inert tubes packed with a polymeric
resin). The guard column removes contaminants that might poison the
separator column.

Doc. 031879-01 3/03



1 « Introduction

3. Separation

® As the eluent and sample are pumped through the separator column,
the sample ions are separated. In the ICS-1000, the mode of
separation is called ion exchange. This is based on the premise that
different sample ions migrate through the IC column at different rates,
depending upon their interactions with the ion exchange sites.

4. Suppression

® After the eluent and sample ions leave the column, they flow through
a suppressor that selectively enhances detection of the sample ions
while suppressing the conductivity of the eluent.

5. Detection

* A conductivity cell measures the electrical conductance of the sample
ions as they emerge from the suppressor and produces a signal based
on a chemical or physical property of the analyte.

6. Data Analysis
* The conductivity cell transmits the signal to a data collection system.

® The data collection system (for the ICS-1000, this is Chromeleon®)
identifies the ions based on retention time, and quantifies each analyte
by integrating the peak area or peak height. The data is quantitated by
comparing the sample peaks in a chromatogram to those produced
from a standard solution. The results are displayed as a chromatogram
and the concentrations of ionic analytes can be automatically
determined and tabulated.

Doc. 031879-01 3/03 1-3
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1.2

Overview of the ICS-1000

The ICS-1000 is an integrated ion chromatography system containing a pump,
injection valve, column heater, and conductivity detector. Other system
components, including a guard column, separator column, and suppressor vary,
depending on the analyses to be performed.

The ICS-1000 can optionally be configured with a column heater for temperature
control of the column.

ICS-1000 operation is controlled remotely by a personal computer running
Windows® 2000 or Windows XP and Chromeleon software (version 6.5 SP2 or
later). Chromeleon also provides data acquisition and data processing functions.

For communication between the ICS-1000 and Chromeleon, the ICS-1000 is
connected to a USB (Universal Serial Bus) port on the computer or a USB hub.
For installation instructions, see Section B.5 and also refer to Installing the
Chromeleon IC System (Document No. 031883).
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Chapter 1
Introduction

Chapter 2
Features
Overview

Chapter 3
Operation and
Maintenance

Chapter 4

Troubleshooting

Chapter 5
Service

Appendix A
Specifications

Appendix B
Installation

Appendix C
TTL and Relay
Control

Appendix D
Reordering
Information

Appendix E
FAQ

Appendix F
Glossary

1.3 About This Manual

Introduces ion analysis and the ICS-1000; explains the
conventions used in this manual, including safety-related
information.

Provides an overview of ICS-1000 operating features and
system components; introduces the Chromeleon user
interface.

Provides operating instructions and describes routine
preventive maintenance procedures.

Lists problems and presents step-by-step procedures for
how to isolate and eliminate the cause of each problem.

Provides step-by-step instructions for routine service and
parts replacement procedures that the user can perform.

Lists the ICS-1000 specifications and installation site
requirements.

Describes how to install the ICS-1000.

Describes the ICS-1000 TTL and relay control features.

Lists spare parts for the ICS-1000.

Provides answers to frequently asked questions about
ICS-1000 operation.

Defines terms commonly used in ion analysis.
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1.3.1

P>

DANGER

E

A
|>Z‘>

z

@

CAUTION

lIMPORTANT]

P>

DANGER

P>

AVERTISSEMENT

>

MISE EN GARDE

Safety Messages and Notes

This manual contains warnings and precautionary statements that can
prevent personal injury and/or damage to the ICS-1000 when properly
followed. Safety messages appear in bold type and are accompanied by
icons, as shown below.

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or
practice that may seriously damage the instrument, but will not cause
injury.

Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.

Messages d'avertissement en frangais

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entrainera des blessures graves a mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entrainer des blessures graves a mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entrainer des blessures mineures 3 modérées. Egalement
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entrainera pas de
blessures.
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ACHTUNG

WARNUNG

VORSICHT

Warnhinweise in Deutsch

Bedeutet unmittelbare Gefahr. MiBachtung kann zum Tod oder
schwerwiegenden Verletzungen fiihren.

Bedeutet eine mogliche Gefahrdung. MiBachtung kann zum Tod oder
schwerwiegenden Verletzungen fiihren.

Bedeutet eine mogliche Gefahrdung. MiBachtung kann zu kleineren
oder mittelschweren Verletzungen fiihren. Wird auch verwendet, wenn
eine Situation zu schweren Schiaden am Gerit fiihren kann, jedoch
keine Verletzungsgefahr besteht.

Notes

Informational messages also appear throughout this manual. These are
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert
you to an unexpected result of an action, suggest how to
optimize instrument performance, etc.
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1.3.2 Safety Labels

The ICS-1000 meets EN 61010-1:1993 (safety), CAN/CSA-C22.2 No.
1010.1-92 (safety), UL 3101-1/10.93 (safety), EN 50082-1:1992
(susceptibility), EN 55011:1991 (emissions). The TUV GS, C, US Mark
safety labels and the CE Mark label on the ICS-1000 attest to compliance
with these standards.

The symbols below appear on the ICS-1000 or on ICS-1000 labels.

~ Alternating current

@ Protective conductor terminal (earth ground)

| Power supply is on

O Power supply is off

Doc. 031879-01 3/03



2 * Features

This chapter describes key ICS-1000 features and introduces the Chromeleon user

interface.
2.1 Operating Features

2.1.1 Front Panel

Figure 2-1 illustrates the front panel of the ICS-1000.

Status

LEDs

Power
LED

; Injection
- Port

Figure 2-1. ICS-1000 Front Panel

Injection Port

The sample to be analyzed can
be injected manually into the
injection port, using a syringe.
For automated sample
injection, the ICS-1000 must be
connected to an autosampler.
For more information about
sample injection, see

Section 3.10.

LEDs

The status LEDs (see

Figure 2-2) indicate the status
of various system functions.
See Table 2-1for a description
of each LEDs function. The
power LED indicates whether
the ICS-1000 power is on.

Doc. 031879-01 3/03
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LED Label
Load

Inject

Alarm

Module

Connected

Acquiring
Data

Pump

Suppressor

Column
Heater

4 N\ /7
INJECT VALVE STATUS
Load Module Connected
Inject Acquiring Data
\—) A\
Pump
Suppressor
ALARM
@ Column Heater
. J L y,

Figure 2-2. Status LEDs

If On (Green)

Injection valve is in Load
position.

Injection valve is in Inject
position.

No “on” (green) state.

ICS-1000 is connected to
a Chromeleon timebase.

Sequence or manual data
acquisition is in progress.

Pump is on.

Suppressor is on and
current is being applied to
it.

Column heater is at set
temperature.

If Flashing

Valve error.

Valve error.

Error detected. Check the Chromeleon
Audit Trail for the cause.

Does not flash.

Sequence has stopped due to an error.

High or low pressure limit is exceeded.
The pump is turned off

Continuity check failed or suppressor is
over the voltage, current, or power limit.
The suppressor is turned off

Column heater is transitioning to a new
temperature.

Table 2-1. ICS-1000 Status LED States
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21.2 Top Cover

Figure 2-3 illustrates the top cover of the ICS-1000.

-/

Figure 2-3. ICS-1000 (Top View)

Reservoir Storage

The ICS-1000 top cover has room
for up to three 2-L plastic
reservoirs (P/N 044129).

Tubing Chase

The tubing chase under the top
cover routes tubing to the front of
the ICS-1000.
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2.1.3 Component Panel

Figure 2-4 shows the user-accessible components installed on the
component panel behind the ICS-1000 front door.

Eluent Valve

Leak Sensor

Pump Heads

Pressure Transducer

Injection Valve

Columns

Connector for
optional column
heater

© ©¢ 0666 06 60 ¢

Suppressor

DS6 Conductivity
Cell

©

Mounting brackets
for a second
suppressor

m Tubing Chase (2)

Figure 2-4. ICS-1000 Component Panel
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Eluent Valve

The eluent valve controls the flow from the eluent reservoir. It opens
automatically when the pump is running and closes when the pump is off.

Leak Sensor

The leak sensor is installed in the drip tray at the bottom of the component
panel. If liquid accumulates in the tray, an error message is reported in
Chromeleon and the Alarm LED flashes.

Pump Heads

The ICS-1000 includes a serial isocratic dual-head pump. The flow rate
can be set to 0.00 and to between 0.05 and 5.0 mL/min. However, for
optimum performance, set the flow rate to between 0.4 and 2.0 mL/min.
Setting the flow rate to 0.00 turns off the pump. See Section 2.4.3 for
details about the pump.

Pressure Transducer

The pressure transducer measures the system backpressure.

Injection Valve

The injection valve is a six-port, electrically-activated valve. A 25-uLL
sample loop (P/N 042857) is installed on the valve at the factory. See
Section 2.4.4 for details about valve operation.

Separator and Guard Columns

Both the separator and guard columns are packed with resin and perform
the separation of the sample ions. The main function of the guard column
is to trap contaminants and remove particulates that might damage the
separator column.

Column Heater (Optional—Not Pictured)

The column heater controls the temperature of the separator and guard
columns. The temperature can be set to between 30 °C and 60 °C and it
must be set at least 5 °C above the ambient temperature. See Section 2.4.5
for details about the column heater.

Doc. 031879-01 3/03 2-5
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Suppressor

The suppressor reduces the eluent conductivity and enhances the
conductivity of the sample ions, thereby increasing detection sensitivity.
Either an AES® Atlas Electrolytic Suppressor, SRS® Self-Regenerating
Suppressor, or MMS™ MicroMembrane™ Suppressor can be used with
the ICS-1000. See Section 2.4.6 for details.

DS6 Heated Conductivity Cell

The flow-through conductivity cell measures the electrical conductance
of analyte ions as they pass through the cell. A heat exchanger inside the
cell regulates the temperature, which can be set to between 30 °C and
55 °C. For optimum performance, set the temperature to at least 7 °C
above the ambient temperature. See Section 2.4.7 for details about the
cell.

Tubing Chases

The upper tubing chase routes tubing from the top cover to the component
panel. The lower tubing chase routes tubing from the component panel
through the ICS-1000 interior to the rear panel.
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21.4 Rear Panel
Figure 2-5 illustrates the ICS-1000 rear panel.

Tubing Clips

[ Analog Output
/! Connector
Power / : = /
T
Ml

i usB

/ Connections
i

TTL and Relay
Connector Strip

=T

Main Power rmul

Receptacle \

-

Waste Lines

Figure 2-5. ICS-1000 Rear Panel

Analog Output Connector

The analog output connector outputs conductivity data (scaled to 1 volt)
to an integrator or recording device. See Section B.19 for connection and
setup information.

USB Connections

A USB receptacle is provided to allow connection to the Chromeleon
computer. Two USB ports are provided for connecting to other USB
devices. See Section B.5 for connection instructions.
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CAUTION

MISE EN GARDE

VORSICHT

TTL and Relay Connector

The TTL and Relay connector strip provides two TTL outputs, two relay
outputs, and four TTL inputs. The outputs can be used to control
functions in other TTL or relay controllable devices. The inputs can be
used to switch the injection valve position, turn on the pump, perform an
autozero command, and send an event mark to the analog output. See
Section C.1 for connection instructions.

Tubing Clips

The tubing clips hold tubing in place when routing it from the top cover.

Power Switch

The power switch provides on/off control of power to the ICS-1000.

Main Power Receptacle

The power supply cord plugs into the AC power receptacle.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-1000 and is easily
accessible.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez a ce que la prise de base soit
situéelinstallée prés du module et facilement accessible.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daB sich die Steckdose nahe am Gerét befindet und
leicht zugénglich ist.

2-8
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2.2 Flow Schematic

Figure 2-6 illustrates the liquid flow path through an ICS-1000 when using
suppression in autorecycle mode.

o
ELUENT — J}OUT

| @
o
PUMP 3
DEGAS 7
(Optional) m m %
COND &
CELL 2 l

w

—

T PULSE
2 DAMPER
(2]

SEPARATOR COLUMN
COLUMN HEATER (optional)

Figure 2-6. ICS-1000 Flow Schematic
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Eluent from the eluent reservoir@ flows first through the pump degas
assembly (if it is installed) and then through the eluent valve® to the
pump®. It is then pushed through the pressure transducer®, which measures
the system pressure.

From there, it is pushed through a pulse damper®, which smooths minor
pressure variations from the pump to minimize baseline noise. The eluent then
flows into the injection valve.®

After sample is loaded into the sample loop®@ and the injection valve is
toggled to the Inject position, eluent passes through the sample loop.

If the optional column heater is installed, the eluent/sample mixture is
pumped through the heat exchanger®, which heats the mixture to the column
heater temperature.

The mixture then goes to the guard and separator columns® and through the
suppressor. ®

From the suppressor, the mixture flows through the cell ®, where the analytes
are detected. A digital signal is sent to Chromeleon software. Analog output
can be collected simultaneously.

Finally, the mixture flows out of the cell and is recycled back into the
suppressor, where it is used as the water source for the regenerant chamber.
Flow is then routed to waste. @&
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2.3 The Chromeleon Interface

NOTE This section provides a brief overview of the
Chromeleon interface. For details, refer to the
Chromeleon Help or user’s manual.

Chromeleon software is used for remote control of ICS-1000 operation. Two
modes of software control are available: direct control and automated control.

* With direct control, you select operating parameters and commands from the
Chromeleon menu bar, toolbars, and Control Panels. Direct control
commands are executed as soon as they are entered. Section 2.3.2 describes
the commands available from the ICS-1000 Control Panels.

*  With automated control, you create a list of samples (a sequence) to be
processed automatically. The sequence includes programs with commands
and parameters for controlling the ICS-1000, acquiring sample data, and
producing reports. Section 3.11.2 describes automatic sample processing.
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2.3.1 The Chromeleon Main Window and Browser

When you start Chromeleon, the main window and the Chromeleon

Browser appear (see Figure 2-7).

“% Chromeleon - AMAR _local'\Dionex Templates - Browser

File Edit Yiew ‘Workspace Qualfication Bakch ‘Window Help

[ & e =

& B3N b el v & (E Ny

T I = o

K b e Ry R O e B[

(I Panels
D Repoarts
IC5-1000
(23 AuDIT
- rnanual

El‘ﬁ Dionex Templ
¢ @[ I1C Applications [ Reports

ﬁnMnR_IncaI"-.,"-.,Dinne:-: Templates - Browser

Eﬁ AMAR_local Mame
B[] DEMO [ IC Applications

lates

([ Panelz

2072003111832 A
1/6/2003 3:05:51 PM
2072003111832 A

Figure 2-7. Chromeleon Main Window and Browser

NOTE The Chromeleon Browser looks

and functions like

Windows Explorer, but do not confuse the two. If you
copy files from the Chromeleon Browser into Explorer,

the files will be corrupted.

The Browser displays the directories in which chromatographic data is
located, and allows you to open, move, and delete data.

The left pane of the Browser shows the directory tree structure. By
clicking the “+’ signs next to the folders and expanding the directory
tree, you can access sequences, System Control Panels, Wellness

Panels, and reports.

The right pane displays information about the item selected in the left

pane.
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2.3.2 The ICS-1000 Control Panels
Chromeleon provides two types of Control Panels for the ICS-1000.

* System Control Panels are used for controlling and monitoring ICS-
1000 operation. System Control Panels are described below.

* The Wellness Panel is used for performing calibration and diagnostic
functions. The Wellness Panel is described in Section 5.1.

System Control Panels

System Control Panels for the ICS-1000 are located in the Dionex
Templates/Panels/Dionex_IC\ICS-1000 folder. Chromeleon provides
panels for each ICS-1000 system configuration. There are two styles of
panels:

* Traditional system panels (see Figure 2-8) provide controls on a
single window with minimal graphics.

* System panels (see Figure 2-9) provide a more graphical interface
than the traditional style. On these panels, clicking a control often
brings up another window in which you enter a value.

When you open a System Control Panel, select a panel that matches your
system configuration and choose the style that you prefer.
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000 Pump and Detectol

< 1
P

AMAR

Audit Tr:

Datasource: |

Sequence:

Sample: |

Program: |

Elapsed Time:
e —

009 52:41 Manually acquired samples will be stored temporarily in sequence
"SEQAMAR_localiCS-2000imanual

‘ em
| ’-SVS‘Slarlup Shutdown

semer.

00.52:42 Chromeleon server version 6.50 SP2 Build 067 (Alpha) started (serial number 853)
09:52:96 User AMar (from AMAR) has connected Server Configuration to this

ICS-1000 Pump 1CS-1000 D

Eluent Bottle; 7 ¢ | Ci i

0.001 3
Connected

#
= Hold Mode 10.0+,
i ns

Signal: 0.09962 pS Supp. Type: [RIGITT] 3: [N ETHY | 35.0°C 3:
Autozero | | Ready 50H: = By oma = B [of =] [ShowPlot..

from Pos.

4
[Pump on ]
1.00 mlmii =]

Off On Prime

Inject Valve———————————

Inject Load

Eluent Flow Valve——————

8.0+

6.0+

i

4.0+

2.0+

-1.0-

ECD_1

Closed Open

T
0.00

0.50

T T T T
1.00

S 1

Pump Settings...

ICS-1000 Inject

Load Inject
Injector Settings...

IC5-1000 Detect

[Suppressur - Oﬂj

P ===
Sewence: ||
sampie: ||
Program: |—|

@03:52 41 Manually acquired samples will be stored [«
tempararily in sequence
"SEQAMAR_ocallCS-20004manual”

9095242 Chromeleon server version .50 SP2 Build
957 (Alpha) started (serial number 853)

Elapsed Program Time: | |

Total Program Time: l:l

1CS-1000 Syst:

¥ Connected Startup | Shutdnwnl Show Plutl

#

Detector Settings...

from Pos.

Figure 2-9. ICS-1000 System Control Panel (Graphical)
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System Controls Overview

This section provides brief descriptions of the various controls available
on the ICS-1000 System Control Panels.

NOTE The examples are from the traditional style of panel.

Sample

Sample

Datasource: | | Elapsed Time: I:l
Sequence: | | Run Time: I:l

Sample: | em
Startup | Shutduwnl

Program: | |

Datasource
Displays the database in which the chromatographic data for the sample
is saved.

Sequence
Displays the sequence in which this sample is included.

Sample
Displays the name of the sample that is running.

Program
Displays the name of the program that is running.

Elapsed Time
Displays the time that has elapsed since the sample analysis began.

Run Time
Displays the total run time.

System

Startup
Starts the pump and suppressor. The flow rate and suppressor current
settings that were in effect at system shutdown (see below) are restored.

Shutdown

Stops the pump and suppressor. The flow rate and suppressor current
settings currently in effect are remembered and will be restored at
system startup (see above).
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Audit Trail

Audit Trail

07 :54:19 0.000 Fump_ECD Autozero

078419 0.000 ECD_1.AwqOn

E07:54:19 0.000 Pump_lnjectValve InjectPosition Duration = 30.00
07:54:49 0,500 {Pump_ECD} Leg Pressure: 500.00

%D?:ﬁ*ﬂ:‘m 0.500 [Fump_ECDY Log Badiground: -0.2<4

[}_:_:_ 15.000 ECD_1. AcqgOff

The Audit Trail displays an account of every event that occurs during
ICS-1000 operation. This includes errors, status messages, operational

events, etc.

Pump

ICS-1000 Pump
-Eluent Bottle

0.00 1 33

¥ Connected
Connected
Hold Mode

Stop Mode

Eluent Bottle

The entry field and gauge indicate the level
of liquid (in liters) in the eluent bottle. This
is a user controlled feature. The level must

be entered by the user when the reservoir is
filled. See Section 3.4.4 for details.

Connected

Pump On

Connects the ICS-1000 to the Chromeleon
Control Panel, enabling communication
between the PC and the module. Clearing
the check box disconnects the ICS-1000
from the PC.

Pressure: 800 psi

[ 58

i

(SFETE | 1.00 ml/min =

o
=

| On | Prime

Hold Mode
Indicates when an automatic (batch) run is on hold; pump flow is not
stopped.

Stop Mode
Indicates when an automatic (batch) run is stopped; pump flow is also
stopped.

Flow Rate
Sets the pump flow rate in mL/min.

Pressure
The sliders select the upper and lower pressure limits. The Pressure field
displays the current pressure.

On, Off, Prime
Turn the pump on and off or start the pump priming function.

2-16
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Column Heater (Optional)

Anject Valve

LoadPosition |

Inject Load |

-Eluent Flow WYalve
Open |

Closed | Open |

ICS5-1000 Column Heater.

Inject Valve

Displays the current position of the inject
valve. The Inject and Load buttons select the
position.

Eluent Flow Valve

Displays the current position of the eluent
flow valve. The Closed and Open buttons
select the position.

Set Temp
Sets the temperature of the column heater.

Detector
IC5-1000 Detect
v Connected Signal: Supp. Type: LT 33 Cell Temp: [BESEIES 33
Autozero | Ready 5.0 Hz 33 SRS Current: SIS 33 SRS Mode: (B0 33 Show Plot...l
# from Pos.
10,0+
||ns ECD 1
|[0.112
5.0+
T min
U= T T T T T T T T T T 1
0.00 0.50 1.00 1.50 2.00 2.50 3.00 3.50 4.00 4.50 5.00
Connected

Connects the ICS-1000 to the Chromeleon Control Panel, enabling

communication between the PC and the module. Clearing the Connected
check box disconnects the ICS-1000 from the PC.

Autozero

Sets the conductivity to zero.

Ready

Indicates if the detector is ready to begin data acquisition.
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Signal
Displays the offset conductivity.

Data Rate

Sets the rate at which data points are recorded.

Supp. Type
Selects the type of suppressor installed.

SRS Current
Sets the current supplied to the suppressor.

Cell Temp
Sets the temperature of the cell.

SRS Mode
Selects whether the suppressor is on or off.

Show Plot

Displays the ICS-1000 detector signal plot in a separate window.
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2.4 System Component Details

This section provides details about ICS-1000 system components, including the
vacuum degas assembly (optional), eluent valve, pump, injection valve, column
heater (optional), suppressor, and conductivity cell.

241 Vacuum Degas Assembly (Optional)

The vacuum degas assembly provides online eluent degassing at the time
and duration specified by the user. The assembly, which must be installed
in the ICS-1000 at the factory, consists of:

A single-channel degas chamber (with degas membranes) with
internal capacity of 17 mL

A dual-stage diaphragm vacuum pump

A solenoid valve

An on-board vacuum sensor

The electronics required to operate the vacuum pump

Tubing, fittings, and other accessories

By default, the ICS-1000 monitors the degas pressure reading and turns
the degas pump on and off as needed. A different degas operating mode
can be selected from Chromeleon. To select degas operating options from
Chromeleon, open the Server Configuration program, select the ICS-1000

Doc. 031879-01 3/03
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device icon under the timebase, and select Properties from the Edit

menu. Select the Options tab (see Figure 2-10).

Dionex ICS-1000 System E3

Eror Levels | Dremo Chromatogram I TTL Inputz I Trend I Calibration I Diagnostics
General ~ Options | Signalz I Head Type & Limits I Solventz I State Devices

— Inztalled Options
¥ Degas

v LCalunin Heater

— Degaz Mode
€ Alwaps Off
€ Alwaps On
' Cycle

On; I':I (0,720 zec)
0fr: I':I [0..5340 zec)

QK. I Cancel | Lpply |

Help |

Degas Mode Options

* Always Off: The degas pump is always off.

Figure 2-10. Server Configuration Properties: Degas Mode Options

® Always On: The degas pump is always on. This setting is for test
purposes by a Dionex Service Representative. Do not use this setting

for routine operation.

® Cycle: The degas pump cycles on and off according to the times
specified in the Cycle On and Off fields. Cycle On specifies for how
long the degas pump runs during a cycle. Cycle Off specifies the time

between cycles.

® Monitor: (default mode) The ICS-1000 monitors the degas pressure
reading and turns the degas pump on and off as required.

2-20
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2.4.2 Eluent Valve

Figure 2-11. Eluent Valve

243 Pump

The eluent valve controls the flow
from the eluent reservoir. It opens
automatically when the pump is
running and closes when the
pump is off. The valve can also be
opened and closed manually from
the Chromeleon Control Panel
(see Section 2.3.2). This lets you
perform service procedures on
pump components without eluent
leaks occurring.

The ICS-1000 pump is a microprocessor-based isocratic eluent delivery
system. Its variable speed, dual-piston series design ensures pulse-free
pumping for the most demanding applications.

Primary Pump Head

The primary pump head pumps mobile phase into the secondary head (see
Figure 2-12). The check valves, which prevent reverse flow through the
pump, are located on the bottom (inlet) and top (outlet) of the primary
pump head. The priming valve is on the front of the pump head.

Doc. 031879-01 3/03
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Pressure
Transducer

Secondary
Pump Head

Waste Valve — 7

____ Outlet Check
Valve

Primary
- Pump Head

25 Priming
e Valve

Inlet Check
Valve

Figure 2-12. ICS-1000 Pump Components

To open the priming valve, turn the knob one-quarter to one-half turn
counterclockwise. When the priming valve is open, liquid can flow into
and out of the primary pump head via the port in the front of the valve.

NOTE The priming valve must be open when the pump is
being primed with a syringe or with isopropyl
alcohol. For detailed priming instructions, see
Section B.12.

Secondary Pump Head

The secondary pump head delivers eluent to the remainder of the
chromatography system (injection valve, column, and detector). The
waste valve is located on the front of the secondary pump head (see

Figure 2-12).

To open the waste valve, turn the knob one-quarter to one-half turn
counterclockwise. When the waste valve is in the open position, all output
is directed to waste.

NOTE The waste valve must be open when the pump is
being primed using the Prime button. For detailed
priming instructions, see Section B.12.

2-22
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Pressure Transducer

Flow exiting the secondary pump head is directed to the pressure
transducer (see Figure 2-12), which measures the system pressure.

Pressure measurements, which can be monitored from the Chromeleon
Control Panel, indicate that the pumping system is delivering smooth,
accurate flow.

The system pressure should remain consistent (no more than a 3%
difference from one pressure reading to the next). High and low pressure
limits can be used to stop the pump flow if a limit is exceeded. See
Section 4.1 for troubleshooting information if a pressure limit is
exceeded.

Pulse Damper

Flow output from the pressure transducer continues to the pulse damper,
which smooths minor pressure variations. From there, flow is directed to
the injection valve and then to the remainder of the chromatography
system.

Piston Seal Wash

The pump includes a piston seal wash assembly that can be set up to
continuously rinse the back of the piston seals to remove salt crystals and
prolong the life of the seals. To use this feature, an external water source
must be connected. See Section B.21 for connection instructions.

For continued protection of the pump, replace the piston rinse seals (see
Section 5.6) and O-rings in the seal wash assembly every 6 months, or
whenever you replace the main piston seals for the ICS-1000 pump.
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244

Injection Valve

The injection valve (P/N 057968) is a six-port, electrically-activated
valve. A 25-uL sample loop (P/N 042857) is installed on the valve at the
factory.

The valve has two operating positions: Load and Inject (see Figure 2-13).

Sample In W Sample In W

LOAD POSITION INJECT POSITION

To Column To Column

.......

......

To Waste From Pump To Waste From Pump

Figure 2-13. Injection Valve Flow Schematics

Eluent flows through either the Load or Inject path, depending on the
valve position.

* In the Load position, sample is loaded into the sample loop, where it
is held until injection. Eluent flows from the pump, through the valve,
and to the column, bypassing the sample loop. Sample flows from the
syringe or automated sampler line (if installed), through the valve,
and into the sample loop. Excess sample flows out to waste.

* In the Inject position, sample is swept to the column for analysis.
Eluent flows from the pump, through the sample loop, and on to the
column, carrying the contents of the sample loop with it. Section 3.10
describes how to inject samples.

Figure 2-14 shows the injection valve connections. The injection valve is
plumbed at the factory with all tubing and fittings for connection to the
pump, injection port, column, and waste. A 25-uLL PEEK sample loop
(P/N 042857) is installed between ports L (1) and L (4). Dionex offers

2-24
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sample loops in various sizes. If necessary, the pre-installed 25-uL loop
can be replaced with a loop that has a different sample injection volume.

SAMPLE IN
(from door
inject port or
autosampler)

25-uL
SAMPLE LOOP
(Orange)

N\

\—

TO INJ
VALVE -W

I (Green)

TO INJ

VALVE -C

== (Black)

TO INJECT|_ (Green)

VALVE -P

Figure 2-14. Injection Valve Plumbing
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245 Column Heater (Optional)

Figure 2-15. Column Heater

The column heater provides temperature
control for the separator and guard column.

The heater temperature can be set to between
30 °C and 60 °C and it must be set at least

5 °C above the ambient temperature.
Temperature is monitored via a thermistor
mounted in the heater block. Setting the
temperature to 0 °C turns off the column
heater.

If the temperature exceeds 65 °C, the column
heater is shut off and the error message
“Column heater exceeds safe temperature.”
is displayed in Chromeleon. See Section 4.1
for troubleshooting information.

The column heater can either be installed at
the factory or ordered separately (P/N
058060).
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2.4.6 Suppressor

The suppressor reduces the eluent conductivity and enhances the
conductivity of the sample ions, thereby increasing detection sensitivity.
Either an Atlas Electrolytic Suppressor, Self-Regenerating Suppressor, or
MicroMembrane Suppressor can be used with the ICS-1000.

For details about any of the suppressors or for information about selecting
a suppressor for your application, refer to the suppressor manuals. The
manuals are on the Dionex Reference Library CD-ROM (P/N 053891),
located in the ICS-1000 Ship Kit (P/N 057905).

2.4.7 DS6 Heated Conductivity Cell

The ICS-1000 flow-through conductivity cell measures the electrical
conductance of analyte ions as they pass through the cell. Two passivated
316 stainless steel electrodes are permanently sealed into the PEEK cell
body. The cell design provides efficient sweep-out, low volume (1 uL),
and low dispersion. Temperature control and compensation help ensure
good peak reproducibility and baseline stability.

Temperature Control

Temperature directly affects the conductivity of a solution. For example,
laboratory heating and air conditioning systems can cause a regular slow
cycling in the baseline. This, in turn, can affect the reproducibility of an
analysis. The higher the conductivity, the more pronounced the effect.

In ion analysis, the effect of temperature variation is minimized by
suppressing eluent conductivity. To further reduce the effect of
temperature variation, the ICS-1000 provides temperature control to the
cell. A heater inside the cell regulates the temperature. The cell heater can
be set to between 30 °C and 55 °C. The set temperature must be at least
7 °C above the ambient temperature. Setting the cell temperature to 0 °C
turns off the cell heater.

Temperature Compensation

Built-in preset temperature compensation of 1.7% per °C helps minimize
changes in the baseline or in peak heights if the operating temperature is
different from the temperature at which the cell was calibrated.

Doc. 031879-01 3/03 2-27



ICS-1000 lon Chromatography System

DS6 Heated Conductivity Cell Components

The cell front cover provides CELL IN and CELL OUT fittings for
connecting the cell to the suppressor (see Figure 2-4). The remaining cell
components are mounted behind the component panel. To replace, the cell
remove the screws on the cell front cover and pull the entire cell assembly
out through the component panel. See Section 5.9 for cell replacement
instructions.
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3 ¢ Operation and Maintenance

This chapter describes routine operating and maintenance procedures for the ICS-
1000 Ion Chromatography System.

3.1 Operation Overview

Figure 3-1 illustrates the basic steps for routine operation of the ICS-1000.

@ower up the system>

¥

< Start Chromeleon >

¥

(Set up the reservoir)
Check all
connections
< Prime the pump )
Set operating
conditions
Equilibrate the
system
< Prepare samples )
Verify operating
status

< Process samples )

Figure 3-1. ICS-1000 Operation Flow Chart
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Sample Processing Overview

Samples can be run either manually (one at a time), or they can be grouped and
run automatically in batches. Figure 3-2 shows the typical steps for manual and
batch sample processing. Samples can be loaded into the sample loop with an
autosampler or with a syringe through the injection port on the ICS-1000 front
door.

Manual Sample Batch Sample
Processing Processing
Using Chromeleon Using Chromeleon
(Load the sample) Create a Sequence

l Sequence Wizard)

Start data

acquisition ) [Add the Sequence}

to the Batch

Autozero ) ‘
l < Start the Batch )

Inject the sam ple)

C
C
e
[

(Optional)
Save the manual
sequence data

Figure 3-2. Sample Processing Overview
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3.2 Power Up the System

Power

Switch \?
B

T
il

-..___\7‘

]

m Ll

Press the power switch on the ICS-

‘ 1000 rear panel (see Figure 3-3) to
= - turn on the system power. Table 3-2
7 ‘ shows the ICS-1000 conditions at
r power up.

Also turn on the power to the
computer and the autosampler (if
used).

L

Figure 3-3. ICS-1000 Rear Panel

Feature

Pump
Injection valve
Cell
Suppressor
Cell heater

Power-Up Condition
Off

Load position
Reading current value
Off*

Set to the last value used. The default when the
ICS-1000 is turned on for the first time 1s 35 °C.

Column oven temperature ~ Set to the last value used. The default when the

(Optional)

ICS-1000 is turned on for the first time is 30 °C.

Table 3-2. ICS-1000 Power-Up Conditions

* When you start the suppressor, the value used last is restored.
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3.3 Start Chromeleon

NOTE See Section B.8 for how to set up Chromeleon, if you are
beginning operation of an ICS-1000 that has not been
configured in a timebase.

1. Ifthe Chromeleon Server is not running (the icon on the taskbar is crossed out
in red % ), start the Server by right-clicking the icon and selecting Start
Server. When the server starts, the icon changes to gray % .

2. Start Chromeleon by selecting Start>Programs>Chromeleon>
Chromeleon. The Chromeleon main window and the Browser will open.
Your screen display should resemble Figure 3-4. If the Browser does not
open, select Browser from the File menu to open it.

*} Chromeleon - AMAR _local’\Dionex Templates - Browser

File Edit Wiew ‘Workspace CQuoalification  Batch  Window  Help

Dl fS & 2R by BNy (s DEEEBE @
Rl e e s o ) |

Eﬂll“lﬂR_IucaI"-.,"-.,Diune:-: Templates - Browser

E@ AMAR, _local Matne / |Last Updste
- DEMO [ I Applications 20412003 11:18:32 A
SR BIDione:x Templates (2] Panelz 11642003 30551 P
i - 1 Applications (2] Reports 20442003 11:16:32 A

[ Panels
{0 Reports
=23 IC5-1000
(3 AUDIT
- manual

Figure 3-4. Chromeleon Main Window and Browser
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3. In the Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-1000
System Panels folder. Several ICS-1000 System Control Panels (.PAN files)
are provided, corresponding to various system configurations. There are two
styles of panels:

® Traditional panels provide controls on a single window with minimal
graphics.

® System panels provide a more graphical interface than the traditional style
and include more controls. You can choose either style of panel,
depending on your personal preference.

4. Open a panel for your system configuration by double-clicking its name in the
list. For example, if your system includes an ICS-1000 and an AS50
autosampler, double-click either ICS-1000_Traditional_System_ASS50.pan
or ICS-1000_System_AS50.pan.

5. The Control Panel opens, unconnected (see Figure 3-5). To connect to the
timebase, open the Control menu and click the name of the ICS-1000
timebase from the list at the bottom of the menu.

EF System - - =gl LI
Pump_ECD.DeviceType} Pump. Sampl System Loy [Audit Trail] on {TimeBaseName
(Pump - PumpMode} D == @

T——
m M! Sequence: @:‘
= ¢ Sample: @—‘

Pump Setlings... Program: (81} | i
Pump_ECD.DeviceType} Injector. . Elapsed Program Time: Egem.Retentiu\ Pump_ECD.DeviceType} System—mmoo—o
[umpilnjel:tValve.Slatw Total Program Time: Eystem.F!grnEm} I” Connected Startup | Shutdown| Show F'Iu(l

Load Inject 100 Sample.Sequence} #{Sample.Humber] olume;d} from Pos. {[Position
Injector Settings...

Pump_ECD.DeviceType} Detector:

72 {ECD_1.Sig

SUPPIESSOT - {SUPPresst
] [essor_Curi

.0

Detector Settings... [l.[‘ll] 0.50 1.00 1.50 2.00 2.50 3.00
Figure 3-5. ICS-1000 System Control Panel (Unconnected)
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Figure 3-6 shows a connected Control Panel for an ICS-1000 system.

% 1CS-1000 System - ICS-1000 - AMAR _ ol x|

ICS-1000 Pump. Sampl System Log [Audit Trail] on CS-1000 ]
ump - On D ce: l:l 16:07:29 User [AMar) fram AMAR -
. 800 psi 5 has connected to timebase ICS-1000

Sequence: l:l @16:07:29 User [AMar) fram AMAR

e — Sample: l:l has acquired control over timebase [CS-1000.

Pump Setlings... Program: =
ICS-1000 Injec Elapsed Program Time: [ || ics-1000 Syst
E Total Program Time: l:l ¥ Connected Startup Shutdown| Show F'Iu(l
Load Inject

Injector Settings...

0.108 pS
Suppressor - Off- st
3

Detector Settings...

ICS-1000 D

T
0.00 0.50

Figure 3-6. ICS-1000 System Control Panel (Connected)

NOTE The ICS-1000 Ion Chromatography System is designed
for use for IC (ion chromatography) and BioLC
applications and should not be used for any other
purpose. If there is a question regarding appropriate
usage, contact Dionex.

3.4 Set Up the Eluent Reservoir

3.41 Prepare the Eluent

Prepare the eluent according to the instructions in the column manual.
Column manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891).

3.4.2 Degas the Eluent

Eluent quality significantly affects the performance of the ICS-1000. To
ensure optimal pump performance, observe the following precautions:
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¢ Dionex strongly recommends vacuum degassing all eluents. This
helps prevent bubbles, caused by outgassing, from forming in the
pump heads and the detector flow cell.

* The optional vacuum degas assembly provides programmable, online
degassing. The degas assembly must be installed in the ICS-1000 at
the factory. If the ICS-1000 does not contain a degas assembly,
manually degas eluents daily (following the instructions below) and
store it in pressurized reservoirs.

Manual Degassing of Eluent

1. Prepare the eluent required for the application and pour it into a
vacuum flask

1. Pour the deionized water into a vacuum flask
2. Attach the flask to a vacuum pump or water aspirator.

3. Vacuum degas the eluent deionized water for 5 to 10 minutes by
shaking or sonication.

4. Remove the flask from the vacuum. Do not allow water to flow
from the aspirator back into the flask.

5. Pour the degassed eluent deionized water into a pressurizable
reservoir. Do not shake the eluent.

6. Install an end-line filter on the eluent deionized water line (see
Section 3.4.3).

7. Pressurize the reservoir (see Section B.20).

3.4.3 Filter the Eluent

Filtering removes small particulates in the eluent that may contaminate
the pump check valves and cause erratic flow rates or loss of prime. An
end-line filter (P/N 045987) is provided in the ICS-1000 Ship Kit

(P/N 057905) for this purpose.

Install the end-line filter on the end of the eluent line, inside the reservoir.
Verify that the end of the filter extends to the bottom of the reservoir and
that the filter is submerged in eluent. This prevents air from being drawn
through the lines. Refer to the Pressurizable Reservoir Installation
Instructions for details.
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lIMPORTANT]

3.4.4

3.4.5

Fill the Reservoir

Fill the reservoir with the prepared eluent.

Set the Eluent Level

After filling the reservoir, enter the volume of liquid in the reservoir on
the Chromeleon Control Panel (see Figure 3-6). The ICS-1000 determines
the eluent usage by monitoring the flow rate and the length of time the
pump is on, and updates the Eluent Level field as the eluent is used up. A
warning first appears if the level falls below 200 mL. Warnings are
repeated at 100 mL and 0 mL.

In order for the eluent level displayed on the Control Panel to be
accurate, the level must be entered by the user when the reservoir is
filled. The ICS-1000 does not automatically detect when the reservoir
is filled, nor when it is empty.

Enter the volume of Note: The Eluent Bottle
liquid in the reservoir - 2 00 field and slider gauge

IC5-1000 Pump-
-Eluent Buttle

are updated as the

liquid is used up.

3.4.6

Figure 3-7. Setting the Eluent Level

Connect the Reservoir

If it is not already connected, connect the ELUENT BOTTLE OUT line from
the reservoir cap to the ELUENT IN line, which extends from the plumbing
and cable chase on the top of the ICS-1000.

3-8
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3.5 Check All Connections

1. Make sure the reservoir is filled and the tubing connecting the reservoir to the
ICS-1000 tubing is securely connected.

2. Make sure the USB cable from the computer is connected to the USB
receptacle on the [CS-1000 rear panel.

3.6 Prime the Pump

If you changed eluent or if the eluent lines are dry, prime the lines first

with a syringe before priming the pump. See Section B.14.1 for
instructions.

1. Verify that the priming valve on the primary pump head (see Figure 3-8) is
closed (turned all the way clockwise).

2. Open the waste valve on the secondary pump head by turning the knob one-
quarter to one-half turn counterclockwise. Opening the valve directs the
eluent flow path to waste and eliminates backpressure.

Secondary
Pump Head

Waste Valve
(open)

Primary
Pump Head

Priming Valve
(close)

Figure 3-8. Priming the Pump

3. Press Prime on the Chromeleon Control Panel. A confirmation message is
displayed, asking if you opened the waste valve. Select Yes. The pump will
begin pumping at approximately 3.0 mL/min.

4. Continue priming the ICS-1000 until all air and previous eluent are purged
and no air bubbles are exiting the waste line.
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5. Press Pump Off.

6. Close the waste valve. Do not overtighten. The pump is now ready for
operation.

3.7 Set System Operating Conditions

NOTE This section is an overview of the steps needed to start
up the system and begin running samples. Actual
operating parameters (flow rate, cell heater
temperature, suppressor current, etc.) depend on the
application to be run. Refer to the column manual for
the required parameters for your application.

Set or verify system operating parameters from the Chromeleon Control Panel.
Operating parameters can also be set automatically by loading a Chromeleon
sequence.

NOTE Clicking the System Startup button on the Chromeleon
Control Panel, starts the pump and suppressor. The flow
rate and suppressor current settings that were in effect
when the system was shut down are restored.

1. Verify that the pump is on and set to the correct flow rate.

Verify that the suppressor current is on and that the setting is correct.

Verify that the cell heater is set to the correct value.

Sl

Verify that the column heater is set to the correct value.
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3.8 Equilibrate the System and Verify Operational Status

1. Allow the system to equilibrate. During equilibration, the Chromeleon
Control Panel displays the background conductivity (the conductivity of the
eluent before sample injection) and the system backpressure.

2. Monitor the background conductivity. Refer to the column manual for the
appropriate background conductivity for your application.

3. Offset the background and zero the reading by clicking the Autozero button
on the Chromeleon Control Panel (see Figure 3-4).

4. Monitor the system pressure from the Control Panel to make sure it is at the
expected pressure for the installed column (refer to the column manual for
details) and it stable.

® [fthe pressure is less than the expected amount, gas may be trapped in the
system. Release the gas by removing the pump fitting on the injection
valve port, labeled P (2). Allow the air to escape and then reconnect the
fitting.

¢ If'the pressure fluctuates by more than about 0.13 MPa (20 psi), prime the
pump. See Section 4.3 for additional troubleshooting information.

e [fthe pressure is too high, there may be a restriction in the system
plumbing. See Section 4.7 for troubleshooting information.

5. Verify that the baseline conductivity is at the expected reading for your
application and is stable. In general, it should be <30 uS for a system set up
for anion analyses and <2 uS for a system set up for cation analyses. See
Section 4.12 for troubleshooting information if the conductivity is too high.
See Section 4.13 if the baseline is drifting or has excessive “noise” (large
fluctuations in readings).

6. Verify that the cell heater is at the set point and is stable. The temperature is at
equilibrium when the Set Temperature and Current Temperature readings
on the Control Panel are the same.

7. Verify that the column heater temperature (if installed) is at the set point and
stable. The temperature is at equilibrium when the Set Temperature and
Current Temperature readings on the Control Panel are the same.

The system is now ready for sample processing.
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3.9 Prepare Samples

3.9.1

3.9.2

NOTE Sample preparation can be performed while the system
is equilibrating.

Collecting and Storing Samples

Collect samples in high density polyethylene containers that have been
thoroughly cleaned with deionized (DI) water. Do not clean containers
with strong acids or detergents because these can leave traces of ions on
the container walls. The ions may interfere with the analysis.

If samples will not be analyzed on the day they are collected, filter them
through clean 0.45 pum filters immediately after collection; otherwise,
bacteria in the samples may cause the ionic concentrations to change over
time. Refrigerating the samples at 4° C (39° F) will reduce, but not
eliminate, bacterial growth.

Analyze samples containing nitrite or sulfite as soon as possible. Nitrite
oxidizes to nitrate, and sulfite to sulfate, thus increasing the measured
concentrations of these ions in the sample. In general, samples that do not
contain nitrite or sulfite can be refrigerated for at least one week with no
significant changes in anion concentrations.

Pretreating Samples

Analyze rainwater, drinking water, and air particulate leach solutions
directly with no sample preparation (other than filtering and possibly
diluting).

Filter groundwater and wastewater samples through 0.45 um filters
before injection, unless samples were filtered after collection.

Before injection, pretreat samples that may contain high concentrations of
interfering substances by putting them through Dionex OnGuard®
cartridges. Refer to the Installation and Troubleshooting Guide for
OnGuard Cartridges (Document No. 032943) for instructions.

3-12
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3.9.3

Diluting Samples

Because the concentrations of ionic species in different samples can vary
widely from sample to sample, no single dilution factor can be
recommended for all samples of one type. In some cases (for example,
many water samples), concentrations are so low that dilution is not
necessary.

Use eluent or ASTM filtered, Type I (18-megohm) deionized water or
eluent to dilute the sample. When using carbonate eluents, diluting with
eluent minimizes the effect of the water dip at the beginning of the
chromatogram. If you dilute the sample with eluent, also use eluent from
the same lot to prepare the calibration standards. This is most important
for fluoride and chloride, which elute near the water dip.

To improve the accuracy of early eluting peak determinations, such as
fluoride, at concentrations below 50 ppb, dilute standards in eluent or
spike the samples with concentrated eluent to minimize the water dip. For
example, spike a 100 mL sample with 1.0 mL of a 100 X eluent
concentrate.
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3.10 Loading and Injecting Samples

Samples can be loaded into the sample loop through the injection port on the front
door using a syringe or vacuum syringe, or they can be loaded using an
autosampler.

For autosampler injections, the injection port tubing is disconnected from the ICS-
1000 injection valve and replaced by the autosampler outlet tubing. Other setup
requirements depend upon the model of autosampler.

Setup for an AS40 Autosampler
A relay or TTL connection is required for Chromeleon to control sample loading.
See Section B.18 for AS40 autosampler installation instructions.

Setup for an AS50 Autosampler

To use an AS50 autosampler with the ICS-1000, the AS50 must meet the
following requirements:

* Aninjection valve cannot be installed in the AS50
® The AS50 must have Moduleware version 1.11 or later installed
®  Control of the ICS-1000 injection valve must be enabled in the AS50

The following AS50 models are configured at the factory to meet the above
requirements:

® ASS50 without injection valve (P/N 061309)
* AS50 without injection valve; with sample preparation (P/N 061310)

*  AS50 without injection valve; with sample preparation and sample tray
cooling (P/N 061311)

* ASS50 without injection valve; with sample tray cooling (P/N 061312)
See Section B.17 for AS50 autosampler installation instructions.

After the AS50 is configured for use with the ICS-1000, all AS50 modes of
injection (full-loop, partial-loop, and partial-loop limited-sample) are supported.
In addition, all AS50 injection valve commands (whether issued from the AS50
front panel or from Chromeleon) will control the ICS-1000 injection valve. For
Chromeleon control, the AS50 must be added to the ICS-1000 timebase (see
Section B.8). For front panel control, the AS50 and ICS-1000 can be set up for
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stand-alone operation. This requires a TTL cable connection between the AS50
and the ICS-1000. See Section C.3 for stand-alone setup instructions.

3.10.1 Loading Samples with a Syringe

1. Make sure the injection port on the ICS-1000 front door (see
Figure 2-1) is connected to the sample port S (5) on the injection valve

(see Figure 3-9).

SAMPLE IN
(from door
inject port or
autosampler)

25-uL
SAMPLE LOOP
TO INJ
(Orange) VALVE -C [ (Black)
TO INJECT|. (Green
TO INJ VALVE - | I
VALVE -W
| (Green)

Figure 3-9. Injection Valve Connections
2. Fill the 1 cc syringe (P/N 016388) provided in the ICS-1000 Ship Kit
(P/N 057905) with a calibration standard or sample.
3. [Insert the syringe into the injection port on the ICS-1000 front door.
4. Verify that the injection valve is in the Load position.

5. Overfill the sample loop with several sample loop volumes. Excess
sample will exit through the injection valve waste line.

6. Leave the syringe in the port.

7. Switch the injection valve to the Inject position (see Section 3.10.4).
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3.10.2 Loading Samples with a Vacuum Syringe

3.10.3

L.

Disconnect the waste line from port W (6) of the injection valve (see
Figure 3-9) and attach a shorter line: 25 to 30 cm (10 to 12 inches) of
PEEK or Teflon® tubing.

Place the free end of the line into the sample.
Verify that the injection valve is in the Load position.

Insert the 1 cc syringe (P/N 016388) provided in the ICS-1000 Ship
Kit (P/N 057905) into the injection port on the ICS-1000 front door
(see Figure 2-1) and pull out the plunger to draw the sample into the
injection valve.

Switch the injection valve to the Inject position (see Section 3.10.4).

Loading Samples with an Autosampler

1.

Verify that the autosampler output line is connected to port S (5) of the
ICS-1000 injection valve.

Prepare and fill the sample vials and place them in the autosampler
tray or cassette. Refer to the autosampler manual for detailed
instructions.

The sample loading process depends on the autosampler. Refer to the
autosampler manual for detailed instructions. In general, use one of
the following methods:

¢ Include the commands for controlling sample loading in a
Chromeleon program. See the examples in Section 3.10.5.

* Enter the commands for loading the sample from the autosampler
front panel.

Switch the injection valve to the Inject position (see Section 3.10.4).

NOTE If you are running the ICS-1000 without
Chromeleon control, see Section C.3 for stand-
alone setup and operation instructions using an
AS50 autosampler.
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3.10.4 Injecting Samples

After loading the sample in the sample loop, switch the injection valve to
the Inject position, using one of the following methods:

® Manually: Click the Inject button on the Chromeleon Control Panel
(see Figure 3-6).

* Automatically: Include the Inject command in a Chromeleon
program. See the examples in Section 3.10.5.

3.10.5 Example Chromeleon Commands for Loading and
Injecting Samples

The following examples show commands for loading and injecting
samples using an AS50 or AS40 autosampler.

Example AS50 Program Commands

0.000 Pump_ ECD.Autozero ;Zero the baseline.
Load ;Switch the valve to Load.
Wait CycleTimeState ;Wait for cycle time (if any).
Inject ;Switch the valve to Inject.
Wait InjectState ;Wait for injection to complete.
ECD_1.AcqOn ;Start data acquisition.

14.000 ECD_1.AcqOff ;Stop data acquisition.

Example AS40 Program Commands

-2.300 Pump_ECD_Relay_1.Closed Duration=138.00 ;Note 1
0.000 Pump_ECD.Autozero ;Note 2
ECD_1.AcqOn ;Note 3
Pump_InjectValve.InjectPosition Duration=30.00 ;Note 4
30.00 ECD_1.AcqOff ;Note 5
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AS40 Program Command Notes:

1. Close the ICS-1000 RELAY OUT 1, which is connected to the AS40
LOAD relay. This signals the AS40 to load the sample.

Zero the baseline.
Start data acquisition.

Switch the valve to Inject.

A

Stop data acquisition.

3.11 Process Samples

Samples can be run either manually (one at a time) or automatically (in groups or
“batches™).

3.11.1 Manual Sample Processing

To process samples manually, select operating parameters and commands
from the Chromeleon menu bar, toolbars, and Control Panel. Commands
are executed as soon as they are entered.

1. Complete the steps in Sections 3.2 through 3.8 to prepare for
operation and start up the ICS-1000.

2. Load the sample using a syringe, vacuum syringe, or autosampler
(see Section 3.10).

3. Select Acquisition On from the Control menu. Chromeleon records
the signal supplied by the detector and displays the signal plot on the
Control Panel.

4. Click the Autozero button on the Control Panel.
5. Inject the sample (see Section 3.10.4).

6. Monitor the chromatogram on the Control Panel and select
Acquisition Off from the Control menu when sample data is
collected.

NOTE Data from Chromeleon manual processing is saved
in the MANUAL sequence folder under the local
datasource. This data is overwritten each time a
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new manual sample is processed. To save the data
from a manual run, select the MANUAL folder,
select Save As from the File menu, and enter a new
name for the sequence.

3.11.2 Automatic (Batch) Sample Processing

For batch processing, you use Chromeleon to create a list of samples (a
sequence) to be processed automatically. For each sample, the sequence
includes a program with commands and parameters for controlling the
ICS-1000, controlling the autosampler (if used), and acquiring sample
data. The sequence also includes a quantification method for peak
identification and area determination. Additional sample processing
parameters are included in the sequence (for example, the sample name,
sample type, injection volume, etc.).

After defining the sequence, you can start batch processing.

1. Complete the steps in Sections 3.2 through 3.8 to prepare for
operation and to start up the ICS-1000.

2. Create a new sequence or modify an existing one.
To create a new sequence:

a. In the Browser, select File>New. Select Sequence (using
Wizard) and click OK.

b. Complete the steps in the Sequence Wizard, adding the desired
number of samples and standards to the list. For help with any of
the steps, click the Help button on the Sequence Wizard page.

NOTE A simple way to get started is to select the “Use
Application Template” option in Step 4 of the
Sequence Wizard. This option lets you select a
column and suppressor type from a list of
applications. The Wizard then copies a program
and quantification method, appropriate for the
selected application, to the sequence folder and adds
them to the sequence definition.
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3. To start the sample processing, make sure the System Control Panel is
open (see Section 3.3) and is the active window. Then, select Edit
from the Batch menu. The Batch dialog box opens (see Figure 3-10).

Batch - ics-1000 =]
Batch List |F|ep0rting| Errar Handlingl Transferl
MHame | Operator |
tove Up |
Mawe Down |
Start | Cloze | Fieady Qheckl Help

Figure 3-10. Batch Dialog Box

4. Click the Add button on the Batch List tab and add the sequence you
created in Step 2. See Figure 3-11 for an example.

Batch - ics-1000 =]
Batch List | Heportingl Errar Handlingl Tran&ferl
Mame | Operator |
fH | 0510004 T est amarguardt
Bemowve |
tove Up |
tove Down |
Start | Cloge | Ready Qheckl Help |

Figure 3-11. Batch Dialog Box with an Example Sequence Added to the Batch List

5. To start the batch, click Start.
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3.12 Maintenance

This section describes routine maintenance procedures that users may perform.
All other maintenance procedures must be performed by Dionex personnel.

As Needed

® Regularly check the eluent reservoir to see if it needs to be refilled.

® Make fresh eluent as needed.

Daily

®  Check the ICS-1000 component mounting panel (see Figure 2-4) for leaks or
spills. Wipe up spills. Isolate and repair leaks (see Section 4.2). Rinse off any
dried eluent with deionized water.

® Check the waste container daily and empty when needed.

Weekly

®  Once a week, check fluid lines for crimping or discoloration. Relocate any
pinched lines. Replace damaged lines.

®  Check the junctions between the pump heads and the pump casting for
evidence of liquid leaks. If piston seal wash tubing is not connected, check the
drain tubes at the rear of the pump heads for evidence of moisture. Normal
friction and wear may gradually result in small liquid leaks around the piston
seal. If unchecked, these leaks can gradually contaminate the piston housing,
causing the pump to operate poorly. If leaks occur, replace the piston seals
(see Section 5.6).

®  Check the end-line filter (P/N 045987) and change if needed. When new, end-
line filters are pure white. If the system is in continuous operation, change the
end-line filter weekly, or whenever it becomes discolored. Replace the filter
more often if bacterial buildup is visible or if the eluent does not contain
solvent.

NOTE It is especially important to regularly replace end-line
filters when using aqueous eluents, which may
contaminate the filter with bacteria or algae. The
bacterial buildup may not be visible.
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Every Six Months
e (alibrate the cell (see Section 5.1.2).

® (Calibrate the vacuum degas assembly (see Section 5.1.4).

® Replace the pump piston rinse seals and piston seals (see Section 5.6).

Yearly

® Rebuild the injection valve (see Section 5.4).

® Replace the AS40 Automated Sampler tip and tubing. The AS40/ASM
Maintenance Kit (P/N 055647) contains all of the components required to
replace the sampling tip and the tubing between the tip and the injection
valve. Instructions are included with the kit.

® Perform the AS50 preventive maintenance procedure. The AS50 Maintenance
Kit (P/N 060581) contains all of the required components and instructions for
performing the procedure.
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This chapter is a guide to troubleshooting problems that may occur while

operating the ICS-1000 Ion Chromatography System.

® Section 4.1 describes error messages and how to troubleshoot them. Table 4-3
lists the messages and the page numbers where they are described.

® The remaining sections in this chapter describe other operating problems and

how to resolve them. Table 4-4 lists the operating problems and the page

numbers where they are described

If you are unable to eliminate a problem, contact Dionex for help. In the U.S., call
Dionex Technical Support at 1-800-346-6390. Outside the U.S., call the nearest
Dionex office

Alarms and Error Conditions

COLUMN HEATER EXCEEDS SAFE TEMPERATURE

COLUMN HEATER OPEN CIRCUIT
COLUMN HEATER SHORT CIRCUIT
DEGAS CALIBRATION FAILED
HARDWARE NOT PRESENT

LEAK SENSOR WET

LOAD/INJECT VALVE ERROR

OPTION NOT INSTALLED

PRESSURE SLOPE CALIBRATION ERROR
PUMP MOTOR LOST CONTROL

PUMP PRESSURE HARDWARE ERROR
PUMP OVER PRESSURE

PUMP UNDER PRESSURE
SUPPRESSOR OVER CURRENT
SUPPRESSOR OVER VOLTAGE
SUPPRESSOR OVER POWER
SUPPRESSOR NOT CONNECTED

See

page 4-3
page 4-3
page 4-3
page 4-4
page 4-4
page 4-4
page 4-5
page 4-5
page 4-5
page 4-6
page 4-6
page 4-6
page 4-7
page 4-7
page 4-8
page 4-8
page 4-8

Table 4-3. ICS-1000 Alarms and Error Messages Summary
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Alarms and Error Conditions See
SUPPRESSOR STOPPED FOR FLOW RATE page 4-9

Table 4-3. ICS-1000 Alarms and Error Messages Summary (Continued)

Other Operating Problems See
Liquid Leaks page 4-9
Pump Difficult to Prime or Loses Prime page 4-11
Pump Does Not Start page 4-13
No Flow page 4-14
Erratic Flow/Pressure Reading page 4-15
Excessive System Backpressure page 4-15
Peak “Ghosting” page 4-16
Nonreproducible Peak Height or Retention Time page 4-17
Abnormal Retention Time or Selectivity page 4-17
No Cell Response page 4-18
High Cell Output page 4-18
Baseline Noise or Drift page 4-19
Vacuum Degas Assembly Does Not Run page 4-20

Table 4-4. Operating Problems Summary
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4.1 Alarms and Error Conditions

If any of the following alarm conditions occurs, a message is displayed in the
Chromeleon Audit Trail.

@ COLUMN HEATER EXCEEDS SAFE TEMPERATURE

This error occurs when the column heater temperature is higher than the
maximum allowed. This error may occur if the ICS-1000 is operating in an
extreme environment (greater than 40 °C).

To troubleshoot:

e Refer to Section A.3 for environmental specifications.

{E‘ COLUMN HEATER OPEN CIRCUIT
This error message occurs when the column heater is unplugged from the
component panel.
To troubleshoot:

1. Check that the column heater is correctly plugged into the component
panel.

2. Ifthe error persists, the column heater may be faulty. Replace the
column heater (see Section 5.11).

{E' COLUMN HEATER SHORT CIRCUIT

This error occurs when there is a short circuit on the thermistor input used to
measure the column heater temperature. This error indicates a faulty column
heater.

To troubleshoot:

® Replace the column heater (see Section 5.11).
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{E' DEGAS CALIBRATION FAILED

This error occurs when the degas vacuum does not reach the expected level
during calibration.

To troubleshoot:
1. Retry the calibration.

2. [If calibration still fails, the vacuum degas assembly may need to be
replaced. Contact Dionex for assistance.

HARDWARE NOT PRESENT

This error indicates an error in the ICS-1000 electronics.

To troubleshoot:

® Contact Dionex for assistance. The ICS-1000 electronics components
cannot be serviced by the user.

LEAK SENSOR WET

The leak sensor is installed in the drip tray at the bottom of the component
panel (see Figure 2-4). If liquid accumulates in the tray, the sensor signals the
problem and the “Leak sensor wet” error message appears.

To troubleshoot:

1. Locate the source of the leak by visually inspecting the tubing,
fittings, and components on the component panel.

2. Tighten fittings or replace tubing and fittings as required. Refer to
Section 4.2 for detailed troubleshooting of various types of leaks.

3. After fixing the leak, dry the drip tray thoroughly to prevent the leak
sensor from triggering additional error messages.
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@ LOAD/INJECT VALVE ERROR

If the injection valve fails to switch position within 1 second of being toggled,
the ICS-1000 Moduleware reports an error to Chromeleon and the
“Load/Inject valve error” message appears.

To troubleshoot:

1. If asequence is being executed, terminate the sequence by selecting
Stop on the Chromeleon Batch menu.

2. Turn off the ICS-1000 power briefly and then restart.

3. Try to toggle the valve from Load to Inject by clicking the Load and
Inject buttons on the ICS-1000 Control Panel in Chromeleon.

4. If the problem persists, contact Dionex for assistance.

@ OPTION NOT INSTALLED

This error occurs if a command is issued to control an option that is not
installed.

To troubleshoot:

® Check the Chromeleon Server Configuration program to verify that the
option is enabled.

{E‘ PRESSURE SLOPE CALIBRATION ERROR

This error occurs if you try to calibrate the pressure slope when the pressure is
less than 3 MPa (500 psi).

To troubleshoot:

* This is a service level error message. Contact Dionex for assistance.
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{E‘ PUMP MOTOR LOST CONTROL

This error indicates an error in the pump controller electronics.
To troubleshoot:

® Contact Dionex for assistance. The ICS-1000 electronics components
cannot be serviced by the user.

PUMP PRESSURE HARDWARE ERROR

This error indicates an error in the pump controller electronics.
To troubleshoot:

* Contact Dionex for assistance. The ICS-1000 electronics components
cannot be serviced by the user.

PUMP OVER PRESSURE

The ICS-1000 has a maximum system pressure limit of 34.5 MPa (5000 psi).
The pressure limit can be lowered from Chromeleon (in the Server
Configuration or in the control program). If the system pressure exceeds the
set limit for at least 0.5 seconds, the pump stops and the “Pump over pressure”
error message appears.

To troubleshoot:

1. Check for blockages in the liquid lines by working your way
backward from the cell to the pump. See Figure 2-6 for the flow
schematic).

2. Check that the flow rate is set to the correct value.
3. Check that the high pressure limit is set to the correct value.

4. Restart the pump.
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@ PUMP UNDER PRESSURE

The ICS-1000 has a minimum pressure limit of 0. The low pressure limit can
be raised from Chromeleon (in the Server Configuration or in the control
program). If the system pressure falls below the low pressure limit, the pump
stops and the “Pump under pressure” error message appears.

To troubleshoot:

1.

2
3
4.
5

Make sure the eluent reservoir is full.
Check for liquid leaks (see Section 4.2).
Check that the waste valve is closed.
Prime the pump (see Section B.12).
Restart the pump.

@ SUPPRESSOR OVER CURRENT

This error may be caused by an exhausted or dirty suppressor or by a
malfunction in the suppressor controller electronics.

To troubleshoot:

1.

Follow the instructions in the suppressor manual to regenerate the
suppressor. Suppressor manuals are included on the Dionex
Reference Library CD-ROM (P/N 053891), located in the ICS-1000
Ship Kit (P/N 057905).

Follow the instructions in the suppressor manual to clean the
Suppressor.

If a malfunction in the suppressor controller is suspected, contact
Dionex for assistance. The ICS-1000 electronics components cannot
be serviced by the user.
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@ SUPPRESSOR OVER VOLTAGE

This error appears if you turn on the suppressor and the ICS-1000 cannot
establish a connection with the suppressor.

To troubleshoot:
1. Check the suppressor cable connection (see Section 5.10).

2. If the error persists, replace the suppressor (see Section 5.10).

SUPPRESSOR OVER POWER

This error appears when, in order to maintain the selected current, the ICS-
1000 is required to apply a higher voltage than the suppressor can support.
To troubleshoot:

® Reduce the flow rate.

® Rehydrate the suppressor. Refer to the suppressor manual for instructions.
Suppressor manuals are included on the Dionex Reference Library CD-
ROM (P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).

® [fthe error persists, replace the suppressor (see Section 5.10).

SUPPRESSOR NOT CONNECTED
This error appears if you turn on the suppressor and the ICS-1000 cannot
establish a connection with the suppressor.
To troubleshoot:
1. Check the suppressor cable connection (see Section 5.10).

2. If the error persists, contact Dionex for assistance. There may be a
problem in the suppressor controller electronics. The ICS-1000
electronics components cannot be serviced by the user.
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{E‘ SUPPRESSOR STOPPED FOR ZERO FLOW RATE

This error appears normally when you click the Shutdown button on the
Chromeleon Control Panel. The message also appears anytime you turn off
the pump flow while the suppressor is on. The suppressor is automatically
turned off to prevent damage to the suppressor.

To troubleshoot:

® [f the pump stopped unexpectedly, see Section 4.5 for pump
troubleshooting information.

4.2 Liquid Leaks

Leaking fitting

Locate the source of the leak. Tighten or, if necessary, replace the liquid line
connection (see Section 5.3). Refer to Installation of Dionex Liquid Line
Fittings (Document No. 031432) for tightening requirements. The manual is
on the Dionex Reference Library CD-ROM (P/N 053891).

Broken liquid line

Replace the line and fittings with the same length and internal diameter tubing
(see Section 5.3).

Blocked or improperly installed line

Make sure the lines are not crimped or otherwise blocked. Also, if the blocked
line is a waste line, make sure it is not elevated at any point after it exits the
ICS-1000. If a line is blocked, replace it (see Section 5.3).

Loose pump check valve

Make sure the check valves are firmly seated in the pump head. If they are
not, tighten them carefully with an open end wrench just until the leak stops.

If the leak persists, replace the check valve (see Section 5.5).
Leaking seal wash port

Leaking from the seal wash port indicates a leaking piston seal. Replace the
seal (see Section 5.6).
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Damaged pump piston seal

1. Replace the piston seal (see Section 5.6).

2. If the leak persists, replace the piston (see Section 5.7).
Pump head not tight against casting

Carefully tighten the pump head mounting nuts just until the leak stops. DO
NOT OVERTIGHTEN!

Leaking pressure transducer

Make sure the liquid line connections into the pressure transducer are tight.
Refer to Installation of Dionex Liquid Line Fittings (Document No. 031432)
for tightening requirements. The manual is on the Dionex Reference Library
CD-ROM (P/N 053891). Replace any damaged fittings. The pressure
transducer cannot be serviced by the user. Contact Dionex for assistance.

Leaking pump head waste valve

Make sure the waste valve is closed. To close the valve, turn the knob
clockwise, and tighten fingertight. DO NOT OVERTIGHTEN!
Overtightening may damage the valve and the pump head.

If the leak persists, replace the waste valve O-ring (see Section 5.8).
Leaking suppressor

Refer to the suppressor manual for troubleshooting procedures. Suppressor
manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).

Leaking injection valve

Make sure the liquid line connections to the transducer are tight. Refer to
Installation of Dionex Liquid Line Fittings (Document No. 031432) for
tightening requirements. The manual is on the Dionex Reference Library CD-
ROM (P/N 053891). Replace any damaged fittings.

Liquid leaks from behind the valve stator may indicate a scratched rotor seal.
Rebuild the injection valve (see Section 5.4).

Leaking cell

Check the waste lines for blockage; trapped particles can plug the lines and
cause a restriction and/or leak. If necessary, clear the waste lines by reversing
the direction of flow.
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Make sure the plumbing downstream from the cell is clear; a blockage may
overpressurize the cell, causing it to leak. If the problem continues, contact
Dionex for assistance.

4.3 Pump Difficult to Prime or Loses Prime

Excessive pressure fluctuations (more than 3% difference from one pressure
reading to the next) indicate that the pump is out of prime.

*  Empty eluent reservoir and/or no eluent connected
Fill the reservoir. Make sure all connections are secure.
* Eluent improperly or insufficiently degassed

If the ICS-1000 does not contain a vacuum degas assembly, degas the eluent
manually (see Section 3.4.2).

If the ICS-1000 contains a vacuum degas assembly, check the degas settings:

1. Open the Chromeleon Server Configuration program, select the ICS-
1000 device icon under the timebase and select Properties from the
Edit menu (or double-click the ICS-1000 device icon).

2. Select the Options tab (see Figure 4-1).
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Dionex ICS-1000 System E

Error Levels | Dema Chromatagranm I TTL Inputs I Trend I Calibration I Diagnostics
General  Options | Signals I Head Type & Limits I Saolvents I State Devices

r— Installed Options
v Deqgaz

¥ Column Heater

— Degas Mode
 Always Off
 Always On
€ Cycle

On: IIJ (0120 sec)
0ff: IIJ [0..5940 zec)

QK I Cancel | S | Help |

Figure 4-1. ICS-1000 Server Configuration Properties: Options

3. Verify that the Degas check box is enabled under Installed Options.

4. Check the Degas Mode settings. Select either the Monitor option or
the Cycle option. If you select Cycle, set the time on to 30 seconds
and the time off to 10 minutes. If Cycle is already selected, try
increasing the time on or decreasing the time off.

End-line filter is dirty or clogged

When new, end-line filters (P/N 045987) are pure white. If the system is in
continuous operation, change the end-line filter weekly, or whenever it
becomes discolored. Replace the filter more often if bacterial buildup is
visible or if the eluent does not contain solvent. See the Pressurizable
Reservoir Installation Instructions for more information about end-line filters.

NOTE It is especially important to regularly replace end-line
filters when using aqueous eluents, which may
contaminate the filter with bacteria or algae. The
bacterial buildup may not be visible.

4-12
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Blockages in inlet tubing

Kinked or clogged tubing causes the pump to be “starved” for eluent. Replace
the tubing and fittings (see Section 5.3).

Dirty check valve
Clean or replace the pump check valve (see Section 5.5).
Liquid leaks at junction between pump head and pump casting

Use the open-end wrench (P/N 014605) provided in the ICS-1000 Ship Kit
(P/N 057905) to tighten the two acorn nuts that attach the pump head to the
pump housing (see Figure 5-4). Tighten the nuts evenly (12 in-1b torque).

If the leak persists, replace the piston seal (see Section 5.6).
Liquid leaks from the seal wash port

Replace the piston seal (see Section 5.6).

Scratched pump piston

Check the pump pistons for scratches and replace if necessary (see
Section 5.7).

4.4 Pump Does Not Start

No power (front Power LED indicator is not lit)

Check that the power cord is plugged in.

Check the main power fuses and replace if needed (see Section 5.16).
No communication between ICS-1000 and Chromeleon

Verify that the USB cable is connected correctly. See Section B.5 for
installation instructions.

Pump is turned off

Turn on the pump from the Chromeleon Control Panel.

Flow rate is set to 0

Set the flow rate from the Chromeleon Control Panel.
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4.5 No Flow

®* Pump waste or priming valve open (see Figure 4-2).

Close the valves by turning the knobs clockwise until fingertight. DO NOT
OVERTIGHTEN! Overtightening may damage the valve and the pump
head.

Priming Valve

Waste Valve

Figure 4-2. Waste and Priming Valves

* Flow rate is set to 0
Set the flow rate from either the Chromeleon Control Panel.
* Eluent valve is closed
Open the eluent valve from either the Chromeleon Control Panel.
*  Pump not primed
Prime the pump (see Section B.12).
* Broken pump piston

Replace the piston (see Section 5.7).

4-14 Doc. 031879-01 3/03



4 * Troubleshooting

4.6

4.7

Erratic Flow/Pressure Reading

Pump needs priming

Prime the pump (see Section B.12).

Damaged piston seal

Replace the piston seal (see Section 5.6).

Dirty pump check valve

Clean or replace the check valve (see Section 5.5).
Leaking liquid lines or fittings

Check the liquid lines and fittings for small leaks. Tighten or, if necessary,
replace the liquid line connection (see Section 5.3). Refer to Installation of
Dionex Liquid Line Fittings (Document No. 031432) for tightening
requirements. The manual is on the Dionex Reference Library CD-ROM
(P/N 053891).

Excessive System Backpressure

Restriction in the system plumbing

Check all liquid lines for crimping or blockage. Make sure the ferrule fittings
are not overtightened onto tubing. Refer to Installation of Dionex Liquid Line
Fittings (Document No. 031432) for details. The manual is on the Dionex
Reference Library CD-ROM (P/N 053891). If you have trouble isolating the
restriction, refer to Section 5.2.

Plugged or damaged fitting

Isolate the faulty fitting by loosening fittings one by one until the pressure
returns to normal. Repair or replace the fitting (see Section 5.3).

Flow rate through the columns too high

Set the correct rate for your application. If an incorrect flow rate calibration is
suspected, calibrate the flow (see Section 5.1.3).
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* Clogged column bed supports

Refer to the instructions in the column manual for troubleshooting guidance.
Column manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).

e (Contaminated columns
Clean the columns as instructed in the column manual.
* Plugged injection valve passages

Rebuild the injection valve (see Section 5.4).

4.8 Peak “Ghosting”

“Ghosting” is the appearance of extraneous peaks in a chromatogram. These may
be late-eluting peaks from a previous injection, or they may be the result of a
contaminated standard or eluent, or a malfunctioning injection valve. These peaks
may co-elute with peaks of interest, resulting in nonreproducible peak
heights/areas.

¢ Insufficient time between sample injections

Wait until the previous sample has been completely eluted before making
another injection.

¢ Insufficient flush between samples

Flush the sample loop with at least 10 loop volumes of deionized water or
sample between sample injections.

® Incorrect or contaminated standards
Remake standards.
® Incorrect or contaminated eluent

Remake the eluent according to the instructions in the column manual.
Column manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891).

Install or replace the end-line filter on the end of the deionized water line (see
Section 3.4.3).
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Malfunctioning injection valve
1. Rebuild the injection valve (see Section 5.4).

2. Ifthe valve leak persists, contact Dionex for assistance.

4.9 Nonreproducible Peak Height or Retention Time

Column overloading

Dilute the sample (see Section 3.9).

Liquid leaks

Locate and eliminate the leaks (see Section 4.2).

Incomplete or imprecise filling of the sample loop

1. Fill the sample loop until excess sample exits the waste line.
2. Inspect the 1-cc syringe (P/N 016388) and replace if damaged.
Pump not primed properly

Prime the pump (see Section B.12).

4.10 Abnormal Retention Time or Selectivity

Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.

Contaminated or degraded sample

Take appropriate precautions when preparing and storing samples to prevent
contamination and degradation (see Section 3.9).

Contaminated column

1. Clean the column as instructed in the column manual. Column manuals
are included on the Dionex Reference Library CD-ROM (P/N 053891),
located in the ICS-1000 Ship Kit (P/N 057905).

2. If cleaning is unsuccessful, replace the column.
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4.11 No Cell Response

Cell not properly installed

Verify that the cell front cover is flush against the component panel. If
necessary, tighten the two mounting screws. When the cell is correctly
installed and the screws tightened, an electronics connector on the cell plugs
into a receptacle inside the ICS-1000.

No flow from pump

This condition has several possible causes. See Section 4.4 and Section 4.5
for details.

Cell electronics malfunctioning

Use the Chromeleon Wellness Panel diagnostics to test the electronics (see
Section 5.1 and the Chromeleon online Help for instructions). If the variance
reading is outside the tolerance range (less than 1 uS), the electronics are
malfunctioning. Contact Dionex for assistance. The ICS-1000 electronics
cannot be serviced by the user.

4.12 High Cell Output

Background not suppressed by suppressor

Verify that the suppressor is turned on and the current is set to the correct
value. Refer to the suppressor manual for additional troubleshooting
guidance. Suppressor manuals are included on the Dionex Reference Library
CD-ROM (P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).

Sample concentration too high

Dilute the sample Section 3.9.3.

Wrong eluent

Check that you are using the correct eluent for your application.
Background conductivity not offset from conductivity reading

Before making an injection, allow the background conductivity to equilibrate,
and then press Autozero on the Chromeleon Control Panel.
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413

Cell out of calibration

Recalibrate the cell (see Section 5.1.2).

Baseline Noise or Drift

Flow system leak; erratic baseline

Check all fittings and liquid lines for leaks. Tighten or, if necessary, replace
all liquid line connections. Refer to Installation of Dionex Liquid Line Fittings
(Document No. 031432) for tightening requirements. The manual is on the
Dionex Reference Library CD-ROM (P/N 053891).

Trapped gases

Release any trapped gases in the cell by loosening the lines to and from the
cell and then retightening them. Also loosen and retighten the fittings to and
from the suppressor eluent ports.

Pump not properly primed
Prime the pump (see Section B.12).
Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.

Rapid changes in ambient temperature
Make sure the ambient temperature is between 4 and 40 °C (40 and 104 °F).

Make sure air conditioning and heating vents are directed away from the ICS-
1000 and the ICS-1000 front door is closed.

Insufficient system equilibration following changes to operating
parameters; especially apparent when operating at high sensitivities

Allow a longer system equilibration time (up to 2 hours) before starting
operation.

Incorrect suppressor operating conditions

Refer to the suppressor manual for troubleshooting information. Suppressor
manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).
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¢ Cell above or below temperature
Contact Dionex for assistance.
* Damaged piston seal

Replace the piston seal (see Section 5.6).

4.14 Vacuum Degas Assembly Does Not Run

® Degas option not enabled in Chromeleon

a. Open the Chromeleon Server Configuration program. Select the ICS-
1000 device icon under the timebase and select Properties from the Edit
menu (or double-click the ICS-1000 device icon).

Select the Options tab (see Figure 4-3).

Dionex ICS-1000 System E3

Eror Levels | Dremo Chromatogram I TTL Inputz I Trend I Calibration I Diagnostics
General ~ Options | Signalz I Head Type & Limits I Solventz I State Devices

— Inztalled Options
¥ Degas

v LCalunin Heater

— Degaz Mode
€ Alwaps Off
€ Alwaps On
' Cycle

On; I':I (0,720 zec)
: I':I [0..5340 zec)

QK. I Cancel | Lpply | Help |

Figure 4-3. ICS-1000 Server Configuration Properties: Options.
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c.

Under Installed Options, verify that the Degas check box is selected.

Under Degas Mode, verify that the Always Off option is not selected. If
it is, select one of the following settings:

® Cycle, and select On: 30 seconds and Off: 10 minutes
®* Monitor

If the Degas Mode settings are correct, but the degas assembly still does
not run, test the assembly by selecting the Always On option. The pump
should turn on immediately. If it does not, the vacuum degas assembly
may need to be replaced. Contact Dionex for assistance.

Select the Degas Mode, Always On option only when testing the vacuum
degas assembly. Do not select the Always On option for routine use.

If the degas pump runs when you select Always On, but does not run
when Monitor mode is selected, recalibrate the degas assembly (see
Section 5.1.4).
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5 ¢ Service

This chapter describes ICS-1000 service and repair procedures that the user can
perform. All procedures not included here, including electronics-related repair
procedures, must be performed by Dionex personnel. For assistance, contact
Dionex Technical Support. In the U.S., call 1-800-346-6390. Outside the U.S.,
call the nearest Dionex office.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to
isolate the cause of the problem.

IMPORTANT Substituting non-Dionex parts may impair ICS-1000 performance,
thereby voiding the product warranty. Refer to the warranty statement

in the Dionex Terms and Conditions for more information.

5.1 Diagnostic and Calibration Procedures
Diagnostic and calibration procedures are performed from the Chromeleon
Wellness Panel (see Figure 5-1).

For an overview of the Wellness Panel features, see Section 5.1.1. For instructions
on performing calibration and diagnostic procedures, see the following sections:

® (Calibrating the Conductivity Cell (Section 5.1.2)
® (Calibrating the Flow Rate (Section 5.1.3)
® (Calibrating the Vacuum Degas Assembly (Section 5.1.4)
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5.1.1

Chromeleon Wellness Panel Overview

NOTE Do not open a System Wellness Control Panel if the
name includes "Service.pan." These Wellness panels are
reserved for use by Dionex Service Representatives.

To Open the Wellness Panel

L.

Open the Chromeleon Browser and expand the Dionex Templates

folder.

Expand the Panels folder and then the Wellness folder.

In the right pane of the Browser window, double-click ICS-
1000_1500_2000_Wellness_user.pan.The Wellness Panel appears.

Open the Control menu and click the name of the ICS-1000 timebase
at the bottom of the menu. This connects the Wellness Panel to the
ICS-1000 and enables the controls on the panel.

% wellness Panel - ICS-1000 - AMAR

System Stat

=10 x|

X

Audit Trail

¥ Connected

‘ |Ca|ihratinn| ‘ Diagnostic |

Calibration Details:  Details... | ’V

Pump
On

| _on |

£114:31:40 Wait at least 15 minutes befare rechecking flow rate. Press the a
Log button to record the new Calibration values into the Audit Trail

Update Well Datak
Press for instructions:

Upload

Instructions

Loading

Pump Flow Rate Calibrati

Press for instructions:
Reset Flow Rate Cal:
Set Flow Rate to 1.00:
Current Pump Pressure:

5.00 minute timer:

Enter new Flow Rate Cal:

Store Calibration Value:
Log Calibration Value:
Current Calibration Date:

Last Calibration Date:

Instructions
Reset Cal
1.00 mL/min

800 psi
5.00 min
504 =

Calibrate

g

Log
3/19/2003

3M19/2003

Degas Calibration.
Press for instructions:

Instructions |

Calibrate |

Log |
3/19/2003
3/19/2003

Degas Calibration:
Log Calibration Value:
Degas Pressure:
Current Cal. Date:

Last Calibration Date:

Electric Conductivity Cell Calibration

Press for instructions: Instructions |
Conductivity Cell Offset Cal:  Offset Cal. |
Conductivity Cell Slope Cal:  Slope Cal. |

Current Calibration Date:

Last Calibration Date:

Conductivity Cell Calibration
Press for instructions:

Set Cell Temp to 35 C:
Set Flow Rate to 1.00:
Total Conductivity:
Cond. Cell Calibration:
Log Calibration VYalue:
Current Calibration Date:

Last Calibration Date:

Instructions
Cell35 C
1.00 mL/min

0.061 pS

Calibrate

L

3/19/2003

3/19,2003

04g

Dummy Cell Test

Press for instructions:
@Dummy Cell:

Log Dummy Cell Walue:

Instructions

R

n

|z

=

o

Figure 5-1. Chromeleon Wellness Panel
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Use the Wellness Panel to perform the following functions:

® (Calibrate the pump flow rate

® (Calibrate the vacuum degas assembly

e (alibrate the conductivity cell

® Test the conductivity cell electronics, using a dummy cell

® Upload calibration values from the ICS-1000 to the Chromeleon
Wellness database
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5.1.2 Calibrating the Conductivity Cell

When to Calibrate
® After every 6 months of use

NOTE Do not use this procedure to calibrate a new cell. If you
are replacing a cell, see the instructions in Section 5.9 to
install the new cell and calibrate it.

Items Needed Description

1.0 mM KCI solution Prepare by dissolving 0.07456 g of reagent-
grade KCl in 1 liter of 18-megohm DI
water.

Backpressure tubing to provide ~ Use 0.076-mm (0.003-in) ID yellow PEEK
at least 7 MPa (1000 psi) tubing (P/N 049715).

1. Open the ICS-1000 Wellness Panel in Chromeleon (see
Section 5.1.1).

2. On the Wellness Panel under Electric Conductivity Cell
Calibration, click Offset Cal.

3. When the offset calibration is complete, click Slope Cal on the
Wellness Panel.

4. Disconnect the pump output line from the injection valve.

5. Disconnect the line from the suppressor ELUENT OUT port to the cell
inlet and connect the pump output line directly to the cell inlet.

6. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure.

7. On the Wellness Panel under Conductivity Cell Calibration, click
Cell 35 C. Allow the cell to reach this temperature and then wait an
additional 5 minutes to let it stabilize.

8. Select 1.00 mL/min to begin pumping 1.0 mM KCI through the cell at
1.0 mL/min.

9.  Wait until the total conductivity reading stabilizes (in about
15 minutes) and then select Calibrate on the Wellness Panel.
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10.
I1.

12.

After calibration, the conductivity reading should be 147.00 + 2 uS
and the cell constant should be between 120 and 180. If this is not the
case, contact Dionex for help.

Click Log to record the new calibration values in the Audit Trail.

Flush the KCI solution from the system by pumping deionized water
through the cell. When the conductivity drops to less than 1 pS/cm,
stop the pump.

Reconnect the pump to the injection valve and reconnect the line
from the suppressor to the cell inlet.
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5.1.3 Calibrating the Flow Rate

When to Calibrate

If you run the ICS-1000 Operational Qualification or Performance
Qualification and it fails.

Items Needed

0.076 mm (0.003 in) ID yellow PEEK tubing (P/N 049715) to create
14 £2 MPa (2000 + 300 psi) of backpressure (if needed)

Deionized water

Balance capable of weighing more than 10 grams with 0.001 grams
readability

® Tared beaker
To Calibrate
1. Open the ICS-1000 Wellness Panel in Chromeleon (see
Section 5.1.1).
2. Verify that there is 14 + 1.4 MPa (2000 + 200 psi) of backpressure.
3. On the Chromeleon Wellness Panel under Pump Flow Rate
Calibration, sclect Reset Cal.
4. Select 1 mL/min to set the flow rate and begin pumping deionized
water.
5. Allow the pump to stabilize for 20 minutes.
6. Click 5.00 min to start the timer. Immediately start collecting water
into the tared beaker.
7. Collect the water for exactly 5.00 minutes.
8. Enter the weight of the water (in grams).
9. Click cCalibrate to download the value to the ICS-1000.
10. To recheck the value, wait at least 15 minutes, and then repeat the
calibration.
11. Click Log to record the new calibration value in the Audit Trail.
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5.1.4 Calibrating the Vacuum Degas Assembly

When to Calibrate

® After every 6 months of use

1. Open the ICS-1000 Wellness Panel in Chromeleon (see
Section 5.1.1).

2. On the Wellness Panel under Degas Calibration, select Calibrate.
The degas pump runs for 90 seconds to allow a vacuum to be created.
After 90 seconds, the vacuum degas pressure reading is recorded.
When the vacuum degas assembly is running in monitor mode, this
calibration value is used to determine when to turn on the degas
pump.

3. Click Log to record the new calibration value in the Audit Trail.

5.2 Isolating a Restriction in the Liquid Lines

A restriction in the liquid plumbing will cause excessive system backpressure.
1. Begin pumping eluent through the system (including the columns).

2. Follow the ICS-1000 flow schematic in Figure 5-2 and work backward
through the system, beginning at the suppressor Regen Out exit. One at a time,
loosen each fitting and observe the pressure. The connection at which the
pressure drops abnormally indicates the point of restriction.

NOTE The numbers on the flow schematic indicate the order in
which liquid flows through the system components.

If the restriction has caused such high pressure that the system cannot be
operated, you must work forward through the flow schematic, adding parts
one at a time until an abnormal pressure increase (and hence, the restriction) is
found.

3. If the restriction is in the tubing or fitting, remove the restriction by back
flushing or by replacing the tubing or fitting (see Section 5.3).
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o

ELUENT <« ] ouT

®

SUPPRESSOR

SEPARATOR COLUMN
COLUMN HEATER (optional)

N/g\OUT
ELUENT

VALW —

Figure 5-2. ICS-1000 Flow Schematic

NOTE The numbers on the flow schematic indicate the
order in which liquid flows through the system
components.

5-8
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5.3 Replacing Tubing and Fittings

The ICS-1000 is plumbed with the tubing and tubing assemblies listed below.

Tubing Size and Type

Color

0.125-mm (0.005-in) ID PEEK ~ Red

(P/N 044221)

0.25-mm (0.010-in) ID PEEK Black
(P/N 042690)

0.50-mm (0.020-in) ID PEEK Orange
(P/N 042855)

0.75-mm (0.030-in) ID PEEK Green
(P/N 044777)

1.58-mm (0.062-in) ID Teflon®  Clear
(P/N 014157)

25 uL sample loop Orange

(P/N 042857)

Used For

Connection from pump pulse damper
to pressure transducer

Connections between other system
components

Connection from injection port to
injection valve

Connection from injection valve to
waste

Connection from pump to degas or
eluent reservoir; pump waste

Connection between ports L (1) and
L (4) on the injection valve

10-32 fittings (P/N 043275) and ferrules (P/N 043276) are used for most
tubing connections. For tightening requirements, refer to Installation of
Dionex Liquid Line Fittings (Document No. 031432). The manual is on the
Dionex Reference Library CD-ROM (P/N 053891).

1/8-in fittings (P/N 052267) and ferrules (P/N 048949) are used for
connections to the suppressor REGEN OUT port and the eluent reservoir.
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5.4 Rebuilding the Injection Valve

Dionex recommends rebuilding the injection valve annually. The Injection Valve
Rebuild Kit (P/N 057896) contains all required replacement parts.

NOTE Substitution of non-Dionex parts may impair valve
performance and void the product warranty.

1. Turn off the pump from the ICS-1000 Control Panel in Chromeleon.

2. Open the ICS-1000 front door.

3. Disconnect each liquid line connected to the injection valve.

4. Follow the instructions provided in the Rebuild Kit to replace the rotor seal,
1solation seal, and stator face.

5. Reconnect all liquid lines to the injection valve (see Figure 5-3).

6. Close the door.

7. Turn on the pump.

SAMPLE IN
(from door \

inject port or
autosampler) ( )

25-L
SAMPLE LOOP TO INJ
(Orange) VALVE -c (Black)
TO INJECT| (Green
TO INJ VALVE -p | ¢ .
VALVE -W
I (Green)

Figure 5-3. Injection Valve Plumbing
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5.5 Cleaning and Replacing the Pump Check Valves

A dirty check valve causes erratic flow rates and pressures. In addition, it
may cause the pump to lose prime and/or be difficult to reprime. If possible,
replace dirty check valves. If new check valves are not available, follow the
instructions for cleaning.

Replacing Check Valves

1. Close the eluent valve from the ICS-1000 Control Panel in Chromeleon.
2. Turn off the main power switch, to ensure that you do not unintentionally start
the ICS-1000.
3. To prevent contamination of pump parts, put on a pair of rubber gloves before
disassembling the pump head.
4. Disconnect the tube fittings from the inlet and outlet check valve assemblies
on the primary pump head (see Figure 5-4).
5. Use a 1/2-inch wrench to loosen both check valve assemblies. Remove the
check valve assemblies from the pump head.
Outlet Check
Valve
Primary
Pump Head
Secondary
Pump Head

Acorn Nuts

Inlet Check
Valve

Figure 5-4. Pump Heads

NOTE The inlet check valve assembly housing has a 1/4-28 port.
The outlet check valve assembly housing has a 10-32 port.
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CAUTION

8.
9.

10.

I1.

If you are installing new cartridges
(P/N 045994) in the existing check valve Double-hole Single-hole
housings, place the cartridge in the inlet
check valve housing with the double-hole
end of the cartridge visible and place the
cartridge in the outlet housing with the
single-hole end visible.

NOTE The pump will not operate
properly unless the cartridge is
installed in the housing in the
correct orientation. Liquid flows
through the check valve in the
large single hole and out the
small double holes.

Install the inlet check valve assembly (P/N 045722) on the bottom of the
primary pump head. Install the outlet check valve assembly (P/N 045721) on
the top of the head. Tighten the check valves fingertight, and then use a
wrench to tighten an additional one-quarter to one-half turn.

Overtightening may damage the pump head and check valve housing
and crush the check valve seats.

Reconnect the liquid lines. Turn on the ICS-1000 main power.
Open the eluent valve from the ICS-1000 Control Panel in Chromeleon.
Prime the pump (see Section B.12).

When the ICS-1000 is at operating pressure, check for leaks from the check
valves. Tighten a check valve a little more only if it leaks.

Cleaning Check Valves

1.
2.

Carefully remove the check valve cartridges from the valve housings.

Place the check valve housings and cartridges in a beaker with methanol.
Sonicate or agitate the parts for several minutes.

Rinse each check valve housing and cartridge thoroughly with filtered
deionized water.

See Step 6 through Step 11 above to reinstall the check valves and complete
the procedure.
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56 Re

placing a Pump Piston Seal and Piston Rinse Seal

A damaged seal allows leakage past the piston, as well as leakage from the
piston seal wash housing. The pump may be difficult to prime, flow rates may
be unstable, and there may be baseline noise.

Preparation

1.

Rinse the pump flow path with deionized water. Direct the flow to waste by
opening the waste valve on the secondary pump head (see Figure 5-7). To
open the valve, turn the knob one-quarter to one-half turn counterclockwise.

After rinsing, close the waste valve.
Close the eluent valve from the ICS-1000 Control Panel in Chromeleon.

To prevent contamination of pump parts, put on a pair of rubber gloves before
disassembling the pump head.

Removing the Head and Piston

L.

CAUTION

MISE EN GARDE

Turn off the main power switch, to ensure that you do not unintentionally start
the ICS-1000.

Disconnect all tubing connections to the pump head.

Locate the open end wrench (P/N 014605) provided in the ICS-1000 Ship Kit
(P/N 057905). Use the wrench to remove the two acorn nuts (see Figure 5-4)
from the pump head.

Slowly pull the head and allow it to separate from the housing. Carefully
disengage the head from the piston by pulling the head straight off and away
from its mounting studs.

Lateral motion while disengaging the pump head from the piston may
break the piston.

Un mouvement latéral pendant la séparation de la téte et du piston
peut casser le piston.

Vermeiden Sie Seitwartsbewegungen, wenn Sie den Kopf vom Kolben
I6sen. Andernfalls kann der Kolben brechen.

VORSICHT
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5. Place the head (front end down) on a clean work surface and lift off the spacer

to expose the piston seal (see Figure 5-5 or Figure 5-6).

Valve Assembly
(P/N 045721)

Priming Valve Knob &>
y (P/N 055709) [ N
Outlet Check %‘ @¢

@ O-Ring

(PIN 055752)

Piston Seal
(P/N 055870)

Spacer with Drain
(P/N 057913) Primary Pump Head

(PIN 055711)

(PIN 048722) S | \ O-Ring
Q) (PIN 014895)
" O-Ring \% Inlet Check

\ (P/N 059283 i\-/‘ Valve Assembly

Seal Guide (P/N 045722)

Piston (P/N 058032)
(P/N 052840)

Piston Rinse Seal

Figure 5-5. Primary Pump Head

Waste Valve Knob

(PIN 055710) /,./\(/',
Y

O-Ring
(P/N 055752)

Piston Seal
(P/N 055870)

Secondary
Pump Head
(P/N 055712)

Spacer with Drain
(P/N 057913)

Piston Rinse Seal \
(P/N 048722) O-Ring

(P/N 014895)

(P/N 058032)

(PIN 052840)

Figure 5-6. Secondary Pump Head

5-14
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6. The piston does not come off as part of the pump head assembly because it is
captured by a magnetic retention system. After removing the pump head, hold
the shaft of the piston (near the base), tilt the piston slightly, and pull the
piston away from the pump.

Installing the New Piston Rinse Seal

1. Remove the guide from the spacer to expose the piston rinse seal and O-ring.
Remove the O-ring.

2. Remove the old piston rinse seal from the guide as follows:
a. Hold the guide with the flat side facing up.

b. To dislodge the piston rinse seal, gently insert the shaft of the piston
through the small hole in the center of the guide (see photo below).

c. Pull the seal off the end of the piston shaft and remove the piston from the
guide.

3. Hold the new piston rinse seal (P/N 048722) with the grooved side facing up.

4. Using your fingertip, gently press the piston rinse seal into the guide until the
edge of the seal is below the surface of the guide.

The piston rinse seal is made of soft plastic. Do not press on the seal

with anything hard or sharp, including your fingernail. If the seal is
nicked or gouged, it will not seal properly and may result in leaks.

5. Place the new O-ring (P/N 059283) into the groove in the guide.

6. Remove the O-ring from the groove in the flat side of the spacer and replace it
with the new O-ring (P/N 014895).
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8.

In one hand, hold the guide with the O-ring and piston rinse seal facing up
(this prevents the O-ring from falling out). In the other hand, hold the spacer
with the cavity facing down.

Gently press the guide into the cavity in the spacer until it is fully seated.

Removing the Piston Seal from the Head

L.

6.

Fill the head cavity with deionized water by injecting the liquid through either
the piston opening or the inlet check valve.

Reinsert the piston approximately 1/8 inch into the seal.

If this is the primary pump head, install a 10-32 fitting plug (P/N 042772) on
the outlet check valve. Tighten the plug.

If this is the secondary pump head, install a 10-32 fitting plug (P/N 042772)
in both the inlet and outlet ports. Tighten the plugs.

Push the piston into the head. (This should hydraulically unseat the seal from
the head.) Remove the piston and pull off the seal.

NOTE If the piston seal is not removed, make sure the 10-32
fitting plug(s) are tight and add more water. Make sure
the head contains no air bubbles, and then repeat Steps
2 and 5.

Remove the 10-32 fitting plug(s).

Installing the New Piston Seal

1.

Open the priming valve knob (primary pump head) or waste valve knob
(secondary pump head) by turning the knob one-quarter to one-half turn
counterclockwise.

Push the piston through the spacer and then through the new seal. Insert the
piston and seal into the pump head until the seal makes contact with the
bottom of the counterbore.

NOTE If necessary, lubricate the seal with a small amount of
isopropyl alcohol to facilitate insertion.

To seat the seal, push down on the spacer until it is flush with the head. A
clicking sound indicates that the seal is correctly seated.

Close the priming valve knob or waste valve knob.
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Reinstalling the Head and Piston

Dionex recommends reinstalling the head and piston as a single assembly, so that
the piston centers itself onto the magnetic follower.

L.

Hold the assembled spacer and guide with the drain tubes aligned vertically
and press the spacer into the head until it is flush with the indented surface of
the head.

Insert the piston so that 1/4 inch of the shaft is exposed. This ensures that the
magnet in the follower picks up the piston. (The follower is the cylinder that
holds the piston in place as it moves in and out of the pump head assembly.)

Reinstall the head and piston assembly; use a wrench to tighten the nuts
evenly (12 in-1b torque).

Completing the Procedure

1.
2.
3.
4.

Reconnect all liquid lines to the pump head.
Turn on the main power switch.
Open the eluent valve.

Prime the pump (see Section B.12).

5.7 Replacing a Pump Piston

Continued leaking of the piston seal after installation of a new seal (assuming
the pump head is tight) indicates a dirty, scratched, or broken piston.

Follow the instructions in Section 5.6 to install a new piston (P/N 052840) and
piston seal (P/N 055870).
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5.8

Replacing the Waste Valve or Priming Valve O-Ring

A damaged O-ring causes leakage around the base of the waste valve or
priming valve knob.

1.
2.

Close the eluent valve from the Control Panel in Chromeleon.

Turn off the main power switch, to ensure that you do not unintentionally start
the ICS-1000.

To remove the waste valve or priming valve from the pump head (see
Figure 5-7), turn the knob counterclockwise until it is loose, and then pull the
knob straight out of the cavity in the pump head.

Waste Valve

—— Priming Valve

Figure 5-7. Waste and Priming Valves

If the O-ring is removed with the valve knob in Step 2, pull the O-ring off the
end of the knob (see Figure 5-8). If the O-ring is not removed with the valve
knob, insert a thin object (for example, the bent end of a paper clip) into the
cavity in the pump head and carefully pull out the O-ring. Do not scratch the
cavity.

IMPORTANT Scr_atches in th(? cav_lty W|I_I cause leaks around the base of the knob
while the pump is being primed.
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@ /,/’/ Valve Knob

O-Ring
(P/N 055752)

Figure 5-8. Waste Valve or Priming Valve O-Ring Replacement

5. Slide a new O-ring (P/N 055752) over the end of the valve.
6. To reinstall the valve containing the new O-ring, turn the knob clockwise and

then tighten fingertight.

NOTE It is normal to encounter resistance after several
rotations of the knob; the O-ring is being pushed
into the cavity of the pump head.

7. Turn on the main power switch.

8. Open the eluent valve.

9. Prime the pump (see Section B.14).
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5.9 Replacing the Conductivity Cell

1. Turn off the ICS-1000 power.

2. Open the front door and disconnect the tubing from the CELL IN and CELL
OUT fittings (see Figure 5-9, View A). Loosen the two screws on the cell front
cover. The screws remain attached (see Figure 5-9, View B).

[f{..!m“"scfew | [THONEY

DS6 HEATED CONDUCTIVITY CELL & 056 HEATED CONBUCTIVITY CELL

semiALno. [0205062 ] § sficho. [02000682 ]
CELL CONSTANT CELL CONSTANT [ 143.68

CELL IN

CELL OUT §

DIONEX P/N3

Unscrew

Figure 5-9. Removing the Cell Front Cover

3. Grip the two loosened screws
and pull the cell cover toward
you to remove it from the
component panel. Do not pull
from the CELL IN and CELL
OUT fittings.

4. Continue pulling on the cover
until the attached cell assembly
slides out the front of the ICS-

1000 (see Figure 5-10).

e D

Figure 5-10. Removing the Cell Assembly
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5. Slide the new cell assembly into the opening in the component panel until it
stops and the cell cover is flush against the component panel. The cell’s
electronic connector automatically plugs into a connector inside the ICS-1000
when you push the assembly into the opening.

Y ©® =

Tighten the screws on the cell front cover fingertight.
Reconnect the inlet and outlet lines.
Turn on the ICS-1000 power.

Calibrate the new cell in Chromeleon. Cell calibration of a new cell consists

of three parts:

s 0 o e

Run the offset calibration, which measures the output of the cell
electronics alone and determines an offset value to be applied to raw
conductivity readings.

Run the slope calibration, which measures the output of the cell
electronics when a built-in dummy cell, which provides a constant
conductivity reading of 21 uS, is automatically enabled. The slope value
is applied to raw conductivity readings.

Enter the cell constant measured at the factory. The ICS-1000 uses the cell
constant to determine the measured conductivity.

Open the Wellness Panel (see Section 5.1.1)
Under Electric Conductivity Cell Calibration, click Offset Cal.
When the offset calibration is complete, click Slope Cal.

Click Calibration Details. Under Conductivity Cell Cal Details, enter
the Cell Constant value printed on the front of the cell.

In the field next to the Download button, verify that Current is selected
and then click Download to download the new value to the ICS-1000.

To ensure the new values are recorded in the ICS-1000 memory, do not
turn off the ICS-1000 power for at least 1 minute after downloading.

Doc. 031879-01 3/03
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5.10 Replacing the Suppressor

Refer to the suppressor manual for guidance about when to replace a suppressor.
Suppressor manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).

L.

A

10.

Refer to the suppressor quick start guide (shipped with the suppressor) for
instructions on preparing the suppressor before initial use and for additional
installation details.

Turn off the pump from the ICS-1000 Control Panel in Chromeleon.
Open the front door of the ICS-1000.
Disconnect the two eluent and the two regenerant lines from the suppressor.

To remove the suppressor from the component mounting panel, slide it up to
detach it from the mounting tabs on the panel and then pull it toward you.

Continue pulling the
suppressor out until the
yellow connector on the
cable inside the ICS-1000 is
outside the panel (see

Figure 5-11).
Disconnect the suppressor
cable (twist the ring on the

yellow connector and pull
the two connectors apart).

Yellow
Connector

Figure 5-11. Removing the Suppressor
Connect the cable from the new suppressor to the ICS-1000 cable (align the
pins on the two connectors and push them together).

Orient the suppressor with the REGEN OUT fitting on top and the cables to the
right.

Push the cables into the opening in the component panel.

5-22
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I1.

12.

13.

14.

Align the top of the suppressor
with the guide line printed on the
component panel (see

Figure 5-12) and align the slots
on the rear of the suppressor
with the tabs on the panel.

Press the suppressor onto the
tabs and then slide it down until
it locks into place. Pull slightly
on the center of the suppressor to
verify that it is securely fastened.
Note: Some suppressors require
more force to secure them onto
the tabs.

Connect the two eluent and two
regenerant lines to the new
Suppressor.

Close the ICS-1000 front door.

1 Suppressor
Mounting Tabs

2 Suppressor Cable
Connector

3 Guideline for AES

4 Guideline for SRS

Figure 5-12. Suppressor Guidelines and Mounting

Tabs on Component Panel

5.11 Replacing the Column Heater

Turn off the ICS-1000 power.

Open the front door of the ICS-1000.

Follow the steps below to remove the existing column heater:

a. Unscrew the two thumbscrews on the heater cover (they remain attached

to the cover).

b. Pull the heater cover straight out to remove it.

Doc. 031879-01 3/03
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¢. Unscrew the six
thumbscrews on the top
metal plate (see

Figure 5-13) and

remove the plate. Thumbscrews (6)

Figure 5-13. ICS-1000 Column Heater Cover Removed

d. Remove the columns from the column heater.

e. Pull the column heater straight toward you to remove it from the
component panel.

Before installing the new column heater, write down the two calibration
values (offset and slope) recorded on the back of the heater.

Align the connector on the back of the new column heater (P/N 058060) with
the connector on the component panel (see Figure 2-4) and push the column
heater onto the component panel.

Remove the heater cover and the metal plate on the new heater.

Install the columns in the new heater and replace the top metal plate and
heater cover.

Turn on the ICS-1000 power.

5-24
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9. Enter the column heater calibration values in Chromeleon as follows:

a. Open the Wellness Panel (see Section 5.1.1) and click Calibration

Details.

b. Under Column Heater Calibration Values, enter the Column Heater
Offset and Column Heater Slope values recorded in Step 4.

c. In the field next to the Download button, verify that Current is selected
and then click Download to download the new calibration values to the

ICS-1000.

d. To ensure the new calibration values are recorded in the ICS-1000
memory, do not turn off the ICS-1000 power for at least 1 minute after

downloading the values.

5.12 Replacing the Column Heater Heat Exchanger

1.

Turn off the ICS-1000
power.

Open the front door of the
ICS-1000.

Unscrew the two
thumbscrews on the column
heater cover (they remain
attached to the cover).

Pull the heater cover straight
out to remove it.

Unscrew the six
thumbscrews on the top
metal plate (see Figure 5-14)
and remove the plate.

Disconnect the heat
exchanger inlet line from
Port C on the injection
valve.

Heat
Exchanger —
Screws (3) &

Figure 5-14. ICS-1000 Column Heater Cover Removed

Disconnect the heat exchanger outlet line from the guard column inlet.
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10.

I1.

Use an Allen wrench to remove the three screws from the heat exchanger
metal plate and remove the plate (with the tubing) from the heater.

Remove the plastic backing from the new heat exchanger (P/N 059979, with
0.25-mm (0.010-in) ID tubing; P/N 060943, with 0.125-mm (0.005-in) ID
tubing) and press the heat exchanger onto the heater. Replace the screws
removed in Step 8.

Connect the new heat exchanger inlet line to Port C on the injection valve and
connect the outlet line to the guard column inlet.

Reinstall the top metal plate and the heater cover.

5.13 Replacing the Eluent Valve

1.
2.
3.

Turn off the power to the ICS-1000.
Open the ICS-1000 front door.

To prevent an eluent leak during the procedure, disconnect the eluent line
from the reservoir cap. Or, plug the line on the left side of the valve with a
union (P/N 039056 and a plug (P/N 037268) after disconnecting the liquid
line from the valve (see Step 4).

Disconnect the two liquid
lines connected to the
eluent valve (see

Figure 5-15).

Unscrew and remove the
two screws that attach the
valve to the component
panel (see Figure 5-15).
Save the screws.

Remove

Figure 5-15. Eluent Valve
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10.

I1.

12.

13.
14.

Pull the valve straight out
from the component panel and
begin pulling the attached
cable out of the opening in the
panel.

The cable connects to a cable
inside the ICS-1000. Continue
pulling until the connectors for
the two cables are outside the T —
panel (see Figure 5-16). ~ Disconnect
Disconnect the cables. SEBIERS

Remove the mounting plate on
the old valve by unscrewing
and removing the two screws.
Save the screws.

Thread the cable from the new
eluent valve through the
mounting plate.

Attach the mounting plate to
the new valve using the
screws removed in Step 8.

Figure 5-17. Removing the Valve Mounting Plate
Connect the cable from the new valve to the ICS-1000 cable. Feed the cables
back inside the ICS-1000.

Align the new valve on the component panel with the liquid ports facing up
and attach it with the two screws removed in Step 5. Reconnect the liquid
lines.

Turn on the power to the ICS-1000.
Prime the pump (see Section B.14).
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5.14 Replacing the Leak Sensor

1.

Turn off the power to the ICS-
1000.

Open the ICS-1000 front door.

Loosen the screw on the front of
the leak sensor (see

Figure 5-18). Note: The screw
remains attached to the sensor.

Loosen

Leak
Sensor

Figure 5-18. Leak Sensor

Remove the leak sensor from
the component panel and pull
the cable out of the opening in
the panel.

The cable attached to the leak
sensor connects to a cable inside
the ICS-1000. Continue pulling
the cable until the connectors for
the two cables are outside of the
panel (see Figure 5-19).

Disconnect the two cables.

Figure 5-19. Leak Sensor Cable

Connect the cable from the new leak sensor to the ICS-1000 cable.

Feed the cables back inside the ICS-1000. Align the leak sensor with the
component panel opening and fingertighten the screw.

Make sure the leak sensor does not touch the bottom of the drip tray.
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5.15 Priming with Isopropyl Alcohol

NOTE Prime the pump heads with isopropyl alcohol only if the
two standard priming procedures described in
Section B.12 are unsuccessful.

1. Connect a 10-mL syringe (P/N 054578) filled with isopropyl alcohol (IPA) to
the port in the primary pump head (see Figure B-37).

2. Open the waste valve on the secondary pump head (see Figure B-37) by
turning the knob one-quarter to one-half turn counterclockwise.

3. Click Pump On on the Chromeleon Control Panel to turn on the pump motor.

4. Open the priming valve on the primary pump head by turning it one-quarter to
one-half turn counterclockwise.

5. Use the syringe to slowly push alcohol through the pump.

NOTE Be careful not to push any air trapped in the syringe
through the pump. Check the waste line from the
secondary pump head to verify that there are no air
bubbles.

6. Close the priming valve. Do not overtighten. Disconnect the syringe from
the priming valve.

7. Let the pump run for several minutes, to purge alcohol from the pump heads,
and then click Prime and flush the heads with the desired eluent.

Isopropyl alcohol may damage some columns. Be sure to thoroughly
rinse the alcohol from the pump, using the process described in
Step 7.

CAUTION
8. Close the waste valve. Do not overtighten.
9. Select the flow rate required for the analysis.

10. Click Pump Off to turn off the pump motor. The pump is now ready for
operation.
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5.16 Changing Main Power Fuses

1. Turn off the main power switch.

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the ICS-1000.

DANGER
HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arriére du ICS-1000.

DANGER
HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Riickseite des ICS-1000.

ACHTUNG

2. The fuse holder is part of the main power receptacle (see Figure 5-20) on the
ICS-1000 rear panel. To remove the fuse holder, squeeze the tab on the top of
the holder to release it and pull the holder straight out of its compartment.

3. Replace the two fuses in the holder with new IEC 127 fast-blow fuses rated
3.15 amps (P/N 954745). Dionex recommends always replacing both fuses.

4. Reinsert the fuse holder into its compartment and push in until the tab clicks
in place.

5. Reconnect the main power cord and turn on the power.

Main Power
Receptacle

Tab Fuses (2)

-

Fuse Holder

S

Fuse Holder (Side View)

Figure 5-20. Main Power Fuse Holder
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A.1 Electrical

Main Power

Fuses

A.2 Physical

Dimensions
(without
reservoir)

Weight

Decibel Level

85 t0 265 Vac, 47 to 63 Hz. The ICS-1000 power supply is auto-
sensing and requires no voltage adjustment

Two 3.15 amp fast-blow IEC 127 fuses (P/N 954745)

Height: 56.1 cm (22.1 in)
Width: 22.4 cm (8.8 in)
Depth: 53.3 cm (21.0 in)
30 kg (66 Ib)

<52 db (at “A WEIGHTING” setting)

A.3 Environmental

Operating
Temperature

Humidity

Operating
Pressure

4 °C to 40 °C (40 °F to 104 °F)

5 to 95% relative humidity, noncondensing

35 MPa (5000 psi) maximum liquid path (tubing, valve, columns,
etc.)
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A.4 Front Panel

Power LED

Inject Valve
LEDs

Alarm LED

Status LEDs

A.5 Pump

Type

Flow Rate

Flow Accuracy
Flow Precision

Operating
Pressure

High Pressure
Limit

Low Pressure
Limit

Delay Volume

Pressure Ripple

On when power is present; off when no power is present

Indicate the position of the inject valve.

Indicates an alarm state.

Indicate instrument status.

Dual-piston (in series), variable speed, 100 pL per revolution

Settable range: 0.00 to 5.00 mL/min, in 0.01 increments
Optimal Operational Range: 0.4 to 2.0 mL/min

<1% of set value within the optimal operational range
<0.2%

35 MPa (5000 psi), maximum

0.7 to 34.4 MPa (100 to 5000 psi)

0.0 to 33.7 MPa (0 to 4900 psi)

<800 pL

<1% at 13.8 MPa (2000 psi) and 1.0 mL/min

Doc. 031879-01 3/03



A * Specifications

A.6 Detector

Range
Temperature
Compensation
Cell Drive

Linearity

0 to 3200 uS (digital output)
0 to 3000 uS (analog output)

1.7% per °C

8 kH square wave

Correlation >0.999
%RSD <5% to 800 uS

A.7 Conductivity Cell with Heat Exchanger

Cell Body
Electrodes
Active Volume

Operating
Temperature

Maximum
Pressure

A.8

Injection Valve

PEEK
Passivated 316 stainless steel
1.0 uL

30 to 55 °C (86 to 130 °F); must be at least 7 °C above the ambient
temperature

2 MPa (300 psi)

Injection Valve

Two-position, six-port, electrically-activated valve with PEEK
wetted components

A.9 Vacuum Degas Assembly (Optional)

Channel
Pump

Materials

Single-channel degas channel with degas membranes
Dual-stage diaphragm vacuum pump

Wetted materials, PEEK, PTFE
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A.10 Column Heater (Optional)

Operating 30 to 60 °C (86 to 140 °F); must be at least 5 °C above the ambient
Temperature temperature
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B ¢ Installation

This chapter provides instructions for the initial installation of the ICS-1000 Ion
Chromatography System.

NOTE These installation instructions are also shipped with the
ICS-1000 as a stand-alone printed manual (Document
No. 031915).

NOTE The order of the steps is important. It is especially
important to install Chromeleon® before connecting the
USB cable and turning on the ICS-1000 power.

B.1 Facility Requirements

Make sure the ICS-1000 installation site meets the power and environmental
specifications listed in Appendix A.

Provide a sturdy workbench for the ICS-1000 of a height that ensures
convenient access to the interior.

Allow at least 15 ¢cm (6 in) behind the ICS-1000 for power connections and
ventilation. For optimal performance, install the ICS-1000 in a draft-free
location, out of the path of air conditioning and heating vents.

(Optional) Provide a clean gas source regulated to between 0.55 and
0.83 MPa (80 and 120 psi) for pressurization of the eluent reservoir.

Use ASTM filtered, Type I (18-megohm) deionized water when preparing
eluent and regenerant.
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B.2 Unpacking the ICS-1000 System

1. After removing the ICS-1000 from the shipping box and removing the top
layer of foam, remove the next layer of foam (see Figure B-1).

A P e
Remove this foam

Figure B-1. ICS-1000 After Removing Shipping Box and First Layer of Foam

2. Set the eluent bottle on top of the ICS-1000 (see Figure B-2).

"- ~ Eluent
~  Bottle
) )

Figure B-2. ICS-1000 with Eluent Bottle
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3. Remove the next layer of foam and remove the Ship Kit box (see Figure B-3).

Figure B-3. ICS-1000 with Ship Kit

4. The bottom foam layer has two cutouts on either side of the ICS-1000
module; use these as hand holds when lifting the module (see Figure B-3).

5. Lift the ICS-1000 out of the bottom layer of foam and set it on a workbench.
Inspect the ICS-1000 for any shipping damage.

Two or more persons should lift the 1CS-1000, which weighs 30 kg
(66 Ib). Lift the ICS-1000 only from each side of the cabinet bottom.
Lifting from the front door will damage the door hinges.
CAUTION
Au moins deux personnes peuvent soulever le ICS-1000: il pése 30 kg
(66 Ib). Ne soulevez le ICS-1000 que par chaque cé6té du fond de
I'armoire. Son soulévement par la porte du panneau avant
MISE EN GARDE endommagera les charniéres de la porte.

Der ICS-1000 wiegt iiber 20 kg. Daher sollte das Gerat nur von zwei
oder mehr Personen angehoben werden. Greifen Sie dazu an beiden
Seiten unter das Gerdt. Heben Sie den Autosampler nicht an der

VORSICHT Vordertiir an, da dadurch die Tiirangeln beschadigt werden kénnten.

Doc. 031879-01 3/03 B-3



ICS-1000 lon Chromatography System

B.2.1

B.2.2

Unpacking the Computer (North America only)

4.

NOTE These instructions assume that Chromeleon®
software and the software license were installed on
the computer before shipping.

Remove the central processing unit (CPU), keyboard, mouse, and all
documentation from the computer box and place these items on a
workbench.

Remove the monitor from its box and place it on the workbench.

Follow the instructions in the computer installation guide to hook up
the monitor, mouse, keyboard, and CPU.

Go on to Section B.4, “Installing the Chromeleon Software License.”.

Unpacking the Computer (outside North America)

L.

Refer to Installing the Chromeleon IC System (Document No.
031883) to verify that the computer being used meets Chromeleon
specifications. The manual is on the Dionex Reference Library CD-
ROM (P/N 053891).

Remove the central processing unit (CPU), keyboard, mouse, and all
documentation from the computer box and place these items on a
workbench.

Remove the monitor from its box and place it on the workbench.

Follow the instructions in the computer installation guide to hook up
the monitor, mouse, keyboard, and CPU.

If Chromeleon is not installed on the computer, go on to Section B.3,
“Installing Chromeleon.”

If Chromeleon is already installed on the computer, go on to
Section B.4, “Installing the Chromeleon Software License.”
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B.3 Installing Chromeleon

NOTES

10.

Windows® 2000 or Windows XP is required for controlling the ICS-1000
with Chromeleon. Chromeleon version 6.5 SP2 or later is required.

To install Chromeleon, you must log onto Windows 2000 or XP with
administrator privileges. Administrator privileges are not required to
run Chromeleon.

Turn on the computer power.
Follow the Windows setup steps as they appear on the screen.

Verify that the monitor display is set to a minimum of 1024 x 768 with 16 bit
color.

Insert the Chromeleon CD-ROM into the CD-ROM drive.
The Chromeleon Setup menu appears.

If the Setup menu does not appear automatically, go to the Autorun folder on
the Chromeleon CD-ROM and double-click autorun.exe.

Select Launch Chromeleon Setup.

Setup now guides you through the installation procedure; follow the on-
screen instructions as they appear.

When prompted, select whether to add the Chromeleon Server Monitor to the
Startup group. If you select yes, the Server Monitor starts automatically when
the computer is started, and the program icon appears in the taskbar.

When complete, go on to Section B.4, “Installing the Chromeleon Software
License.”
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IMPORTANT

Installing DX-LAN Devices

If you will also be installing a module that requires a DX-LAN interface
connection, verify that the following steps are completed before continuing:

1. Ifitis not already installed, install the DX-LAN card in the module. Refer
to the operator’s manual for the module for installation instructions.

2. Install the DX-LAN card in the computer.
3. Connect the module to the DX-LAN.
4. Install the DX-LAN card driver.

Instructions for Steps 2 through 4 are in Installing the Chromeleon IC System
(Document No. 031883).

B.4

Installing the Chromeleon Software License

For the Chromeleon computer to control the ICS-1000, a valid software license
must be installed. To install the license, you first install a dongle on the computer
and then enter a license “Key Code” in Chromeleon. (A dongle is an adapter that
is connected to the parallel PC interface or USB port. The dongle stores the serial
number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required.

1. Plug the dongle into the appropriate port on the computer (either the parallel
or USB port, depending on the type of dongle). Tighten the connector screws
on a parallel port dongle.

2. Ifitis not already running, start the Chromeleon Server Monitor (select
Start>Programs>Chromeleon>Server Monitor). The Server Monitor
window opens.
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Check the server status:

® [f“Chromeleon Server is running idle” is displayed, the license Key Code
was entered before shipping the computer, and you can omit the
remaining steps in this section. Click Close and go on to Section B.5.

® If “Chromeleon Server is running idle (Evaluation Mode)” is displayed
(see Figure B-4), the license Key Code has not yet been entered. If this is

the case, go on to Step 4.

% Chromeleon Server Monitor

Status

o4 }-‘5- [Chramelzon Server is runring idle {Evaluation Made).

HE B

LClose |

Help |

Y
Start |

Serial Mo B48

Guit b onitor |

Config... |

Figure B-4. Server Evaluation Mode

Open Chromeleon (select Start>Programs>Chromeleon>Chromeleon).
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5. Select File>Preferences to open the Preferences dialog box (see Figure B-5).
Select the License tab and click Dongle. Enter the Key Code exactly as it
appears on the Chromeleon Software License key code sheet. Click OK.

Spectra Thumbnails | AMT Editar I Spectra Library I
Browser License | Grid I Server

Fey Code: IFXXH->< - DA

— Copy Protection Location

€ None [Evaluation Mode]

" Hardpratect 140 ID:-:EIEEIF 3:
" Dionex &0 Converter 140 ID:-:|331-'1 3:

' UYD 340541705 Interface 1/0 |D>:0318 3:

€ Pump Control Card 140 IUHU3UU 3:

* Daongle

€ License Server I.t’-‘-.T-EIEI J
ok I Cancel | el |

Figure B-5. Preferences: License Page

6. Check the Server Monitor status. It should now display “Chromeleon Server
is running idle.” (see Figure B-6).

‘4 Chiomeleon Server Monitor HE B

Status Close |

[Chrameleon Server is running idls.
Help |

Lot Monitar |

Config... |

SEart |

Serial Mo: - B48

Figure B-6. Server Running

7. Click Close to close the Server Monitor window.

8. Go on to Section B.5.
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B.5 Connecting the ICS-1000 to the Chromeleon PC

The ICS-1000 rear panel provides a USB receptacle for connecting the ICS-1000
to a USB port on the Chromeleon PC. The rear panel also provides two USB ports
for connecting other Dionex USB-compliant modules to the system.

B.5.1

Do not turn on the power to the ICS-1000 or other USB module(s) until
after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed.
If not, Windows will be unable to identify the new USB device when
the power is turned on. See Section B.3 to install Chromeleon.

Connecting the ICS-1000 to the PC

1. Locate the USB cable (P/N 960779) in the ICS-1000 Ship Kit
(P/N 057905).

2. Plug the cable’s “A” connector into a USB port on the Chromeleon
PC and plug the cable’s “B” connector into the USB receptacle
(labeled FROM PC) on the ICS-1000 rear panel (see Figure B-7).

Plug the USB cable’s “B” Plug the USB cable’s “A”
connector into the FROM PC connector into the USB
receptacle on the ICS-1000. port on the Chromeleon PC.

B
ICS-1000
A

USB Cable Chromeleon PC

FROM PC USB receptacle
on the ICS-1000 rear panel

Figure B-7. Example Connections: One ICS-1000 Connected to the Computer
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B.5.2 Connecting Additional USB Devices

The ICS-1000 provides two USB ports for connecting additional Dionex
USB-compliant modules to the system.

To connect an additional USB module, plug the “A” connector on a USB
cable into an “A” port (labeled TO MODULE) on the ICS-1000 rear panel
and plug the cable’s “B” connector into the USB receptacle on the USB
module (see Figure B-8).

B
1CS-1000 —A——j
A \

USB Cables A
J k \—‘ Chromeleon PC

Figure B-8. Example Connections: Two Dionex USB Modules Connected to the ICS-1000

NOTE If the number of USB devices in the system exceeds the
number of available USB ports, connect the devices to
the system with a USB-compliant, full-speed external
hub. One or more hubs is also required if the ICS-1000
or other USB device is more than 5 meters (16 ft) from
the PC. Refer to the manual provided by the hub vendor
for complete installation instructions.

The USB standard limits the USB cable length to 5 meters (16 ft). Each

IMPORTANT] USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters

(32 yds) from the PC.
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B.6 Connecting the Power Cord

Connect the power cord (IEC 320 C13) (ordered separately) from the main power
receptacle on the rear panel to a grounded power source. The ICS-1000 power
supply is auto-sensing, so no adjustment is required to select the line voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-1000 or connect it to AC power
mains without an earthed ground connection.

P>

WARNING

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-1000 and is easily
accessible.

P>

CAUTION

Operation at AC input levels outside of the specified operating voltage
range may damage the 1CS-1000.

P>

CAUTION

DANGER D'ELECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne

le branchez pas au secteur C.A. sans utiliser de branchement mis a la
AVERTISSEMENT terre_

P>

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez a ce que la prise de base soit
situéelinstallée prés du module et facilement accessible.

P>

MISE EN GARDE

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlagen ist eine geerdete Steckdose zu verwenden. Das Geriat darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
WARNUNG  Wwerden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daB sich die Steckdose nahe am Gerit befindet und
leicht zuganglich ist.

> P

VORSICHT
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B.7 Turning On the ICS-1000 Power

Before turning on the ICS-1000 power, verify that Chromeleon

IMPORTANT| software is installed. See Section B.3 for installation instructions. If

Chromeleon is not installed first, Windows will be unable to identify
the new USB device.

1. Ifitis not already on, turn
on the computer power and

log onto Windows 2000 or T il ——
Windows XP as an ] :
administrator. Power

2. Press the power switch on i B switch
the ICS-1000 rear panel (see “" "l .
Figure B-9) to turn on the I"" | |
pover. Wl

Figure B-9. ICS-1000 Rear Panel

3. Windows automatically detects the new USB device. A message flashes on
the screen to inform you that new hardware was found.

=101x]

*% Chromeleon

ﬁ IC5-1000/2000 lon Chromatography Systern

Irniztalling ...

| Lonhg...

4. Go on to Section B.8.
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B.8 Setting Up Chromeleon

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon user’s guide or online Help.

B.8.1 Assigning the ICS-1000 to a Timebase

1. Ifthe Chromeleon Server is not running (the icon on the taskbar is

crossed out in red % ), start the Server by right-clicking the icon
and selecting Start Server. When the server starts, the icon changes

to gray % .

2. Open the Server Configuration program (select
Start>Programs>Chromeleon>Server Configuration).

3. The Unassigned USB Devices dialog box appears (see Figure B-10).

Unassigned Dionex IC USB Devices Detected E

The zoftware haz detected USE devices which are not aszigned to a Timebase. Y'ou may add the devices
to an existing Timebaze, create a new Timebaze for these devices, or zsimply press the "Cancel” button to
postpone assigning the module.

Server Mame: AMAR

—Unassigned USE Devices———————————— — Timebase

ICS-1000: 200011

Azzighed Devices

Dionex AS1-100 Autasampler
Diionex PRE0 Pump
Diones WD 3405 FDA

LS =

<o Urassign |

Elasiadie | Hew Eelete

= [Laurich Senven Eanfiguration orib

ak. I Cahicel |

Figure B-10. ICS-1000 Unassigned to Timebase
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4. Click the New button.

5. The Timebase box displays a default name (the Server Configuration
name). You can use the provided name or type a new one (for
example, ICS-1000).

6. Press the Enter key.

7. In the Unassigned USB Devices box, select the ICS-1000 and then
click the Assign button. The ICS-1000 is now assigned to the
timebase (see Figure B-11). If you are installing more than one ICS-
1000, you can verify the serial numbers for each by checking the label
on the component panel.

8. Repeat Step 7 if you are adding additional USB devices to this

timebase.
Unassigned Dionex IC USB Devices Detected E

The software haz detected USE devices which are not aszigned to a Timebasze. vYou may add the devices
to ah existing Timebase, create a new Timebaze for theze devices, or simply press the "Cancel” button to
poztpone azsigning the module,

Server Mame: AMaR

—Unassighed USE Devices — Timebase

Agzigned Devices

: |CS-1000; 200011
)

< [Inasaian

|

ElastModile | Hew Lelete

™| LAt Senver Eomfiguration ot D

QK. I Cancel |

Figure B-11. ICS-1000 Assigned to a Timebase

9. Click OK to close the dialog box. The Server Configuration program
window appears.

B-14
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10. Click the + icon next to the server name to expand the folder. The
timebase you created is displayed (see Figure B-12).

&% Sepver Configuration - Chromeleon Server Configuration

File Edit Wiew Server Help
S R 2R BE DA% N v
=- B amar

ﬂ‘_,’j? Sharable Devices
[ DEMO
=
Dionesx IC5-1000 System
Figure B-12. Server Configuration with ICS-1000 Timebase

11. To verify that the ICS-1000 is correctly connected to the timebase,
double-click its name under the timebase. Click Yes if the following
message appears: “Communication to the device will be stopped...Do
you want to continue?”’
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12. The ICS-1000 System dialog box opens (see Figure B-13). The
General page shows the Device Name (Pump_ECD), the Mode
(Live), and the Module Serial No.

Solventsz I Eluent Generator I State Devices I Errar Levels
Drermao Chromatagrarn I TTL Inputs I Trend I Calibration I Diagnostics
General | Options I Sighals I Head Type & Limits

Device Name: I
~ Mode
® |Live
Madule Serial Mo: |2EIEIEI11 J
Moduleware version:l 0.3.27 Download... |
€ Wirkual

Usge Live mode to control a physical module connected to the server,

Wirtual mode can be uzed to demonstrate the software support for
the module and alloves one to create methods and panels without
having a physical module attached to the zerver.

Figure B-13. ICS-1000 System Properties

13. Close the dialog box and then save the configuration (select
File>Save Installation).

14. Ifyou are going to add one or more DX-LAN devices to the timebase,
go on to Section B.8.2. Otherwise, exit the Server Configuration
program and then go on to Section B.9.

B.8.2 Assigning DX-LAN Devices to the Timebase (Optional)

Follow the instructions in this section if you are adding one or more
devices to the timebase that are connected to the PC through a DX-LAN
interface (not through USB connections).

1. Follow the instructions in Installing the Chromeleon IC System
(Document No. 031883) to add the DX-LAN card to the server
configuration as a sharable device.
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2. Select the timebase that was created for the ICS-1000 (see

Figure B-14); then, click the Add device icon % on the toolbar (or
select Edit>Add Device).

%% server Configuration - Chromeleon Server Configuration
File Edit VYiew Server Help

BE 2R PN
= & amar

Sharable Devices

EEDFE NV

DEMO

- g Dionex IC5-1000 System

Figure B-14. Example: ICS-1000 Timebase

The Add device to timebase dialog box appears.

3. Ifitis not already selected, select Dionex under Manufacturers and
then select the device from the Devices list.

dd device to timebase
Timebhase Name:  BiolLC
hanufacturers: Devices:
Ze ADZ0 Detector =
General AD25 Detactor :I
AR 50 Autosampler;
Agilent AZF100 Autosampler
Antec &% CD20 Detectar
Berthold S 025 Detector
BIC-RAD o)
cTC o) CD25A Detectar
Dostmann E2 D120 Systemn
e 419 EDA40 Conductivity Detectar
il =f B9 Fnan nir Aran Netartar =l
oK | Cancel |

Figure B-15. Add Device to Timebase Dialog Box
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4. Click OK. A configuration properties dialog box for the device
appears. Figure B-16 shows an example of the properties for an AS50

Autosampler.
Dionex AS50 Autosampler E
Errar Levels | Calibration | Diagnostic |
General | Options I Temperature I Devices

Device Name:  |EENEE

™ Demo Mode

— Communication

Device |D:

INone J
Buemy far Device 1D |

Device Senial No:

Figure B-16. AS50 Configuration Properties

5. On the General tab page, clear the Demo Mode check box if it is
currently selected, and then select the DX-LAN Device ID number.
Note: Devices display their DX-LAN ID numbers when their power
is turned on.

Click OK to close the dialog box.
Save the configuration (select File>Save Installation).

Exit the Server Configuration program.

o »® =N

Go on to Section B.9
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B.9 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. Before
beginning the installation, refer to the column and
suppressor manuals for detailed start-up and
installation instructions. The manuals are provided on
the Dionex Reference Library CD-ROM (P/N 053891),
which is located in the ICS-1000 Ship Kit (P/N 057905).

Before beginning:

* Remove the guard column, separator column, and suppressor from their

boxes.

* Remove the fitting plugs from the ends of each column and from all ports on
the suppressor.

® Discard any tubing temporarily connecting the suppressor ports.

B.9.1

Column Heater Setup (Optional)

Follow the steps below if the optional column heater is installed.

L.

Cut off the two
shipping ties from
the column heater
and remove them

(see Figure B-17).

Loosen the two
thumbscrews on
the heater cover
(they remain
attached to the
cover).

Pull the heater
cover straight out
to remove it.

E/Thumbscrew (2)

Figure B-17. ICS-1000 Column Heater Setup
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B.9.2

4. Unscrew the six

thumbscrews on the
top metal plate (see

Figure B-18) and

remove the plate. Thumbscrew (6)

Go on to
Section B.9.2.

Figure B-18. ICS-1000 Column Heater Cover Removed

Installing the Columns

S kW

Remove the union connecting GUARD IN and GUARD OUT.

Connect GUARD IN to the guard column inlet. Check the arrow on the
column label; it should point down (flow away from the injection
valve).

Connect GUARD OUT to the guard column outlet.
Push the guard column onto the back column clip.
Remove the union connecting COL IN and COL OUT and

Connect COL IN to the separator column inlet. Connect COL OUT to
the separator column outlet. Check the arrow on the column label. It
should point up (flow toward the cell).

Push the separator column onto the front column clips.

Replace the top metal plate on the column heater (if installed).

B-20

Doc. 031879-01 3/03




Installing and Plumbing the Columns and Suppressor

B.9.3 Installing the Suppressor

1. Locate the suppressor
mounting tabs on the
component panel (see
Figure B-19). Reach
into the opening
between the tabs and
pull the yellow
connector and attached
cable slightly out of the
opening.

1 Suppressor
Mounting Tabs

2 Suppressor Cable
Connector

3 Guideline for AES

4 Guideline for SRS

2. Connect this cable to the
cable from the
suppressor (align the
pins on the two
connectors and push
them together).

Figure B-19. Suppressor Mounting Tabs
and Guidelines

3. Orient the suppressor with the REGEN OUT fitting on top and the
cable to the right.
4. Feed the cable into the opening in the component panel.

5. Align the top of the suppressor with the guideline printed on the
component panel (see Figure B-19) and align the slots on the rear of
the suppressor with the tabs on the panel.
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6. Press the suppressor onto the tabs
and then slide it down to lock it in
place. Pull slightly on the center of
the suppressor to verify that it is
securely fastened. Figure B-20
shows an SRS suppressor installed
on the component panel.

7. Remove the union connecting
ELUENT IN and ELUENT OUT and
connect these lines to the
corresponding ports on the
SUppressor.

Figure B-20. Suppressor Installed
(SRS Shown)

8. Remove the fitting plug from REGEN IN and connect it to the REGEN
IN port on the suppressor. Connect the TO SRS/AES REGEN OUT line
to the REGEN OUT port on the suppressor.

9. Replace the cover on the column heater (if installed), making sure the
GUARD IN line is aligned with the slot on the side of the heater cover.

10. Go on to Section B.10.
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B.10 Connecting the Waste Lines

The ICS-1000 has the following waste lines:

® PUMP WASTE carries prime waste from the pump.

® TO WASTE OUT carries sample overflow from the injection valve.

® WASTE, GAS SEPARATOR carries system waste from the suppressor.

Untape the coiled waste lines from the rear panel. Place the ends of the PUMP
WASTE and TO WASTE OUT lines into a waste container.

Direct the WASTE, GAS SEPARATOR line from the top of the ICS-1000 to the rear
panel. Snap the line onto one of the tubing clips on the rear panel. Connect the line
to the gas separator waste tube (see Section B.10.1).

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

B.10.1 Installing the Gas Separator Waste Tube

1. Locate the gas

separator waste tube 0 '& Connect the
assembly (see WASTE, GAS
Figure B-21) in the ﬁE;ARATOR line
ICS-1000 Ship Kit

(P/N 057905).

2. Connect the WASTE,
GAS SEPARATOR
line to the 3-mm
(1/8-in) ID white
Teflon tubing on the
gas separator waste
tube assembly.

Figure B-21. Gas Separator Waste Tube Assembly

3. Place the gas separator waste tube assembly into the waste container.
Make sure the tubing junction (where the white Teflon tubing meets
the black polyethylene tubing) is above the top of the container and
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that the gas separator waste tube and the waste container are open to

the atmosphere (see Figure B-22).
4. Go on to Section B.11.

Waste, Gas
Separator Line

Gas Separator

Waste Waste Tube Assembly

Container

CAUTION

MISE EN GARDE

Figure B-22. Gas Separator Waste Tube Installation

DO NOT CAP THE WASTE CONTAINER: The ICS-1000 uses an
electrolytic process that results in the production of small amounts of
oxygen or hydrogen gas. To ensure that the gas is not trapped in a
closed container and allowed to concentrate, install a 1.3-cm (0.52-in)
ID black gas separator waste tube (P/N 045460) in an uncapped waste
container. Connect the Waste, Gas Separator line to the waste tube

(see Figure B-22).

NE FERMEZ PAS LE CONTENEUR DE GAZ RESIDUEL L : Le ICS-1000
travaille avec un proces d’électrolyse, qui produit des petites
quantités de gaz d’oxygéne ou d’hydrogéne. Afin de garantir que le
gaz ne soit pas enfermé dans un conteneur fermé et puisse s’y
concentrer, connectez un tube noir a gaz résiduel (diamétre intérieur =
1,3 cm ; n° de commande 045460) a un conteneur ouvert (non fermé).
Connectez le conteneur résiduel au tube résiduel/gaz séparateur
(désigné: « Waste, Gas Separator»).

B-24
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VERSCHLIESSEN SIE DEN ABFALLBEHALTER NICHT: Der ICS-1000
verwendet einen Elektrolyseprozess, wodurch kleine Mengen an
Sauerstoff und Wasserstoff entstehen. Fiihren Sie einen schwarzen
Gasabscheiderschlauch (ID = 1,3 cm; Bestell-Nr. 045460) in einen

VORSICHT offenen (unverschlossenen) Abfallbehilter, damit sich das Gas nicht
in einem geschlossenen Behalter sammelt und aufkonzentriert.
Verbinden Sie die mit Waste, Gas Separator bezeichnete Leitung mit
dem Abfallschlauch.

B.11 Setting Up the Eluent Reservoir

1. Rinse the eluent reservoir.

2. Prepare the eluent as instructed in the manual for the column being installed.
The column manual is included on the Dionex Reference Library CD-ROM
(P/N 053891), located in the Ship Kit.

3. Fill the reservoir with the prepared eluent.
4. Place the reservoir on top of the ICS-1000.
5. Install the cap and hand tighten.
NOTE The ICS-1000 does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Dionex recommends pressurizing the

reservoir with helium or nitrogen. See Section B.20 for
instructions.

6. Go on to Section B.12.
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B.12 Setting Up a Chromeleon Application

Chromeleon provides application templates, which you can use to quickly get
started running. To use the application templates, you need to know the type of
column and suppressor you will be using. This section shows how to create a list
of samples to be processed (a sequence) and how to use an application template.

1. Identify the type of column and suppressor installed in the ICS-1000.

2. Start Chromeleon (select Start>Programs>Chromeleon>Chromeleon).
The Chromeleon main window and Browser appear (see Figure B-23).

*} Chromeleon - AMAR _local’\Dionex Templates - Browser

File Edit Wiew ‘Workspace CQuoalification  Batch  Window  Help

Dl fS & 2R by BNy (s DEEEBE @
Rl e e s o ) |

Eﬂll“lﬂR_IucaI"-.,"-.,Diune:-: Templates - Browser

E--@ AMAR, _local Mame / |Last Updste

-] DEMO [ IC Applications 22003 111632 &

S8 TPDicr=:: Terpl (] Panels 19672003 20551 PM

(01C applications || 23 Reports 2402003 111632 &

[ Panels

i ([ Reports

B 1¢5-1000
(23 AUDIT
e manual

lakes

Figure B-23. Chromeleon Main Window and Browser
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3. In the Browser, select File>New and select Sequence (using Wizard) (see

Figure B-24).

{Seguence (using Wizard)
Seguence (from LIMS Worklist)
Query (using Wizard)

Program File

tethod File

Spectra Library

K.

Cancel

il

Help

Figure B-24. Creating a New Sequence

The Sequence Wizard Welcome page appears (see Figure B-25).

Chromeleon Sequence Wizard: Welcome

Welcome to the

Sequence Wizard

Thiz wizard helpz pou to create a sequence. [t will guide pou through

the following steps:

o Choose a timebase
o Specify standards and unknownz
o Select method files
o Store the sequence

To continue, click Mext.

Cancel

Help

Figure B-25. Sequence Wizard Welcome Page
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NOTE For details about a Sequence Wizard step, click the Help
button on the Sequence Wizard page.

4. Click Next>.
The Sequence Wizard Timebase page appears (see Figure B-26).

Chromeleon Sequence Wizard - Step 1 of 5: Timebase E

Chooze a Timebase
Select the timebasze where the sequence will run,

Timehaze: EQ My Computer
fics-1000 ~6L) DEMO

SSEICS-1000
LCamputer: :
IAMAH : Favorites

25 Metwork Meighborhood

PBratocal:
IM_I,I Computer j

Enter connection information
manually or pick a timebaze from
the lizt at right.

< Back I MHeut » I Cancel | Help

Figure B-26. Example: Sequence Wizard Step 1

5. Select the ICS-1000 timebase and click Next>.
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The Unknown Samples page appears (see Figure B-27).

Chromeleon Sequence Wizard - Step 2 of 5: Unknown Samples E
Unknown Samples
Generate zamples from a template o import them via clipboard or from another sequence
T [— | Sequence Preview | Fack F'reviewl .
MHane | Pos. | Wal. |
Template far Sample Mame:
j 3 |
Mumber of Wials: ID [1..%]
Injections per Yial; I1 [1...99]
Start Position; I1 [1...99339]
Injection Yolume:  [20.00 [0.1...100000.0 pi]
Apply > I
< Back | MHeut » | Cancel | Help

Figure B-27. Example: Sequence Wizard Step 2

6. Select Use Template from the drop-down list.

7. In the Template for Sample Name field, type Sample, click the right arrow,
and select Sample Number #n.

8. In the Number of Vials field, type 1.
9. Use default settings for the remaining parameters on the page.

NOTE You can edit the sequence later, to add more samples

and select the injection parameters appropriate for your
application.
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10. Click Apply.
Figure B-28 shows Sequence Wizard Step 2 after a sample is defined.

Chromeleon Sequence Wizard - Step 2 of 5: Unknown Samples

Unknown S5amples
Generate samples from a template or import them via clipboard or fram another sequence

Sequence Preview i
IUse template j [riport... | ; | e F'rewewl i

Mame | Pog. | Wal, |
Template for Sample Name: @ Sample 1 1 200

ISampIe fn j ;I
Murnber of Yials: |1— [1...x]
Injections per Yial: |1— [1..99]

Start Pozition: |1— [1...99939]

Injection Wolame: |2':'-D [0.1..100000.0 0

Apply rx

< Back I Ment » I Cancel | Help

Figure B-28. Example: Sequence Wizard Step 2 with Sample Defined

11. Click Next>.
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The Standard Samples page appears (see Figure B-29).
Chromeleon Sequence Wizard - Step 3 of 5: standard Samples E2

Standard Samples

Generate standardz from a template or import them via clipboard or from another zequence

s tomplole [ | Sequence Preview | Fack Preview | :
M arme | Pos. | Wl |
Template for Sample Hame; @ Sample 1 1 200

=i
Mumber of Wials: ID [1...x]
Injections per Yial; I1 [1...99]

Start Position; |99 [1...99939]
Injection Yolume:  |20.0 [0.1...100000.0 pl]

[ Variation: |'| Standard(z]
aftern each |1 W rikrmasmls]

Apply >

< Back I Mewut » I Cancel | Help |

Figure B-29. Example Sequence Wizard Step 3

12. Click Next> to omit this step and define standard injections later. Or, define
one or more standard injections, and then click Next>.

The Methods & Reporting page appears
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13. Select the Use Application Template check box.

14. From the drop-down lists, select the type of suppressor to be installed and
then select the column.

In the example in Figure B-30, the 4-mm ASRS suppressor and AS17 column
are selected.

Chromeleon Sequence Wizard - Step 4 of 5: Methods & Reporting E

Methods & Reporting
Specify a method or select a pre-defined template, and indicate reporting preferences.

— Applications (includes method)

¥ Use Application Template Suppressor Type IASHS_4mm vl

I.&S1 T Production Test Chromatogram j

= ethiad les

Brogran: I.l’-‘n.51 7 Production Test Chromatogram j Browse... |
[uantifieationm i ethod: IAS'I ¢ Praduction Test Chromatogrann j Browss... |

e progran atd auattticaton fes il beimperted (copred] inta e new seauence)

— Preferred Reparting Options

Preferred Report: IT_|DCEI|'\DiDnB:-: Templates'\Heports'\defaultj Browse... |

Preferred Channel: I j

These settingz are uzed when vou print a report for the sequence or double-click. a zample.

< Back I MHeut » I Cancel | Help

Figure B-30. Example: Sequence Wizard Step 4

15. To select a report template, click the Browse button, go to the Dionex
Templates/Reports folder, and select a template (for example, default_letter).

16. Click Next>.
The Saving the Sequence page appears.
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17. Enter a name for the sequence and a location (see the example in

Figure B-31).

Chromeleon Sequence Wizard - Step 5 of 5: Saving the Sequence E3

Saving the Sequence

Specify where to save the seguence. Press Mest to zave it.

—Mame & Title

Remember ta enter a new seguence name, unless you want to ovenarite an old sequence.

Seguence Mame: IInstaIIatinn Exampld

[
[

Title: |
— Location
Datasource: IAM."—‘-.F!_IDcaI =]
Directony: I ﬂ Browsze. . |

< Back I Hewt » I

Cancel | Help |

Figure B-31. Example: Sequence Wizard Step 5

18. Click Next> and then click Done on the last page of the Sequence Wizard.

The Browser appears, displaying the sequence you created (see Figure B-32).
Notice the three files in the top pane of the Browser window.

EAMAR_Iocal"-.,"-.,InsI:aIIaI:ion Example - Browser

E@ amMar_local Mame /| Title: Timehase La
F-[Z] DEMO Z A517 Production Test Chromatogram . pom AZ17 4mm Production Test Chromatogra 1C5-1000 ar:
@] Dionex Templates | 2317 Production Test Chromatogram.ant 7
-3 1251000 [ \cs-1000_System pan 27
423 Installation Example
| | |
Mo. [Mame IType |Pos | Inj. %al. | Program Method |Status |Inj. Dt -
1 @ Sample 1 |Unkn0wn 1 200 A517 Produ AS17 Produ Single

-

14 | D

Figure B-32. Example Browser with Open Sequence
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The .pgm file (program) contains commands and parameters for controlling
the ICS-1000, controlling the autosampler (if used), and acquiring sample

data.

The .qnt file (quantification method) contains peak identification and area
determination parameters.

The .pan file (Control Panel) lets you control and/or monitor the ICS-1000
and other modules that are connected to the timebase.

NOTE The sequence that you create here is intended as a
starting point only. You can add additional samples to
the sequence, change injection parameters, and edit the
.pgm and .qnt files. Refer to the Chromeleon online Help
for details.

NOTE After completing the installation, see Section 3.11 for
how to process the samples and standards in the
sequence.

19. Double-click the .pan file to open the Control Panel for your system (see the
example in Figure B-33).

1CS-1000 Pump:

% 125-1000 System - [CS-1000 - AMAR

ump - On
F- 800 psi

Pump Settings...

ICS-1000 Inject

i

LoadP osition
Load Inject
Injector Settings...

Sequonce: |
e
Program:

(=S
System Log [Audit Trail] on ICS-1000
16:07:29 User [AMar) from AMAR -
has connected to timebase 1C5-1000
@ 16:07:29 User [Ahar) fram AMAR
has acquired control over timebase [CS-1000.

-

Elapsed Program Time:
Total Program Time: |:|

ICS-1000 Syst
¥ Connected Startup Shutdown| Show Plutl

ICS-1000 Detec

0.108 pS

Suppressor - Off

Detector Settings...

O om

T T T
0.00 0.50 1.00

Figure B-33. ICS-1000 System Control Panel Example
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B.12.1

NOTE If the Connected check box is not selected, click the box
to connect the ICS-1000 to the Control Panel.

Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the ICS-1000 by clicking
the Inject and then the Load button on the Control Panel. If
communication is occurring, you will hear the valve actuate as it changes
position.

Go on to Section B.13.

B.13 Setting the Eluent Level

After filling the reservoir, enter the volume of liquid in the reservoir on the
Chromeleon Control Panel (see Figure B-34). The ICS-1000 determines the
eluent usage by monitoring the flow rate and the length of time the pump is on,
and updates the Eluent Level field as the eluent is used up. A warning appears if
the level falls below 200 mL. Warnings are repeated at 100 mL and 0 mL.

In order for the eluent level displayed on the Control Panel to be
accurate, the level must be entered by the user when the reservoir is
filled. The ICS-1000 does not automatically detect when the reservoir
is filled, nor when it is empty.

Enter the volume of Note: The Eluent Bottle
liquid in the reservoir - E

ICS-1000 Pump=
-Eluent Bottle

field and slider gauge
-4 are updated as the

- liquid is used up.

-2
-0

Figure B-34. Setting the Eluent Level
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B.14 Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and hand
tightened, and the liquid line from the ICS-1000 to the reservoir cap is
connected (see Section B.11).

2. Verify that the waste lines are directed to a waste container.
3. The priming procedure consists of two parts:

®  Priming the eluent lines with a syringe. Perform this procedure at initial
installation, after changing eluents, or when eluent lines are empty.

® Priming the pump heads with the Prime button. Perform this procedure
after the eluent lines are primed.

B.14.1 Priming the Eluent Lines with a Syringe

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.
1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 054578) to the port in the priming
valve on the primary pump head (see Figure B-35).

Secondary
Pump Head

Waste Valve
(close)

Primary
Pump Head

10 mL Syringe Priming Valve
(P/N 054578) (open)

Figure B-35. Priming the Eluent Lines
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3. Open the priming valve by turning it one-quarter to one-half turn
counterclockwise.

4. On the Chromeleon Control Panel, click Pump Settings and then
click Eluent Flow Valve Open (see Figure B-36).

& I1CS-1000 System - 1£S-1000 - AMAR
ICS-1000 Pump

Pressure:
-Pump Settings

800 psi Flow Rate: [IEULILL S
Pump Settings... ‘Eluent Bottle— On | Off | Prime |

0.00 1 33
1CS-1000 Injec 1 rluent Flow Valve

- -4
EH LoadPosition £ Closed | Open |
| : i3
Load —‘Inject £ Max. Pressure: | 5000 psi
i i 12
Injector Settings... : Curr. Pressure: | 800 psi

ICS-1000 Detect g Min. Pressure:
0.088 |JS =C Eluent Level:

. E Suppressor Current—
= 0 mA 3:
= T 1

Figure B-36. Chromeleon Control Panel: Pump Settings

HENEE

5. Draw the syringe back to begin pulling eluent through the flow path.
It may take several syringe draws to remove all air or previous eluent
from the tubing.

NOTE If the vacuum degas assembly is installed, draw
out an additional 20 mL of eluent.

6. After priming the lines thoroughly, close the priming valve. Do not
overtighten the priming valve.

7. Close the eluent valve (click Eluent Flow Valve Closed on the
Control Panel).
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B.14.2 Priming with the Prime Button

NOTE Perform this procedure after priming the eluent
lines (see Section B.14.1).

Check that the priming valve on the primary pump head is closed (see
Figure B-37).

Waste Valve

Secondary
Pump Head

(open)

Primary
Pump Head

Priming Valve
(close)

Figure B-37. Priming the Pump

Open the waste valve on the secondary pump head by turning the
knob one-quarter to one-half turn counterclockwise (see

Figure B-37). Opening the valve directs the eluent flow path to waste
and eliminates backpressure.

Click Prime on the Chromeleon Control Panel (see Figure B-36). The
pump will begin pumping at approximately 3.0 mL/min.

Continue priming the ICS-1000 until no air bubbles are exiting the
pump waste line.

Press Pump Off.

Close the waste valve. Do not overtighten. The pump is now ready
for operation.

NOTE If the two standard priming procedures described above

are unsuccessful, prime the pump with isopropyl
alcohol.See Section 5.15 for instructions.

B-38
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B.15 Equilibrating the System

1.

After priming the pump, turn on the pump and set the flow to the operating
rate.

Flush the system for about 5 minutes to equilibrate.

Monitor the system pressure from the Control Panel to make sure it is at the
expected pressure for the installed column (refer to the column manual for
details) and is stable. If the pressure is less than the expected amount, gas may
be trapped in the system. Release the gas by removing the pump fitting on the
injection valve. The fitting is labeled P (2). Allow the air to escape and then
reconnect the fitting.

Check that liquid is flowing out of the suppressor REGEN OUT waste line and
that the pressure is stable.

Monitor the baseline conductivity. In general, it should be <30 uS for a system
set up for anion analyses, and <2 uS for a system set up for cation analyses.
Equilibration time varies and it can take some time to reach these expected
values.

B.16 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by
monitoring the pump pressure reading on the Chromeleon Control Panel. Write
down the short-term pressure fluctuations; they should be less than 0.13 MPa

(20 psi).

ICS-1000 installation is complete. For routine operation, refer to Chapter 3.
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B.17 Connecting an AS50 Autosampler (Optional)

B.17.1 AS50 Configuration Requirements

To use an AS50 autosampler with the ICS-1000, the AS50 must meet the
following requirements:

* Aninjection valve cannot be installed in the AS50
® The AS50 must have Moduleware version 1.11 or later installed
¢ Control of the ICS-1000 injection valve must be enabled in the AS50

The following AS50 models are configured at the factory to meet the
above requirements:

® ASS50 without injection valve (P/N 061309)
* ASS50 without injection valve; with sample preparation (P/N 061310)

* ASS50 without injection valve; with sample preparation and sample
tray cooling (P/N 061311)

* AS50 without injection valve; with sample tray cooling (P/N 061312)

Notes

® To identify the version of Moduleware currently installed in the
AS50, go to the AS50 POWER UP screen (press Menu, 8, and 1). If a
Moduleware update is required, contact Dionex.

® In order to use an AS50 that has an injection valve installed, the valve
must be disconnected from the AS50 electronics. Contact Dionex for
assistance. The AS50 electronics components cannot be serviced by
the user.

® [fthe AS50 is currently running with a Thermal Compartment (TC)
or Chromatography Compartment (CC) and you are now going to use
it with an ICS-1000, the injection valve is typically installed in the TC
or CC, not in the AS50. If this is the case, verify that the correct
Moduleware version is installed, and enable control of the ICS-1000
injection valve (see Section B.17.3).

After the AS50 is configured for use with the ICS-1000, all AS50 modes
of injection (full-loop, partial-loop, and partial-loop limited-sample) are
supported. In addition, all AS50 injection valve commands (whether

B-40
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issued from the AS50 front panel or from Chromeleon) will control the
ICS-1000 injection valve. For Chromeleon control, the AS50 must be
added to the ICS-1000 timebase (see Section B.8). For front panel
control, the AS50 and ICS-1000 can be set up for stand-alone operation.
This requires a TTL cable connection between the AS50 and the ICS-
1000. See Section C.3 for stand-alone setup instructions.

B.17.2 AS50 Connections

1. Place the AS50 to the left of the ICS-1000 on the workbench.
2. Open the ICS-1000 and AS50 doors.

3. The needle seal line that extends from the inject port in the
autosampler is coiled inside the AS50 door, on the right side. Route
this line through the AS50 right side slot (see Figure B-38) and the
ICS-1000 left side slot to the ICS-1000 injection valve.

The needle seal line from the AS50 inject port to the ICS-1000 injection
||Mp0R-|-AN-|-| valve is calibrated for use with the ICS-1000. To ensure injection
=" precision, do not shorten (by cutting) or lengthen this line, or replace

it with a different (uncalibrated) line.

Route AS50
needle seal line
to ICS-1000
injection valve

Insert the waste line
from the ICS-1000
injection valve here

i

Figure B-38. AS50 Drip Tray
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4. Connect the needle seal
line from the AS50 to port AS50
S (5) on the injection valve Needle

. Seal Line
(see Figure B-39).

The green waste line that is
connected to port W (6) on
the injection valve (see
Figure B-39) is connected
with a union to a Teflon
waste line (see

Figure B-40) and routed
through the tubing chase to
the ICS-1000 rear panel.

Waste
Line

5. Disconnect the green
waste line (labeled AS50
TRAY) from the union and
route the line to the drip
tray in the autosampler
compartment.

AS50 TRAY
Waste Line
(disconnect
from union)

You can either leave the
disconnected Teflon waste
line and union in the
tubing chase, or pull the
line out from the front.

Figure B-40. Injection Valve Waste Line Union

6. Push the end of the green AS50 TRAY line into the small round opening on the
right side of the AS50 tray (see Figure B-38).

Make sure the injection valve waste line is not elevated above the
@] injection valve at any point between the valve and the AS50 drip tray.

NOTE For PEEK waste lines, sharply bend the waste line
tubing about 5-mm from the end to ensure it stays in
place in the opening in the drip tray. When bending the
tubing, be sure not to restrict the inner diameter.

7. If you have not already done so, add the AS50 to the Chromeleon timebase
(see Section B.8).
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B.17.3 Enable AS50 Control of the Injection Valve

Follow the steps below if you are connecting an AS50 that was not
configured at the factory for ICS-1000 support. Injection valve control is
already enabled in pre-configured AS50 models (see the list in

Section B.17.1).

1. On the AS50 front panel, press Menu and 0 to go to the TIME
FUNCTION OUT screen (see Figure B-41). In the LOAD/INECT VALVE:
TTL 1 field, select ENABLED.

TIME FUNCTION OUT

TTL
LOAD/INJECT VALVE: 1  ENABLED
LOAD/INJECT VALVE: 2  DISABLED

Help Prompt

Figure B-41. AS50 Time Function Out Screen

2. Turn the AS50 power off and then back on.

All AS50 injection valve commands (whether issued from the AS50
front panel or from Chromeleon) will now control the ICS-1000
injection valve.
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B.18 Connecting an AS40 Automated Sampler (Optional)

1.

CAUTION

Place the AS40 to the left
of the ICS-1000 on the
workbench.

Open the front door of the
ICS-1000 and thread the
outlet line from the AS40
through the left side slot
at the front of the ICS-
1000.

Connect the outlet line
from the AS40 to port
S (5) of the injection valve

(see Figure B-42).

Figure B-42. ICS-1000 Injection Valve

Locate the relay control cable (P/N 047946) supplied with the AS40.

Remove the 2-position connector plug from the pair of wires labeled LOAD on
the relay control cable.

Locate the 12-position connector
plug (P/N 923686) in the ICS-
1000 Ship Kit (P/N 057905) (see Positlon 1
Figure B-43).

Attach the red wire from the
relay control cable to position 1 Position 12
on the plug, and attach the green
wire to position 2. This will be
used to connect the AS40 LOAD  Figyre B-43. 12-Position Connector Plug
relay to RELAY OUT 1 on the

ICS-1000.

Locking
Screws

To attach a wire to the plug, strip the end of the wire, insert it into the plug,
and use a screwdriver to tighten the locking screw.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the
connector.

B-44
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NOTE If RELAY OUT 1 is not available, you can connect to
RELAY OUT 2 or to one of the TTL outputs. For RELAY
OUT 2, connect the red wire to position 3 and the green
wire to position 4. For TTL OUT 1, connect the red wire
to position 5 and the green wire to position 11. For TTL
OUT 2, connect the red wire to position 6 and the green
wire to position 12.

8. Connect the relay control cable's 10-position connector plug to the RELAY
CONTROL connector on the AS40 rear panel (see Figure B-44).

9. Plug the 12-position connector plug into the TTL and relay connector on the
ICS-1000 rear panel (see Figure B-44). Make sure the red wire connects to
position 1 and the green wire connects to position 2.

ICS-1000 Rear Panel AS40 Rear Panel
TTL/Relay Connector
RELAY CONTROL
13 B £ E s
| 3 s 2
RELAY 2 g R
sl
—E
TTLouT 1| © v
(+) 2 Mviol viol/ a9/ {red ] green
u
11 © =
TTLIN 21l o red u grnNot used here
(+) 3o
4 Gt Relay Control Cable
TTLGND 1 ©
) 2f o

Figure B-44. Example AS40 Autosampler Connection

The AS40 Load relay is now dedicated to the ICS-1000 RELAY OUT 1. Use this
relay for running with Chromeleon. When you set up the ICS-1000 application
(see Section B.12), commands for controlling the AS40 Load relay and switching
the ICS-1000 injection valve are included by default in the program file (see

Figure B-45).
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5124 Production Test Chromatogram - Commands - |E

m Production Test Chromatograrm

—-2.300

UL E S L UL LETIL = =

Flow = 1.50

Pump ECD Relay 1.Closed Duration=138.00 ; For AS40 injection
Relay 1 turned on to start Relay 1 turned off after

the AS40 Load cycle and 138 seconds

0.000 Pump ECD.Autozero

ECD 1.Acqon load the sample loop
Pump Injectvalve.InjectPosition Duration=20. OO:

15.000 ECD 1.AcqgoOff Injection valve Injection valve

- switched to Inject switched back

End to Load

4 | o

Figure B-45. Example Program for AS40 Control
B.19 Analog Output Connection (Optional)

B.20

The analog output connector on the ICS-1000 rear panel outputs an analog voltage
signal proportional to the conductivity measured by the cell. The output is filtered
using the selected data rise time. The analog output can be connected to an
analog-to-digital converter such as an integrator or other recording device. Refer
to the documentation for the device for connection instructions.

Analog output is 0 to 1V, scaled to the selected range.

For an example setup for ICS-1000 stand-alone operation with an AS50
autosampler, see Section C.3.

Pressurizing the Eluent Reservoir (Optional)

The ICS-1000 does not require pressurized reservoirs. However, if eluent is
manually degassed or is sensitive to contamination, Dionex recommends
pressurizing the reservoir with helium or nitrogen. The air regulator accessory
bracket and other items needed for pressurizing the eluent reservoir must be
ordered separately (P/N 060054).

B-46
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Pressurizing the Eluent Reservoir (Optional)

B.20.1 Connecting the Gas Source (Optional)

1. Locate the barbed fitting (P/N 030071), pipe thread reducer
(P/N 030087), 3-mm (1/8-in) ID tubing (P/N 040793), and ICS-1000
air regulator accessory (P/N 060054). These parts must be ordered
separately.

2. Use the barbed fitting and pipe thread reducer to connect the 3-mm
(1/8-in) ID tubing to a clean gas source, regulated to between 0.55
and 0.83 MPa (80 and 120 psi).

3. Push the other end of the tubing onto the inlet of the air regulator (see
Figure B-46).

4. Remove the eluent reservoir cap.

5. Connect the gas line from the eluent reservoir cap to the gas line on
the air regulator outlet.

6. Slip the air regulator accessory bracket over the neck of the eluent
reservoir (see Figure B-46).

Eluent Gas Line

Air Regulator
Accessory
Bracket

Gas Inlet Line
3-mm (1/8-in) ID

Connec

- gas source

-

Figure B-46. ICS-1000 Pressurized Eluent Reservoir Connections (Optional)
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B.20.2 Pressurizing the Eluent Reservoir (Optional)

NOTE Do not pressurize the ICS-1000 until after the
reservoir is plumbed.

1. Pull out the air regulator knob and turn it fully counterclockwise to
ensure there is no pressure to the reservoir when the gas source is
turned on.

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the
eluent reservoir.

4. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the
regulator knob back in.

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

CAUTION
Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure a 0,07 MPa (10 Ib/po?).

MISE EN GARDE
Setzen Sie den Eluentbehilter auf keinen Fall einem Druck liber 0,07
MPa aus.

VORSICHT
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Pump Continuous Seal Wash Connections (Optional)

B.21 Pump Continuous Seal Wash Connections (Optional)

The pump includes a seal wash assembly that can be set up to continuously rinse
the back of the piston seals to remove salt crystals and prolong the life of the seals.
Follow the steps below to set up this feature.

1. Fill a flush bottle with either deionized water or a combination of deionized
water and 10% or 20% isopropyl alcohol. (Isopropyl alcohol will inhibit
bacterial growth in the water.)

2. Place the flush bottle on top of the ICS-1000. During operation, gravity
maintains flow through the pump heads.

3. The flush solution is carried to the piston seal wash assembly and out to waste
via 1.5-mm (0.06-in) ID tubing (P/N 055847). Locate this tubing in the ICS-
1000 Ship Kit and cut the tubing into three unequal pieces in the following
lengths:

® 117 cm (46 in)
® 152 cm (60 in)
® [5cm(6in)
4. Install the tubing as follows (see Figure B-47 and Figure B-48):

a. Push the 117-cm (46-in) piece of clear tubing onto the drain tube on the
bottom of the secondary pump head. Place the free end of this tubing in
the flush bottle. Make sure the end of the tubing is near the bottom of the

bottle.
Drain Tube
Drain Tube
Primary Pump
Head

Note: The drain
tubes on the
bottom of each
pump head are not
visible in the
photo.

Secondary
Pump Head

Figure B-47. Primary and Secondary Pump Heads with Drain Tubes
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Push the 152-cm (60-in) piece of clear tubing onto the drain tube on the
top of the primary pump head. This is the waste line. Route this waste line
through the lower tubing chase and out the back of the ICS-1000.

Push the 15-cm (6-in) piece of clear tubing over the drain tube on the top
the secondary pump head. Push the other end of the tubing over the drain

tube on the bottom of the primary pump head.

Place a 10 mL syringe (P/N 054578) at the end of the waste line, press the
syringe against the line to form a seal, and draw out all of the air.

Push approximately 5 cm (2 in) of black 0.25-mm (0.01-in) ID tubing

(P/N 057057) into the end of the waste line.

NOTE The black tubing creates a flow restriction. Assuming a

height difference of about 76 cm (30 in) between the
flush bottle and the waste container, this setup provides
a flow of one drop of flush solution every 5 to 30 seconds.

Place the end of the waste line in a waste container.

This completes the piston seal wash installation. Periodically refill the

flush bottle and empty the waste container as required.

Flush Tubing, 117 cm (46 in) long

Bottle v

Secondary Pump Head —/

Tubing, 15 cm (6 in) long —/

/— Primary Pump Head

. Tubing, 152 cm (60 in) long
!

end of waste line

Insert black tubing into - s

Waste
Container

Figure B-48. Piston Seal Wash Flow Schematic

B-50
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Manually Connecting to a Control Panel

B.22 Manually Connecting to a Control Panel

This section describes how to manually connect the ICS-1000 to a Control Panel
if you do not use the application templates described in Section B.12.

1. Inthe Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-1000
folder. Several System Control Panels, corresponding to various system
configurations, are provided.

2. Open the panel for your system configuration by double-clicking its name in
the list. For example, if your system includes an ICS-1000 and an AS50
autosampler, double-click either ICS-1000_System_ASS50.pan or ICS-
1000_Traditional_System_ASS0.pan.

NOTE The two types of panels (system and traditional
system) are similar in function, but have different
“looks.” You can select either style, depending on
your personal preference.

When the Control Panel opens, the controls on the panel are not enabled (see
Figure B-49).

% Pump and Detector - - _ Ol
Sampl Audit Trail
Datasource: |($1) | Elapsed Time: Eem.ﬂmemii -
Sequence: [($1} ] Run Time:
Sample: [($1} ] em
program: [51) || _Stortun | stutanmn | -
Pump_ECD.DeviceType} Pump ([Pump_ECD.DeviceType} D
Eluent Bottle, = i | [T G d ‘C " ‘ Signal: ‘ PJ.Signal.Valu(‘ ‘Supp. Type:‘ 3: Cell Temp: 3:
100 Connected Autozerp | Ready Data Rate: 3: SRS Current: 3: SRS Mode: 3: Show Plul...l
= {Sample.Sequence} #{Sample.Number Sample.Hame alume;d} from Pos. {Position}
: Hold Mode 10.0- ) [sample-Name) &
50
Stop Mode

8.0+

=0 p {Pumpho

_or | _on | vum| [ 40]

Inject Valve—————————

{Pump_InjectValve.State} 204
Inject Load

Eluent Flow Valve 4

-1.0-
I T T T T T T T T T 1
Closed Open 0.00 0.50 1.00 1.50 2.00 250 3.00 3.50 4.00 4.50 5.00

Figure B-49. ICS-1000 Traditional System Control Panel (Unconnected)
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To connect the Control Panel to the ICS-1000, open the Control menu and
click the name of the ICS-1000 timebase at the bottom of the menu.

The Control Panel is now connected to the ICS-1000 and the controls are
enabled (see Figure B-50).

Ef [CS-1000 Pump and Detector - ICS-1000 - AMAR

=|o] x|
Sampl Audit Trail
Datasource: Elapsed Time: |— 15:02:01 User (Ahar)from AMAR has acquired control overtimebase 1CS-1000.
| | l—l 21‘5 02:15 EluentValve = Open =
Sequence: | | RunTime: | || | |ey15:00010 Elusntvals = Closad
Sample: | | em .1‘5 02:21 EluentValve = Open
o 5y15:08:23 EluentValve = Closed
Bragrame ‘ ‘ Startup Shutdown -
ICS-1000 Pump: 1CS-1000 Detects
EluentBoflle [ Connected | | ¥ Connected |Gonnected| [JIEEED n.mo9ps | TR [Hone =l Cell Temp: NETCESS]
0.001 3:
| Connected | Autozero | [Ready | 50Hz = ey [oma = OIS [off = ShowPlot..
# from Pos.
Hold Mod 10.0
w5 Fop_1
Stop Mode 0.0%0
(A[WEICH | 1.00 mlfmiai
off On Prime 4.0+
Inject Valve
LoadP ositi
Inject Load
Eluent Flow Valve i
1.0
T T T T T T T T T T 1
Closed Open 0.00 0.50 1.00 1.50 200 2.50 3.00 3.50 4.00 4.50 5.00

Figure B-50. ICS-1000 Traditional System Control Panel (Connected to the ICS-1000)
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B.23 Installation Troubleshooting

Problem: When the ICS-1000 power is turned on for the first time, a Windows
message box appears asking for a USB configuration file (cmwdmusb.inf).

Possible Cause: The USB cable was connected and the power turned on before
Chromeleon was installed.

Solutions:
Use one of the methods below to resolve the problem:

® C(Click the Cancel button on the Windows message box. Turn off the ICS-1000
power and unplug the USB cable. Then, install Chromeleon, reconnect the
USB cable and turn on the ICS-1000 power. Windows will now automatically
recognize the new USB device.

® Leave the message box open and insert the Chromeleon CD into the CD-
ROM drive. Click the Browse button on the message dialog box. The
cmwdmusb.inf file is located in the Drivers folder on the CD.
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C « TTL and Relay Control

NOTE The ICS-1000 Ion Chromatography System is designed
for use with IC (ion chromatography) and BioLC
applications and should not be used for any other
purpose. If there is a question regarding appropriate
usage, contact Dionex.

C.1 TTL and Relay Connections

A 12-pin connector strip for TTL/relay control is located on the ICS-1000 rear
panel. The connector provides two relay outputs, two TTL outputs, and four TTL

inputs (see Figure C-1).

Connector
Pin Function Position Description
—||[O] 1
1 Solid State Relay Contacts Output
RELAY —— @ 2 }
ot | [O] 3
2 Solid State Relay Contacts Output
oy P y "
TTLOUT 11 [o] s TTL Output 1 (1 kQ pull up to +5, 100 mA sink)
*) 2| (O] s TTL Output 2 (1 kQ pull up to +5, 100 mA sink)
1 @ 7 TTL Input 1 — Inject/Load
TTLIN 2 @ 8 TTL Input 2 — Autozero
*) 3 @ 9 TTL Input 3 — Pump/Suppressor On
4 O] 10 TTL Input 4 — Mark
TTL GND 1 @ 11 Ground Note: The TTL input
functions can be reassigned
) 2 @ 12 Ground to different inputs.
Figure C-1. TTL and Relay Connector on Rear Panel
Relay loads in excess of 200 mA or with included power supplies over
60 V may damage the relay drivers on the CPU.
CAUTION
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The outputs can be used to control functions in external devices such as an
autosampler or another Dionex module. When connected to a controlling device,
the inputs can be programmed to perform the following ICS-1000 functions:

Switch the injection valve position (load/inject)

Perform an autozero command (set the conductivity to zero)

Turn the pump on and off (also turns the suppressor on and off)

Send a chart mark signal to the analog output. The mark is 10% of the full-
scale voltage, and the duration is 0.5 seconds. A mark can be used, for
example, to indicate the injection.

Relay outputs 1 and 2 can be programmed to switch any low-voltage control.
Switched current must be less than 200 mA and 42 V peak.

Connecting a TTL or Relay

1.

CAUTION

Locate the twisted pair of
wires (P/N 043598) and the

B
12-position connector plug Position 1 A
(P/N 923687) (see 'l Locking
Figure C-2) in the ICS-1000 N Screws
Ship Kit (P/N 057905). E i

AR

Follow these basic steps to
connect the TTL or relays.

a.

b.

Position 12

For each relay or TTL to Figure C-2. 12-Position Connector Plug

be used, connect an

active wire (red) and a ground wire (black) to the 12-position connector
plug at the appropriate pin locations. Refer to Figure C-1 or the label on
the ICS-1000 rear panel for the connector pin assignments.

To attach a wire to the plug, strip the end of the wire, insert it into the
plug, and use a screwdriver to tighten the locking screw. If necessary,
multiple ground wires can be attached to a single TTL input/output
ground pin.

When attaching wires to the connector plug, be careful not to allow

stray strands of wire to short to the adjoining position on the
connector.

Plug the connector into the 12-pin connector on the ICS-1000 rear panel.

Doc. 031879-01 3/03



C « TTL and Relay Control

c. Connect the wires from the ICS-1000 connector plug to the TTL or relay
connector pins on the other module(s). Additional connector plugs are
provided with other Dionex modules.

NOTE Check the polarity of each connection. Connect signal
wires to signal (+) pins and ground wires to ground (-)
pins.

3. Ifyou connected a TTL input, verify that the correct function is assigned to
the input and that the correct input control type is selected. Select different
settings if necessary. Input functions and control types are assigned from
Chromeleon (see Section C.1.1).

C.1.1 Selecting TTL Input Functions and Control Types

To select TTL input functions and the control type, open the Chromeleon
Server Configuration program and double-click the ICS-1000 icon under
the timebase. Select the TTL Inputs tab (see Figure C-3).

Dionex ICS-1000 System E

General I Options I Signals I Head Type & Limits I Saolvents I State Devices
Error Levels I Demao Chromatogram T TL Inputs |Trend I Calibration I Diagnostics

TTL Input Maode: MNormal edge
— TTL Input Functions
TTL Input 1: ILoad.f'Iniect Walve j
TTL Input 2 I.&utnzern j
TTL Input 2 IPumpa’Suppressor OmOFF j
TTL Input 4: IF!ec:order mnark, j

QK I Cancel | S | Help |

Figure C-3. ICS-1000 Server Configuration Properties: TTL Inputs
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TTL Input Control Types

Wivhal: Edge The ICS-1000 TTL inputs respond to four types of

Rorrost e signals to accommodate different controlling devices.
Inwerted Edge The default control type, Normal Edge, is compatible with
Inverted Pulze | the output signals provided by Dionex modules.

If the device connected to the ICS-1000 does not send a normal edge
signal, select the appropriate control type. Refer to the documentation
provided with the controlling device and the information below to select
the correct type.

® Normal Edge: In normal edge Action Off or No Effect
operation, t'he negative (falling) . R
edge of a signal turns on the NORMAL
function. For example, for the EDGE gy —
Load/Inject function, the Action On

negative edge switches the
injection valve position to Load.

The action of the positive (rising) edge depends on the function: For
the Load/Inject function, the rising edge switches the injection valve
to the Inject position. For the Pump On function, the rising edge turns
off the pump (and suppressor). For Autozero and Mark, the rising edge
has no effect.

® Inverted Edge: The inverted [r——
edge mode works identically to
the normal edge mode except | nvERTED
that the positive and negative EDGE g v ...
edges are reversed in function. Action Off or No Effect

®  Normal Pulse: In normal pulse
operation, the negative (falling) —_
edge of the TTL signal is the NORMAL
> . PULSE ,q v/
active edge and the positive
(rising) edge is ignored.

Action Off

Action On

A pulse width of 50 ms or more

is guaranteed to be detected. A pulse width of 4 ms or less is
guaranteed to be ignored. The action for pulse widths that are greater
than 4 ms and less than 50 ms is undefined.
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® [nverted Pulse: The inverted
pulse mode operates identically
to the normal pulse mode
except that the positive and
negative edges are reversed in
function.

Action On

TILS V

INVERTED
PULSE ,q v

Action Off

C.2 Controlling TTL and Relay Outputs

The ICS-1000 provides two TTL outputs and two relay contacts for control of
functions in external devices, such as an integrator or autosampler. The relay
outputs can be used to switch any low-voltage control. Switched current must be
less than 200 mA and 60 V peak blocking. The relay-contact closures are
normally open. When the relay is closed, current flows to the connected device.

Relay loads in excess of 200 mA or with included power supplies over
60 V may damage the relay drivers on the CPU.

CAUTION

The TTL outputs are normally at 5 volts. Setting a TTL output to 0 volts turns on

the action in the connected device.
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The TTL and relay output states can be controlled, either by issuing direct control
commands from the Chromeleon control panel or by including the commands in a
control program. Figure C-4 shows an example relay program command for
controlling an AS40 autosampler.

5124 Production Test Chromatogram - Commands - |E

m Production Test Chromatograrm

DUPPLCDDUL_\JULLCIIL el =
Flow = 1.50
-2.300 Pump_ECD_Relay_l.Closed\§\> Duration=138.00 ; For AS40 injection
Relay 1 turned on to start Relay 1 turned off after
0.000 Pump ECD.Rutozero IthedAti‘w LoadI C)I/cle and 138 seconds
ECD 1.Rcqon oad the sample loop

Pump Injectvalve.InjectPosition Duration=30.00
15.000 ECD 1.AcqOff

End

-

Figure C-4. Example Program for AS40 Control
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C.3 Example Setup for Stand-Alone Operation

This section describes an example setup for stand-alone operation (operation
without Chromeleon software) with an AS50 autosampler and a third-party
analog-to-digital converter and controller. If your configuration includes different
devices, use the following steps as guidelines and refer to your product
documentation for specific connection details.

Verify the AS50 Configuration

Refer to Section B.17.1 to verify that the AS50 meets the configuration
requirements for use with the ICS-1000.

Connect the AS50 Autosampler

Follow the instructions in Section B.17.2 to connect the AS50 autosampler to the
ICS-1000 injection valve.

Connect the TTLs and Relays

1. Locate two twisted pairs of
wires (P/N 043598) and 12-
position connector plugs Position 1
(P/N 923686) (see
Figure C-5) in the ICS-1000
and AS50 Ship Kits.

2. Attach the wires to the
connector plug positions
indicated in Figure C-6.

Locking
Screws

Position 12

Figure C-5. 12-Position Connector Plug

To attach a wire to a connector plug, strip the ends of the wire, insert into the
desired connector position, and tighten the locking screw with a screwdriver.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the

connector.
CAUTION

3. Plug the connector plugs into their respective TTL/Relay connectors on the
rear panel of each module.

Make sure the red wires connect to active (+) pins on each module and the
black wires connect to ground (-) pins.
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ICS-1000 Rear Panel Connections AS50 Rear Panel Connections

ANALOG
( OUTPUT

TTL1IN (+)

TTL 2 OUT (+
(o 11 TTL 1 OUT (+) TTL2IN (+)
1 B RLY 2 OUT TTL3IN (+)
RELAY o2 TTL4IN (+)
out — [ |5 RLY1OUT L
2 1= |_|_IN/OUT()
— o |4
TTLoutr 1o s ] 2 3 45 6 7 8 9 1011 12 bk pos
. 2o red pos.
. 2fele 1356 ||?|?|?|‘K|f’|°\| [2]e o ]9 p] 4t
: ”@ﬁ"’” JAYAWERNDZA\
TTLIN 2 [ o
— . |
*) 3 [ o Inject - | J
N Pump On/Off {—'| |
Lo |10 Autozero J
TTLGND 1 | o
) A K-S lack: Start/Continue Schedule

pos. 11,12,12

Start Acquisition

J

L Analog Data Transfer
ANALOG IN red black red black
RELAY OUT I—Hw RELAY IN

Third-Party Analog-to-Digital Converter and Controller

System Function Connection

Inject AS50 TTL Out 1 to ICS-1000 TTL In 1
Autozero AS50 TTL Out 2 to ICS-1000 TTL In 2
Pump On/Off AS50 RLY Out 2 to ICS-1000 TTL In 3
Start Data Acquisition AS50 RLY Out 1 to Third-party DAC RLY In

Start/Continue Schedule Third-party ADC RLY OUT to AS50 TTL In 2

1CS-1000 TTL Inputs AS50 TTL Inputs

TTLIN 1 = Inject TTL IN 1 = (unassigned)

TTL IN 2 = Autozero TTL IN 2 = Start/Continue Schedule
TTL IN 3 = Pump On/Off TTL IN 3 = Tray/Temp. On/Off
TTLIN 4 = Mark TTL IN 4 = Therm. Compart. On/Off

Figure C-6. Example Connections for Stand-Alone Operation
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Enable AS50 Control of the Injection Valve

1. On the AS50 front panel, press Menu and 0 to go to the TIME FUNCTION OUT
screen. In the LOAD/INECT VALVE: TTL 1 field, select ENABLED.

TIME FUNCTION OUT

TTL
LOAD/INJECT VALVE: 1  ENABLED
LOAD/INJECT VALVE: 2  DISABLED

Help Prompt

Figure C-7. AS50 Time Function Out Screen

2. Turn the AS50 power off and then back on.
You can now issue commands from the AS50 to switch the ICS-1000
injection valve position.

Connect the Analog Output

1. Locate the analog cable for the third-party analog-to-digital converter and
controller.

2. Connect the analog input connector on the third-party controller to the
ANALOG OUTPUT connector on the ICS-1000 rear panel (see Figure C-6).
Create an AS50 Method and Schedule

Figure C-8 is an example of AS50 method timed events that can be used with the
TTL/Relay connections shown in Figure C-6.

TIMED EVENTS METHOD1
TIME VALVE CSV TTL1 TTL2 RLY1 RLY2
INIT LOAD
0.00 INJECT 1 1 1
0.50 0 0 1
Help Prompt

Figure C-8. Example AS50 Method for Stand-Alone Operation
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Timed Event Notes:
® At time INIT, the injection valve is set to Load.

* Attime 0.00, the injection valve is set to Inject, an autozero is performed
(TTL2=1), the data acquisition mark is sent (RLY 1=1), and the pump is
turned on (RLY2=1).

e Attime 0.5, TTL2 and RLY1 are switched back to 0 to be ready for the next
run. RLY?2 remains at 1 to keep the pump on.

* TTL1 does not need to be set in the timed events because the Load and Inject
commands control the ICS-1000 injection valve automatically (see “Enable
AS50 Control of the Injection Valve” on page C-9).

To run the above method, set up an AS50 schedule. The example in Figure C-9
includes a four-point calibration (Lines 1 — 4) followed by two samples (Lines 5

and 6).
SCHEDULE EDIT 1 SAVETO 1 RUN 1
MISSING VIAL ACTION:  SKIP
VIAL# INJ/  INJ
LINE START-END VIAL VOLSuL) METHOD
1-4 1- 4 3 25
5 5-5 1 25.0 1
6 6 - 6 1 5.0 1
Help Prompt

Figure C-9. Example AS50 Schedule for Stand-Alone Operation
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D ¢ Reordering Information

Part Number

046548
039164

057937
057938
045721
045722
045994
052840
055870
048722
055752
057945
054578

042857
057968
024305
016388
057896

056116

Item
Reservoirs
2-L plastic reservoir assembly (includes stopper and cap)

4-L plastic reservoir assembly (includes stopper and cap)

Pump
Primary pump head assembly
Secondary pump head assembly
Outlet check valve assembly, 10-32
Inlet check valve assembly, 1/4-28
Check valve cartridges
Piston
Piston seal
Piston rinse seal
O-ring for waste valve or priming valve
Eluent valve

10-cc syringe (for priming eluent lines)

Sample Loop and Injection Valve
25-pL sample loop
Injection valve
Luer adapter fitting, 1/4-28 (for manual injections)
1-cc syringe (for manual injections)

Injection valve rebuild kit

Suppressors, Cell, and Column Heater

AAES Anion Atlas Electrolytic Suppressor
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Part Number Item
056118 CAES Cation Atlas Electrolytic Suppressor
053946 ASRS-Ultra 4-mm Anion Self-Regenerating Suppressor
053949 CSRS-Ultra 4-mm Cation Self-Regenerating Suppressor
057985 DS6 heated conductivity cell
058060 Column heater assembly
059979 Column heater heat exchanger, 0.25-mm (0.010-in) ID tubing
060943 Column heater heat exchanger, 0.125-mm (0.005-in) ID tubing
058062 Column heater cover assembly
Relay/TTL
923686 12-position connector plug
043598 Twisted pair of wires
Miscellaneous
954745 IEC 127 fast-blow fuses, rated 3.15 amps
060494 USB cable, 5 m (16 ft)
060392 External USB hub
058053 Leak detector
Maintenance Kits
055647 AS40/ASM preventive maintenance kit
060581 AS50 preventive maintenance kit
057954 ICS-1000 preventive maintenance kit
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E - FAQ

E.1

E.2

E.3

E.4

How do | hook up an autosampler?

For instructions on how to connect the ICS-1000 to an AS50 autosampler, see
Section B.17 of this manual. To connect an AS40, see Section B.18. Also see the
AS50 Autosampler Operator’s Manual (Document No. 031169) or the 4540
Automated Sampler Operator s Manual (Document No. 034970). The manuals
are included on the Dionex Reference Library CD-ROM (P/N 053891), located in
the ICS-1000 Ship Kit (P/N 057905).

How do | print?

Click the Print toolbar button in Chromeleon (see Section 2.3).

Why are the retention times moving?

Retention times can shift if the pump flow is erratic or if the column or eluent is
contaminated. See Section 4.6 for pump flow rate troubleshooting. If a
contaminated column is suspected, clean the column as instructed in the column
manual. The column manual is included on the Dionex Reference Library CD-
ROM (P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).

How do | adjust retention times?

Retention times are calculated during calibration. The Use Recently Detected
Retention Time parameter in the Chromeleon QNT Editor (General tab) can be
used to compensate for some types of retention time drifts; for example,
evaporation of volatile components in pre-mixed solvents or an aging column.
Refer to the Chromeleon Help or user’s guide for details.
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E.5 When should | remake standards?

Standards are used only for calibration and should always be made fresh (they
have a lifetime of only one week).

E.6 When should | remake eluents?

Eluents should be remade every two or three weeks.

E.7 How do | start Chromeleon?

Click Start on the Windows taskbar, and then select Programs >Chromeleon >
Chromeleon.

E.8 How do | delete data?

In the Chromeleon Browser, highlight the sequence you want to delete and then
select File >Delete.

E.9 How do | back up data?

In Chromeleon, select File >Export/Backup. Back up the data and indicate the
backup source.

E.10 How do | shut off the system?

In Chromeleon, click the System Shutdown button on the ICS-1000 Control
Panel (see Figure 2-8). On the ICS-1000, turn off the power switch on the rear

panel (see Figure 2-5).

E.11 How do | store columns?

Columns should be stored in eluent. See the column manual for complete
instructions. The column manual is included on the Dionex Reference Library
CD-ROM (P/N 053891), located in the ICS-1000 Ship Kit (P/N 057905).
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E.12 How do | know when a column is dirty?

See the troubleshooting section of the column manual.

E.13 How do | clean a column?

See the troubleshooting section of the column manual.

E.14 Why is the conductivity high?

Possible reasons for high conductivity include:

® The suppressor needs regeneration. See the suppressor manual for
troubleshooting information. The suppressor manual is included on the
Dionex Reference Library CD-ROM (P/N 053891), located in the ICS-1000
Ship Kit (P/N 057905).

® The cell is out of calibration. See Section 5.1.2 for calibration instructions.

® See Section 4.12 for additional troubleshooting information.
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Analytical Column
Synonymous with Separator Column.

Band Spreading

The broadening of the sample band as it travels through the column. Band
spreading can also occur in the injection valve, detector cell, and interconnecting
tubing.

Calibration Curve
A graph showing detector response in peak height or area versus analyte
concentration.

Capacity Factor (k")

The number of column volumes of eluent, pumped through the column, required
to elute an analyte. Capacity factor is a dimensionless measure of retention which
is independent of column length or eluent flow rate. It is calculated as follows:

Where: t. = retention time
t, = retention time of unretained solute (column void volume)
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Cell Constant (k)
A factor determined experimentally by measuring the conductance (G) of a
standard solution of known equivalent conductivity (k).

k=«x/G

The value of k depends upon the surface area of, and distance between, the
electrode faces in the conductivity detector cell.

k=1/4

Where: [ = length
A = area of one electrode (the other electrode is equal to
the first)

Channeling
The preferential flow of liquid along more open, less resistant paths through the
column packing. This causes Band Spreading.

Column Efficiency (N)

A measure of the narrowness of analyte bands as they elute from the column.
High efficiency is desirable because resolution between closely spaced bands
improves with greater efficiency. For a symmetrical (Gaussian) peak, column
efficiency can be determined by the following:

N= 5.54(t1/W1/2)2

Where: t; = the peak retention time (in seconds)
W, = the peak width at 1/2 height (in seconds)

Column efficiency is proportional to column length: for a given resin and column
diameter, increasing the column length increases the column efficiency.
Synonymous with Theoretical Plates.

Column Selectivity (a)
Describes the relative separation of the band maxima between two adjacent peaks.
Selectivity can be determined by the following:

a=(t; - to)/(t; -to)

Where: t; and t, = retention time of components 1 and 2, respectively
to = retention time of unretained components (void volume)

Concentrator Column
A short column used to retain and concentrate analytes from a measured volume

Doc. 031879-01 3/03
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of relatively clean sample. This allows large volumes of sample to be injected,
lowering concentration detection limits.

Conductivity

A measure of the ease with which electrical current flows through a liquid
contained between two opposite charged electrodes. Conductivity is a
characteristic of ions in solution. Units are siemens.

Counterion
Tons carrying a charge opposite that of the sample ions (e.g., Na") may be the
counterion of a Cl” analyte. These ions preserve electrical neutrality in solution.

% Crosslink

Divinylbenzene content in a polystyrene/divinylbenzene (PS-DVB) resin; this
contributes to the mechanical strength of the resin and determines
chromatographic properties.

Equivalent Conductivity (1)

The contribution of an ionic species to the total conductivity of a solution as
measured in a standard cell having electrodes 1 cm? in area and exactly 1 cm
apart.

Guard Column

A small column that prevents poisoning of the separator column by sorbing
organic contaminants and removing particulates. It is filled with the same packing
as the separator column. Synonymous with Pre-Column.

HETP (H)
Height Equivalent to a Theoretical Plate. A measure of column efficiency which
allows comparison between columns of different lengths.

HETP=H=L/N

Where: L = the column length (in mm)
N = the number of theoretical plates

Ion-Exchange Capacity
The number of active ion exchange sites in a given weight or volume of resin; this
is usually expressed in meq/g or meq/mL.

Ion-Exchange Resin
An insoluble polymer matrix containing fixed-charge exchange sites (anionic or
cationic). IC resins are formed into small spherical particles (beads).
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Packing
The material that fills a chromatographic column; usually a resin or silica-based
material.

Pellicular Resin

A resin with a solid, nonporous core coated with a thin layer of more porous
material. The exchange sites of pellicular ion exchange resins are located only on
the surface layer of the bead. These resins have a low ion-exchange capacity.

Pre-Column
Synonymous with Guard Column.

Regenerant
A dilute acid or base that converts ion exchange sites in a MicroMembrane
Suppressor back to the form that suppresses the eluent conductivity.

Resin
See Ion-Exchange Resin.

Resolution (R)

A measure of the separation between two sample components. This is expressed
as the ratio of the distance between the two peak maxima to the mean value of the
peak width at the baseline.

R=2(t - t))/(W, + W)

Where: t; and t, =the retention times of components 1 and 2,
respectively
W, and W, = the baseline width of peaks 1 and 2,
respectively (measured in the same units as the retention
time)

R is proportional to the square root of efficiency (N). A value of R = 1.5
represents “baseline separation” of the two peaks.

Retention Time
The time from injection to peak maximum; the basis for identification of a species
in chromatographic analysis.

Separator Column
The column used to perform a chromatographic separation; also called an
analytical column.

Doc. 031879-01 3/03



F « Glossary

Siemens (S)
Unit measure of conductance; the reciprocal of the electrical resistance of a
solution.

Suppressor
A device used to minimize eluent conductivity and convert sample species to a
common form, thus increasing detection sensitivity.

Temperature Coefficient

The percent of change in the conductivity of a solution with a 1 °C change in
temperature. Every solution has a characteristic temperature coefficient which is
determined experimentally.

Theoretical Plates (N)
See Column Efficiency.

Void Volume (V)

The volume occupied by the eluent in a packed column. This volume includes the
volume between the injection valve and the column, as well as between the
column and the detector cell. Unretained components are eluted in the void
volume.
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A

Air particulate samples, 3-12
Air regulator, B-47 — B-48
Alarm conditions, 4-3 — 4-8
See also Error messages
Ambient temperature, 4-19
Analog output, C-2
Connections, C-9
Connector, 2-7
Analog-to-digital controller, C-9
Anion separations, 3-11
Applications, 3-6, C-1
AS40 Automated Sampler
Installation, B-44
Sample injection, 3-16
Yearly maintenance, 3-22
AS50 Autosampler
Connections for stand-alone operation, C-7
Enabling injection valve control, B-43, C-9
Installation, B-40
Method for stand-alone operation, C-9
Sample injection, 3-16
Schedule for stand-alone operation, C-9
Time Function Out screen, B-43, C-9
Yearly maintenance, 3-22
Atlas Electrolytic Suppressor, 2-6
See also Suppressor
Audit Trail, 2-16
Automated control, 2-11
Autosampler
Sample injection, 3-16
See also AS40 Automated Sampler
See also AS50 Autosampler
Autozero, 2-17, 3-11, 3-18

B

Background conductivity

High, 4-18

Offsetting, 3-11
Backpressure, 2-23

Restriction in plumbing, 5-7

Troubleshooting, 4-15
Baseline

Drift, 4-19

Equilibration, B-39

Noise, 2-10, 4-19

Stability, 2-27
Batch processing, 3-2

Starting, 3-20

See also Sample processing
Blockages

Liquid lines, 4-6, 5-7
Bottle

See Reservoir
Browser, 2-12, 3-5, B-51

C

Cables
AS40 Relay Control, B-44
Power cord, 5-30
USB, B-9
Calibration, 5-1
Conductivity cell, 5-4
Flow rate, 5-6
Vacuum degas assembly, 5-7
Cation separations, 3-11
Cell
See Conductivity cell
Cell calibration, 5-4
Cell drive, A-3
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Check valves
Cleaning procedure, 5-11 — 5-12
Replacement procedure, 5-11 —5-12
Chromatogram, 1-3
Chromeleon, 2-11
Adding devices to a timebase, B-16
Alarm conditions, 4-3
Browser, 2-12, 3-5
Control Panel, 2-11, 3-18
Creating a sequence, 3-19
Degas options, 4-20
Direct control, 2-11
Error messages, 4-3
Installation, B-5, B-13
Interface, 2-11
License installation, B-5 — B-6
Menu, 2-11, 3-18
Programs, 2-11, 2-15, 3-16 — 3-19
Starting, 3-4, B-26
System properties dialog box, B-16
Timebase, 3-5
Toolbars, 2-11, 3-18
Verifying communication, B-35
Wellness Panel, 5-1
Chromeleon Server
Starting, 3-4, B-13
Chromeleon Server Configuration program
Starting, B-13
Timebase, B-15
Column heater, 2-5, 2-26
Replacement procedure, 5-23
Specifications, A-4
Column heater alarms
Column heater exceeds safe temperature,
4-3
Column heater open circuit, 4-3
Column heater short circuit, 4-3
Columns, 2-5
Cleaning, E-3
Contaminated, 4-17
Damage from IPA, 5-29
Installing, B-19
Storing, E-2

Commands
Chromeleon, 2-11, 3-19, B-34
Component panel, 2-4
Computer
Connections, B-9
Operating system requirements, B-5
Unpacking, B-4
Conductivity
Causes of high conductivity, E-3
Temperature effect, 2-27
Conductivity cell, 2-6, 2-27
Calibrating, 5-4
Calibration constant, 5-21
High cell output, 4-18
Leaking, 4-10
No response, 4-18
Replacement procedure, 5-20
Specifications, A-3
Volume, 2-27
Conductivity cell specifications
Active volume, A-3
Cell body, A-3
Electrodes, A-3
Maximum pressure, A-3
Contacting Dionex, 5-1
Contamination
Column, 4-16 — 4-17
Eluents, 4-16
Sample, 4-17
Standard, 4-16
Control Panel, 2-11, 2-13, 3-18
System Panel, 2-13
Wellness Panel, 2-13

D

Daily maintenance, 3-21
Data
Backing up, E-2
Deleting, E-2
Saving, 3-19
Data acquisition, 3-18
Data analysis description, 1-3

Index-2
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Data rise time, B-46
Decibel level, A-1
Degas tubing assembly
See Vacuum degas assembly
Degas calibration failed alarm, 4-4
Degassing eluents, 2-19, 3-6
Delay volume, A-2
Detection description, 1-3
Detector specifications
Cell drive, A-3
Linearity, A-3
Range, A-3
Temperature compensation, A-3
Diagnostics, 5-1
Dimensions, A-1
Dionex
Contacting, 5-1
Direct control, 2-11
Dongle, B-6
Drip tray, 2-5
DS6 Heated Conductivity Cell
See Conductivity cell
Duty cycle, 2-20

E

Electrical specifications
Fuses, A-1
Main power, A-1
Eluent
Aqueous, 3-21, 4-12
Degassing, 2-19
Delivery process, 1-2
Filtering, 3-7
Preparing, 3-6
When to remake, E-2
Eluent bottle
See Eluent reservoir
Eluent level, 3-8, B-35
Eluent reservoir
Connecting, 3-8, B-25
Filling, 3-8
Gas connection, B-47

Monitoring liquid level in, 3-8, B-35
Pressurization, B-48
Storage on top cover, 2-3
Eluent valve, 2-5
Replacing, 5-26
End-line filter
See Filter, end-line
Environmental specifications
Humidity, A-1
Operating pressure, A-1
Operating temperature, A-1
Equilibration time, 3-11
Error messages, 4-3 —4-8
Column heater exceeds safe temperature,
4-3
Column heater open circuit, 4-3
Column heater short circuit, 4-3
Degas calibration failed, 4-4
Hardware not present, 4-4
Leak sensor wet, 4-4
Load/inject valve error, 4-5
Option not installed, 4-5
Pressure slope calibration error, 4-5
Pump motor lost control, 4-5
Pump over pressure, 4-6
Pump pressure hardware error, 4-6
Pump under pressure, 4-7
Suppressor not connected, 4-8
Suppressor over current, 4-7
Suppressor over power, 4-8
Suppressor stopped for zero flow rate, 4-8

F

Facility requirements, B-1

Filter, end-line
Bacterial contamination, 3-21, 4-12
Dirty or clogged, 3-21, 4-12
Installation, 3-7

Fittings
Leaking, 4-9
Replacing, 5-9
Requirements, 5-9
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Flow rate, 2-5, A-2
Calibration, 5-6
Troubleshooting, 4-14

Flow schematic, 2-9

FROM PC
USB connections, B-9

Front panel, 2-1
Specifications, A-2

Fuses
Replacement procedure, 5-30
Requirements, A-1

G

Gas separator waste tube, B-23
Gas source
Connection, B-47
Installation, B-47
Pressure requirement, B-47
Ghosting, 4-16
Guard column, 2-5, B-19
Installation, B-20

H

Hardware not present error, 4-4
Heater

Column, 2-26
High pressure alarm, 4-6
High pressure limit, A-2
Humidity limits, A-1

I

Injecting samples, 3-14
Via autosampler, 3-16
Via syringe, 3-15
Via vacuum syringe, 3-16
Injection port, 2-1
Injecting via syringe, 3-15
Injection valve, 2-5, 2-24
Controlling with an AS50, B-43, C-9

Leaking, 4-10
Plumbing connections, 2-24
Rebuilding, 5-10
Specifications, A-3
Troubleshooting, 4-5
Installation, B-1 — B-53
Adding devices to a timebase, B-16
Analog output connection, C-9
AS40 autosampler, B-44
AS50 Autosampler, B-40
Assigning devices to a timebase, B-15
Assigning USB devices, B-14
Chromeleon, B-5, B-13
Columns, B-19
Computer, B-4
Eluent reservoir, B-25, B-48
Equilibrating the system, B-39
Gas separator waste tube, B-23
Gas source, B-47
Guard column, B-20
Key code, B-8
Operating system requirements, B-5
Operational status verification, B-39
PC connections, B-9
Plumbing, B-25
Power connection, B-11
Priming, B-36 — B-38
Separator column, B-20
Software license, B-5 — B-6
Stand-alone operation setup, C-7 — C-8
Starting the ICS, B-12
Suppressor, B-21
TTL and relay connections, C-1 — C-2
Unpacking, B-2
USB connections, B-9 — B-10
Waste lines, B-23
Installation troubleshooting, B-53
Inverted edge TTL input control, C-4
Inverted pulse TTL input control, C-5
Ion chromatography
Overview, 1-1
Ion exchange, 1-3
Isocratic delivery system, 1-2
Isopropyl alcohol, 5-29
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K

Key code (Chromeleon), B-6

L

Leak sensor, 2-5
Leak sensor wet alarm, 4-4
Replacement, 5-28
Leaks
Cell, 4-10
Fittings, 4-9
Injection valve, 4-10
Liquid, 4-9
Pressure transducer, 4-10
Pump check valve, 4-9
Pump head, 4-10
Pump head waste valve, 4-10
Pump piston seal, 4-10
Suppressor, 4-10
LED, A-2
License (Chromeleon), B-5 — B-6
License server (Chromeleon), B-6
Linearity requirements, A-3
Liquid leaks, 4-9
See also Leaks
Load/inject valve alarm, 4-5
Loading samples, 3-14
Loop
See Sample loop
Low pressure limit, A-2

M

Main power receptacle, 2-8
Maintenance, 3-21
Daily, 3-21
Ongoing, 3-21
Weekly, 3-21
Yearly, 3-22
Manual sample processing, 3-2
MicroMembrane Suppressor, 2-6
See also Suppressor

N

Nitrite in samples, 3-12
Normal edge TTL input control, C-4
Normal pulse TTL input control, C-4

O

Offsetting background conductivity, 3-11
Operating features, 2-1
Operating pressure, A-1
Operating ranges
Cell heater, 2-6
Column heater, 2-5
Flow rate, 2-5
Operating system requirements, B-5
Operating temperature, A-1
Operation
Equilibration time, 3-11
Overview, 3-1
Priming, 3-9, 5-29, B-38
Reservoir setup, 3-6
Sample preparation, 3-12
Sample processing, 3-2
Setting operating conditions, 3-10
Starting Chromeleon, 3-4
System power-up, 3-3
Operational status verification, 3-11
Option not installed error, 4-5
Oven
See Column heater
Overview, 1-4

P

Panels
Chromeleon Control Panel, 2-11, 3-18
Chromeleon Wellness Panel, 5-1
Component panel, 2-4
Parameters
Chromeleon operating commands, 2-11,
3-19, B-34
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PC
See Computer
Peak ghosting, 4-16
Peak height
Reproducibility, 2-27
Troubleshooting, 4-17
Peaks
Extraneous (ghosting), 4-16
PEEK
Conductivity cell body, 2-27
Physical specifications
Decibel level, A-1
Dimensions, A-1
Weight, A-1
Piston seals
Replacement procedure, 5-13 — 5-14,
5-16 —5-17
Pistons
Replacement procedure, 5-17
Plotting detector output, 2-18
Plumbing
Columns and suppressor, B-25
Injection valve, 5-10
Replacing tubing and fittings, 5-9
Troubleshooting, 5-7
Power
Turning on, 3-3, B-12
Power cord, 5-30, B-11
Power receptacle, 2-8, B-11
Power requirements, A-1
Power-up conditions, 3-3
Pressure
Limit, 4-7
Pump operating specifications, A-2
System, 4-6 — 4-7
Pressure ripple, A-2
Pressure slope calibration error, 4-5
Pressure transducer, 2-5, 2-23
Leaking, 4-10
System backpressure, 2-23
Pressurizing
Eluent reservoir, B-48
Priming, 3-9, 5-29, B-36 — B-38
Pump is out of prime, 4-12

With a syringe, B-36
With isopropyl alcohol, 5-29
With the Prime button, B-38
Priming valve
Opening, 2-22
O-ring replacement procedure, 5-18
Printing, E-1
Processing samples, 3-2, 3-18 — 3-19
Automatically (batch), 3-2, 3-19
Manually, 3-2, 3-18
Product warranty, 5-1
Program time, 2-15
Programs (Chromeleon), 2-11, 2-15, 3-16 —
3-19
Run time, 2-15
Pulse damper, 2-10, 2-23

Pump, 2-21
Flow rate, 2-5
Leaks, 4-10

Operating pressure, A-2

Over pressure alarm, 4-6

Primary pump head, 2-21

Priming, 3-9, B-36

Priming problems, 4-11

Secondary pump head, 2-22

Troubleshooting, 4-13

Under pressure alarm, 4-7
Pump check valve leaking, 4-9
Pump components, 2-21
Pump degas

See Vacuum degas assembly
Pump head waste valve

Leaking, 4-10

O-ring replacement procedure, 5-18
Pump heads, 5-11
Pump motor lost control alarm, 4-5
Pump pressure hardware error, 4-6
Pump priming valve

O-ring replacement procedure, 5-18
Pump specifications

Flow rate, A-2

Operating pressure, A-2

Type, A-2

Index-6
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R

Rear panel, 2-7

Analog output connector, 2-7

Power receptacle, 2-8

USB connections, 2-7
Rebuilding the injection valve, 5-10
Relay connections

AS40, B-44

Rear panel connector, 2-8, C-1
Relay outputs

Controlling, C-5

Voltage and current specifications, C-2
Reordering information, D-1
Reproducibility, 2-27
Reservoir

Connecting, 3-8

Filling, 3-8

Monitoring liquid level in, 3-8, B-35

Storage on top cover, 2-3
Restriction in liquid lines, 4-6, 5-7
Retention time

Adjusting, E-1

Moving, E-1

Troubleshooting, 4-17
Run time, 2-15
Running samples, 3-18

See also Processing samples

S

Safety messages, 1-6
Sample loop, 2-5, 2-24
Changing, 5-9
Injecting, 2-24
Injection valve connections, 2-24, 5-10
Loading, 2-24
Reordering, D-1
Sample processing, 3-2, 3-18 — 3-19
Batch, 3-2, 3-19
Manual, 3-2, 3-18
With Chromeleon, 3-18 — 3-19

Samples
Collecting and storing, 3-12
Diluting, 3-13
Filtering, 3-12
Injecting, 3-14, 3-16
Loading, 3-14
Pretreating, 3-12

Saving data, 3-19

Schematic
Flow, 2-9

Seal replacement, 5-14, 5-16 — 5-17

Selectivity
Troubleshooting, 4-17

Self-Regenerating Suppressor, 2-6
See also Suppressor

Separation process, 1-3

Separator column, 2-5, B-19
Installation, B-20

Sequence, 2-11
Creating, 3-19

Sequence Wizard, 3-19

Serial number, B-16

Server Configuration program
AS50 configuration properties, B-18
Starting, 3-4, B-13
Timebase, B-15

Server Monitor, B-6

Service chase, 2-3, 2-6

Service procedures, 5-12
Check valve cleaning, 5-11 — 5-12
Check valve replacement, 5-11
Conductivity cell replacement, 5-20
Fuse replacement, 5-30
Injection valve rebuilding, 5-10
Isolation of liquid lines restriction, 5-7
Leak sensor replacement, 5-28
Piston replacement, 5-17
Piston seal replacement, 5-13
Priming valve O-ring replacement, 5-18
Rebuilding the injection valve, 5-10
Replacing tubing and fittings, 5-9
Suppressor replacement, 5-22
Tubing and fittings replacement, 5-9
Waste valve O-ring replacement, 5-18
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Sharable device, B-16
Software license, B-5 — B-6
Specifications
Column heater, A-4
Conductivity cell, A-3
Electrical, A-1
Environmental, A-1
Injection valve, A-3
Physical, A-1
Pump, A-2
Vacuum degas assembly, A-3
Stand-alone operation, B-43, C-7 — C-9
Analog output connection, C-9
AS50 setup, B-43, C-9
Example connections, C-8
TTL and relay connections, C-7
Standards
When to remake, E-2
Starting Chromeleon, B-26
Sulfite in samples, 3-12
Suppression description, 1-3
Suppressor
Controlling the current to, 2-18
Description, 2-6, 2-27
Installation, B-21
Leaking, 4-10
Replacement procedure, 5-22
Suppressor alarms
Suppressor not connected, 4-8
Suppressor over current, 4-7
Suppressor over power, 4-8
Suppressor stopped for zero flow rate, 4-8
Syringe injection, 3-15
Vacuum, 3-16
System
Shutdown, E-2
Startup, 3-3
Status, 3-11
System backpressure, 2-23
System components
Descriptions, 2-19
System Control Panel, 3-5, B-51
See also Control Panel
System overview, 1-4

System properties dialog box, B-16

T

Technical Support, 5-1
Temperature
Cell heater, 2-27
Column heater, 2-5, 2-26
Minimizing the effect of variations, 2-27
Temperature compensation, 2-27, A-3
Time, 2-15
Timebase (Chromeleon), 3-5
Adding devices to a timebase, B-16 — B-17
Assigning the ICS to a timebase, B-13 —
B-15
TO MODULE
USB port connections, B-10
Top cover, 2-3
Troubleshooting, 4-1
Alarm conditions, 4-3
Baseline noise or drift, 4-19
Calibrations, 5-1
Diagnostics, 5-1
Error messages, 4-3
Excessive backpressure, 4-15
Flow rate, 4-14
High cell output, 4-18
Installation, B-53
Liquid leaks, 4-9
No cell response, 4-18
Peak ghosting, 4-16
Peak height, 4-17
Pump, 4-11 - 4-13
Retention time, 4-17
Selectivity, 4-17
Vacuum degas assembly, 4-20
TTL and relay connector, C-1
Connection instructions, C-2
Pin assignments, C-1
TTL inputs
Default function assignments, C-2
Rear panel connector, 2-8
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TTL outputs

Controlling, C-5

Rear panel connector, 2-8
Tubing

Replacing, 5-9

Requirements, 5-9

Routing clips, 2-8
Tubing connections

Isolating a restriction, 4-6, 5-7
TUV, 1-8

U

Unassigned USB Devices, B-13
Unpacking, B-2
Computer, B-4
USB cable, B-10
USB connections, 2-7, B-9 — B-10
Unassigned devices, B-13

\%

Vacuum degas assembly, 2-19
Calibration, 5-7
Components, 2-19
Fails to run, 4-20
Priming, B-37
Specifications, A-3
Troubleshooting, 4-11

Valve
See Eluent valve
See Injection valve

W

Warranty, voiding, 5-1

Waste lines
Blocked, 4-9
Connection, B-23
Connection to AS50, B-42

Waste valve, 2-22
Opening, 2-22, 5-13
O-ring replacement procedure, 5-18
Water samples, 3-12
Weekly maintenance, 3-21
Weight, A-1
Wellness Panel, 2-13, 5-1

Y

Yearly maintenance, 3-22
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